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IP-MAC Binding Port 
This window is used to enable or disable IP-MAC binding on specific ports of the Switch. Select a port or a range of ports with 
the From and To fields. Enable or disable the port with the State field. Enable or disable zero IP address with the Allow Zero IP 
field. The user may also enable the ACL Mode for IP-MAC Binding which will create two Access Profile Entries on the Switch, 
as previously stated. Click Apply to save changes. To view this window click, Configuration > IP-MAC Binding > IP-MAC 
Binding Port. 

 

Figure 6- 105. IP-MAC Binding Ports window 
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IP-MAC Binding Table 
The window shown below can be used to create IP-MAC binding entries. Enter the IP and MAC addresses of the authorized users 
in the appropriate fields and click Add. To modify either the IP address or the MAC address of the binding entry, make the 
desired changes in the appropriate field and Click Modify. To find an IP-MAC binding entry, enter the IP and MAC addresses 
and click Find. To delete an entry click Delete. To clear all the entries from the table click Delete All. To view this window click, 
Configuration > IP-MAC Binding > IP-MAC Binding Table. 

 

Figure 6- 106. IP-MAC Binding Table window 

The following fields can be set or modified: 

Parameter                    Description 

IP Address Enter the IP address you wish to bind to the MAC address set below. 

MAC Address Enter the MAC address you wish to bind to the IP Address set above. 

All Ports Click this check box to configure this IP-MAC binding entry (IP Address + MAC Address) for all 
ports on the Switch.  

Ports Specify the switch ports for which to configure this IP-MAC binding entry (IP Address + MAC 
Address). 

Mode The user may set the IP-MAC Binding Mode here by using the pull-down menu. The choices 
are: 
ARP – Choosing this selection will set a normal IP-Mac Binding entry for the IP address and 
MAC address entered. 
ACL – Choosing this entry will allow only packets from the source IP-MAC binding entry 
created here. All other packets with a different IP address will be discarded by the Switch. This 
mode can only be used if the ACL Mode has been enabled in the IP-MAC Binding Ports 
window as seen previously.  
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IP-MAC Binding Blocked 
This window is used to view unauthorized devices that have been blocked by IP-MAC binding restrictions. To view this window 
click, Configuration > IP-MAC Binding > IP-MAC Binding Blocked. 

 

Figure 6- 107. IP-MAC Binding Blocked window 

To find an unauthorized device that has been blocked by the IP-MAC binding restrictions, enter the VLAN name and MAC 
Address in the appropriate fields and click Find. To delete an entry click the delete button next to the entry’s MAC address. To 
delete all the entries in the IP-MAC Binding Blocked Table click Delete All. 
 

DHCP Snooping Entries   
This table is used to enable and view dynamic entries on specific ports. To enable particular port settings, enter the port range and 
click Apply. To delete an entry, click Delete.  
To view this window click, Configuration > IP-MAC Binding > IP-MAC Binding DHCP Snooping. 

 
Figure 6- 108. IP-MAC Binding DHCP Snooping window 
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IP-MAC Binding Permit IP Pool   
This table is used to enable and view IP-MAC Binding Permit IP Pool entries on specific ports. To enable particular port settings, 
enter the port range and click Add.  To modify a previously created entry, enter the IP Address range and click Modify, to delete 
an entry, click Delete.  
To view this window click, Configuration > IP-MAC Binding > IP-MAC Binding Permit IP Pool. 

 
Figure 6- 109. IP-MAC Binding DHCP Snooping window 
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Limited IP Multicast Range 
The Limited IP Multicast Range window allows the user to specify which multicast address(es) reports are to be received on 
specified ports on the switch.  This function will therefore limit the number of reports received and the number of multicast groups 
configured on the Switch. The user may set an IP address or range of IP addresses to accept reports (Permit) or deny reports (Deny) 
coming into the specified switch ports.  

Limited IP Multicast Range Profile Settings 
This window is used to create a multicast address profile. To create a new profile specify the multicast ranges of the multicast 
addresses in the profile by entering the lowest and highest multicast IP addresses of the range into From Multicast IP and To 
Multicast IP fields. Click Apply to implement the settings. The new multicast range profile will be listed in The Port 
Information Table. To remove the existing profile from The Port Information Table list, click the corresponding  button 
under the “Delete” heading. To view this window click, Configuration > Limited IP Multicast Range > Limited IP Multicast 
Range Profile Settings. 

 
Figure 6- 110. Limited Multicast Range Profile Settings window 

Parameter                      Description 

Name Enter a meaningful description for the profile.  

From Multicast IP  Enter the lowest multicast IP address of the range. 

To Multicast IP Enter the highest multicast IP address of the range. 
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Limited IP Multicast Range Status Setting 
After Multicast Range Profiles are created, you may start to configure the multicast address filtering function on a port or a range 
of ports by configuring the Limited IP Multicast Range Status window as below. To view the following window, click 
Configuration > Limited IP Multicast Range > Limited IP Multicast Range Status Settings window.  

 
Figure 6- 111 Limited Multicast Range Status Settings window 

Parameter                      Description 

From…To Select a port or group of ports using the pull-down menus. 

State Toggle the State field to either Enabled or Disabled a given port or group of ports where 
access is to be either permitted or denied. 

Access Two options are available: Permint and Deny. The default mode is Permit. 
Permint specifies that the packet that match the addresses defined in the profiles will be 
permitted. Deny specifies that the packet that match the addresses defined in the profiles will 
be denied.  
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Click Apply to implement the configuration.  

Limited IP Multicast Range Setting 
The Limited IP Multicast Range Settings enables the user to configure the ports on the switch that will be involved in the 
Limited IP Multicast Range.  The user can configure the range of multicast ports that will be accepted by the source ports to be 
forwarded to the receiver ports.  To configure these settings, click Configuration > Limited IP Multicast Range > Limited IP 
Multicast Range Settings. 

 
Figure 6- 112 Limited Multicast Range Settings window 

To add a new Limited IP Multicast Range click Add, the following window will be displayed. To search for a range use the drop 
down menu to select the port and click Find.   

 
Figure 6- 113 Limited Multicast Range Settings window (Add) 

Use the drop down menu to select the range of ports that will be included in the Limited IP Multicast Range, enter the previously 
configured name for the range and click Apply.  To view the Port Information Table click, the hyperlinked Show The Port 
Information Table. 

 
Figure 6- 114 Limited Multicast Range Settings window (Add) 

To remove an entry, click the corresponding  button under “Delete” heading.  
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Layer 3 IP Networking 
Static ARP Table 
The Address Resolution Protocol (ARP) is a TCP/IP protocol that converts IP addresses into physical addresses. This table allows 
network managers to view, define, modify and delete ARP information for specific devices.  
Static entries can be defined in the ARP Table. When static entries are defined, a permanent entry is entered and is used to 
translate IP addresses to MAC addresses. 
To open the Static ARP Table click, Configuration > Layer 3 IP Networking > Static ARP Settings. 

 
Figure 6- 115. Static ARP Settings window 

To add a new entry, click the Add button, the following window will be displayed: 

 
Figure 6- 116. Static ARP Table – Add a New Entry window 

To modify an entry, click the Modify button, the following window will be displayed: 

 
Figure 6- 117. Static ARP Table - Modify 

The following fields can be set: 

Parameter               Description 

IP Address The IP address of the ARP entry. 

MAC Address The MAC address of the ARP entry. 

After entering the IP Address and MAC Address of the Static ARP entry, click Apply to implement the new entry. To completely 
clear the Static ARP Settings, click the Clear All button. 

 

NOTE: The Switch supports up to 255 static ARP entries.  
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Gratuitous ARP Settings 
An ARP announcement (also known as Gratuitous ARP) is a packet (usually an ARP Request) containing a valid SHA (Sender 
Hardware Address) and SPA (Sender Protocol Address) for the host which sent it, with TPA (Target Protocol Address) equal to 
SPA. Such a request is not intended to solicit a reply, but merely update the ARP caches of other hosts which receive the packet. 
This is commonly done by many operating systems on startup, and helps to resolve problems which would otherwise occur if, for 
example, a network card had recently been changed (changing the IP address to MAC address mapping) and other hosts still had 
the old mapping in their ARP cache. 
To open the Gratuitous ARP Settings window, click Configuration > Layer 3 IP Networking > Gratuitous ARP Settings. 

 
Figure 6- 118. Gratuitous ARP Settings Table 

Once you have made the desired gratuitous ARP setting changes, click Apply.  
To modify a current entry, click the corresponding Modify button of the entry to be modified, revealing the following window to 
configure: 

 
Figure 6- 119. Gratuitous ARP Settings – Edit window 

The following fields can be set or viewed: 

Parameter                     Description 

Send on IPIF status 
up 

This is used to enable/disable the sending of gratuitous ARP request packets while an IPIF 
interface comes up. This is used to automatically announce the interface’s IP address to other 
nodes. By default, the state is Enabled, and only one ARP packet will be broadcast. 

Send on Duplicate 
IP- Detected 

This is used to enable/disable the sending of gratuitous ARP request packets while a duplicate 
IP is detected. By default, the state is Enabled. Duplicate IP detected means that the system 
received an ARP request packet that is sent by an IP address that matches the system’s own 
IP address.  
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Gratuitous ARP 
Learning 

This is used to enable/disable updating ARP cache based on the received gratuitous ARP 
packet. If a switch receives a gratuitous ARP packet and the sender’s IP address in its ARP 
table, it should update the ARP entry. This is Enabled by default. 

Gratuitous ARP 
Trap & Log 

The switch can trap and log IP conflict events to inform the administrator. By default, trap is 
Disabled and event log is Enabled. 

Gratuitous ARP 
Periodical Send 
Interval 

This is used to configure the interval for the periodical sending of gratuitous ARP request 
packets. By default, the interval is 0. 

After making the desired changes, click Apply to implement the new Gratuitous ARP Table entry.  
 

DHCP/BOOTP Relay 
The relay hops count limit allows the maximum number of hops (routers) that the DHCP/BOOTP messages can be relayed 
through to be set. If a packet’s hop count is more than the hop count limit, the packet is dropped. The range is between 1 and 16 
hops, with a default value of 4. The relay time threshold sets the minimum time (in seconds) that the Switch will wait before 
forwarding a BOOTREQUEST packet. If the value in the second field of the packet is less than the relay time threshold, the 
packet will be dropped. The range is between 0 and 65535 seconds, with a default value of 0 seconds. 

DHCP / BOOTP Relay Global Settings 
To enable and configure DHCP/BOOTP Relay Global Settings on the Switch, click Configuration > Layer 3 IP Networking > 
DHCP/BOOTP Relay > DHCP/BOOTP Relay Global Settings: 

 
Figure 6- 120.  DHCP/ BOOTP Relay Global Settings window 

The following fields can be set: 

Parameter                 Description 

Relay State  This field can be toggled between Enabled and Disabled using the pull-down menu.  It is 
used to enable or disable the DHCP/BOOTP Relay service on the Switch. The default is 
Disabled 

Relay Hops Count 
Limit (1-16)  

This field allows an entry between 1 and 16 to define the maximum number of router hops 
DHCP/BOOTP messages can be forwarded across. The default hop count is 4. 

Relay Time Threshold 
(0-65535) 

Allows an entry between 0 and 65535 seconds, and defines the maximum time limit for 
routing a DHCP/BOOTP packet. If a value of 0 is entered, the Switch will not process the 
value in the seconds field of the BOOTP or DHCP packet. If a non-zero value is entered, 
the Switch will use that value, along with the hop count to determine whether to forward a 
given BOOTP or DHCP packet. 

DHCP Agent 
Information Option 82 
State 

This field can be toggled between Enabled and Disabled using the pull-down menu.  It is 
used to enable or disable the DHCP Agent Information Option 82 on the Switch.  The 
default is Disabled. 
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Enabled –When this field is toggled to Enabled the relay agent will insert and remove DHCP 
relay information (option 82 field) in messages between DHCP servers and clients. When 
the relay agent receives the DHCP request, it adds the option 82 information, and the IP 
address of the relay agent (if the relay agent is configured), to the packet. Once the option 
82 information has been added to the packet it is sent on to the DHCP server. When the 
DHCP server receives the packet, if the server is capable of option 82, it can implement 
policies like restricting the number of IP addresses that can be assigned to a single remote 
ID or circuit ID. Then the DHCP server echoes the option 82 field in the DHCP reply. The 
DHCP server unicasts the reply to the back to the relay agent if the request was relayed to 
the server by the relay agent. The switch verifies that it originally inserted the option 82 
data. Finally, the relay agent removes the option 82 field and forwards the packet to the 
switch port that connects to the DHCP client that sent the DHCP request. 

Disabled- If the field is toggled to Disabled the relay agent will not insert and remove DHCP 
relay information (option 82 field) in messages between DHCP servers and clients, and the 
check and policy settings will have no effect. 

DHCP Agent 
Information Option 82 
Check 

This field can be toggled between Enabled and Disabled using the pull-down menu.  It is 
used to enable or disable the Switches ability to check the validity of the packet’s option 82 
field. 
Enabled– When the field is toggled to Enable, the relay agent will check the validity of the 
packet’s option 82 field. If the switch receives a packet that contains the option-82 field from 
a DHCP client, the switch drops the packet because it is invalid. In packets received from 
DHCP servers, the relay agent will drop invalid messages.  
Disabled- When the field is toggled to Disabled, the relay agent will not check the validity of 
the packet’s option 82 field. 

DHCP Agent 
Information Option 82 
Policy 

This field can be toggled between Replace, Drop, and Keep by using the pull-down menu.  
It is used to set the Switches policy for handling packets when the DHCP Agent 
Information Option 82 Check is set to Disabled. The default is Replace. 
Replace- The option 82 field will be replaced if the option 82 field already exists in the 
packet received from the DHCP client. 
Drop- The packet will be dropped if the option 82 field already exists in the packet received 
from the DHCP client. 
Keep-The option 82 field will be retained if the option 82 field already exists in the packet 
received from the DHCP client.  

DHCP Agent 
Information Option 82 
Remote ID 

This field specifies the feature which allows the user to configure the Remote ID as any 
specific string. When the Remote ID state is set to Default, the switch’s system MAC 
address is used as the Remote ID. When the Remote ID state is configured to be user-
defined, the user-defined string is used as the Remote ID. 
Note: The maximum number of characters that can be used is 32.   

Click Apply to implement any changes that have been made. 

 

NOTE: If the Switch receives a packet that contains the option-82 field from a DHCP client and the 
information-checking feature is enabled, the switch drops the packet because it is invalid. However, in 
some instances, you might configure a client with the option-82 field. In this situation, you should 
disable the information-check feature so that the switch does not remove the option-82 field from the 
packet. You can configure the action that the switch takes when it receives a packet with existing 
option-82 information by configuring the DHCP Agent Information Option 82 Policy. 
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The Implementation of DHCP Information Option 82 in the xStack® DES-3500 
Series switches 
The config dhcp_relay option_82 command configures the DHCP relay agent information option 82 setting of the switch. The 
formats for the circuit ID sub-option and the remote ID sub-option are as follows:  

 

NOTE: For the circuit ID sub-option of a standalone switch, the module field is always zero. 

Circuit ID sub-option format: 

1.           2.            3.            4.            5.                              6.          7. 

1 6 0 4 VLAN Module Port 

1 byte    1 byte    1 byte    1 byte     2 bytes               1 byte   1 byte 
     

a. Sub-option type 
b. Length  
c. Circuit ID type 
d. Length  
e. VLAN :  the incoming VLAN ID of DHCP client packet. 
f. Module : For a standalone switch, the Module is always 0; For a stackable switch, the Module is the Unit ID. 
g. Port : The incoming port number of DHCP client packet, port number starts from 1. 

Remote ID sub-option format 1: 

1.           2.            3.            4.            5.                     

2 8 0 6 MAC address 

1 byte    1 byte    1 byte    1 byte     6 bytes 
 

1. Sub-option type  
2. Length 
3. Remote ID type  
4. Length 
5. MAC address: The Switch’s system MAC address.          

           Remote ID sub-option format 2 (Using user-defined string as remote ID): 
1.           2.            3.            4.            5.                     

2 n+2 1 n User-defined String 

1 byte    1 byte    1 byte    1 byte     6 bytes 
 

1. Sub-option type  
2. Length: the string length of the Remote ID suboption 
3. Remote ID type  
4. Length: the string length of user-defined string 
5. User-defined string          

 

Figure 6- 121. Circuit ID and Remote ID Sub-option Format 
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DHCP/BOOTP Relay Interface Settings 

The DHCP/ BOOTP Relay Interface Settings allows the user to set up a server, by IP address, for relaying DHCP/ BOOTP 
information to the Switch. The user may enter a previously configured IP interface on the Switch that will be connected directly to 
the DHCP/BOOTP server using the following window. Properly configured settings will be displayed in the BOOTP Relay 
Table at the bottom of the following window, once the user clicks the Add button under the Apply heading. The user may add up 
to four server IPs per IP interface on the Switch. Entries may be deleted by clicking it’s corresponding . To enable and 
configure DHCP/BOOTP Relay Global Settings on the Switch, click Configuration > Layer 3 IP Networking > 
DHCP/BOOTP Relay > DHCP/BOOTP Relay Interface Settings: 

 
Figure 6- 122. DHCP/BOOTP Relay Interface Settings and DHCP/BOOTP Relay Interface Table window 

The following parameters may be configured or viewed. 

Parameter                       Description 

Interface The IP interface on the Switch that will be connected directly to the Server. 

Server IP Enter the IP address of the DHCP/BOOTP server. Up to four server IPs can be configured 
per IP Interface 
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DHCP Option 60 Settings 

The DHCP Option 60 Settings allows the Switch to monitor Option 60 contents of the DHCP client packets and determine which 
client packets to relay to the DHCP Server and which packets to drop.   

To enable and configure DHCP Option 60 Global Settings on the Switch, click Configuration > Layer 3 IP Networking > 
DHCP/BOOTP Relay > DHCP Option 60 Settings: 

 
Figure 6- 123. DHCP Option 60 Settings Table window 

The following parameters may be configured or viewed. 

Parameter                       Description 

Status Use the drop down menu to Enable or Disable the DHCP Option 60 Global Settings. 

Default Processing 
Mode 

Use the drop down menu to choose between Drop or Relay. This function allows the User to 
specify how the Switch will assess the content of the DHCP client packet and decide 
whether to relay the packet to a DHCP Server or just simply drop it.   

Server IP Enter the Server IP Address and click Add. 

String A string can map to multiple DHCP servers, but not more than 4 servers at a time, also a 
DHCP server can map to multiple strings, but not to any more than 50. Enter the String and 
press Delete to delete the entry.   

IP Address Enter the Server IP Address and click Add. 

Match Type Use the drop down menu to choose between Exact Match or Partial Match. Exact Match will 
exactly match the client string to the specified string. Partial Match will only partically match 
the DHCP client string to the specified string.  
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DHCP Option 61 Settings 

The DHCP Option 61 Settings allows the Switch to monitor Option 61 contents of the DHCP client packets and determine which 
client packets to relay to the DHCP Server and which packets to drop.   

To enable and configure DHCP Option 61 Global Settings on the Switch, click Configuration > Layer 3 IP Networking > 
DHCP/BOOTP Relay > DHCP Option 61 Settings: 

 
Figure 6- 124. DHCP Option 60 Settings Table window 

The following parameters may be configured or viewed. 

Parameter                       Description 

Status Use the drop down menu to Enable or Disable the DHCP Option 61 Global Settings. 

Default Processing 
Mode 

Use the drop down menu to choose between Drop or Relay. This function allows the User to 
specify how the Switch will assess the content of the DHCP client packet and decide 
whether to relay the packet to a DHCP Server or just simply drop it.   

Default Server Enter the IP Address of the Default Server that will be used during processing. 

Client ID Use the drop down menu to select String or MAC Address as the identifier. 

Mode Use the drop down menu to choose between Exact Match or Partial Match. Exact Match will 
exactly match the client string to the specified string. Partial Match will only partically match 
the DHCP client string to the specified string.  

IP Address Enter the Server IP Address and click Add. 

String A string can map to multiple DHCP servers, but not more than 4 servers at a time, also a 
DHCP server can map to multiple strings, but not to any more than 50. Enter the String and 
press Delete to delete the entry.   

MAC Address Enter the MAC Address and click Delete to remove the entry.   
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DHCP Local Relay Settings 

The DHCP Local Relay Settings are used to request packets from the Client to the Server. As a result of the customer’s 
networking environment, DCHP Local Relay is implemented so that it is independent from the original behavior of DHCP relay. 
The DHCP Local Relay is also independent from the option82 module in the forwarding way and the content of DHCP request 
packets from Client to Server.  
To enable and configure DHCP Local Relay Global Settings on the Switch, click Configuration > Layer 3 IP Networking > 
DHCP/BOOTP Relay > DHCP Local Relay Settings: 

 
Figure 6- 125. DHCP Local Relay Settings window 

The following parameters may be configured or viewed. 

Parameter                          Description 

DHCP/BOOTP Local 
Relay Operation State 

Used to Enable or Disable the DHCP/BOOTP Local Relay Operation State. 

VLAN Name This is the VLAN Name that identifies the VLAN the user wishes to modify the 
DHCP/BOOTP Local Relay Settings for. 

VID List This is the VID List that identifies the VLAN the user wishes to modify the DHCP/BOOTP 
Local Relay Settings for. 

State Enable or Disable the DHCP/BOOTP Local Relay Settings state.  

Click Apply to implement changes made.  
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LLDP 
The Link Layer Discovery Protocol (LLDP) allows stations attached to an IEEE 802 LAN to advertise, to other stations attached 
to the same IEEE 802 LAN. The major capabilities provided by this system is that it incorporates the station, the management 
address or addresses of the entity or entities that provide management of those capabilities, and the identification of the station’s 
point of attachment to the IEEE 802 LAN required by those management entity or entities. 
The information distributed via this protocol is stored by its recipients in a standard Management Information Base (MIB), 
making it possible for the information to be accessed by a Network Management System (NMS) through a management protocol 
such as the Simple Network Management Protocol (SNMP). 

LLDP Global Settings 
To view this window, click Configuration > LLDP > LLDP Global Settings 

 
Figure 6- 126. LLDP Global Settings window 

The following parameters can be set: 

Parameter                 Description 

LLDP State Used to Enable or Disable LLDP on the Switch.   

LLDP Forward 
Message 

Enable or Disable the message forwarding of the LLDP function, to advertise to other stations 
attached to the same IEEE 802 LAN. 

Message TX 
Interval (5-32768) 

This interval controls how often active ports retransmit advertisements to their neighbors. To 
change the packet transmission interval, enter a value in seconds (5 to 32768). 

Message TX Hold 
Multiplier (2-10) 

This function calculates the Time-to-Live for creating and transmitting the LLDP advertisements 
to LLDP neighbors by changing the multiplier used by an LLDP Switch. When the Time-to-Live 
for an advertisement expires the advertised data is then deleted from the neighbor Switch’s MIB.



xStack® DES-3500 Series Layer 2 Stackable Fast Ethernet Managed Switch User Manual 

 143

Re Init Delay (1-
10) 

The LLDP reinitialization delay interval is the minimum time that an LLDP port will wait before 
reinitializing after receiving an LLDP disable command. To change the LLDP Reinit Delay, enter 
a value in seconds (1 to 10).   

TX Delay (1-8192) LLDP TX Delay allows the user to change the minimum time delay interval for any LLDP port 
which will delay advertising any successive LLDP advertisements due to change in the LLDP 
MIB content. To change the LLDP TX Delay, enter a value in seconds (1 to 8192). 

Notification 
Interval (5-3600) 

LLDP Notification Interval is used to send notifications to configured SNMP trap receiver(s) when 
an LLDP change is detected in an advertisement received on the port from an LLDP neighbor. 
To set the LLDP Notification Interval, enter a value in seconds (5 to 3600).   

Click Apply to implement changes made.  
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Basic LLDP Port Settings 
To view this window, click Configuration > LLDP > Basic LLDP Port Settings 

 
Figure 6- 127. Basic LLDP Port Settings window 

The following parameters can be set: 

Parameter                 Description 

From Port/To 
Port 

Use the pull-down menu to select a range of ports to be configured.  

Notification State Use the pull-down menu to Enable or Disable the status of the LLDP notification.   

Admin State Select the status of the notification, use the drop-down menu to choose between TX, RX, TX And 
RX or Disabled. 

Port Description Use the pull-down menu to Enable or Disable the status of the LLDP Port Description.   

System Name Use the pull-down menu to Enable or Disable the status of the LLDP System Name.   

System 
Description 

Use the pull-down menu to Enable or Disable the status of the LLDP System Description.   

System Use the pull-down menu to Enable or Disable the status of the LLDP System Capabilities.   
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Capabilities 
Click Apply to implement changes made.  

802.1 Extension LLDP Port Settings 
To view this window, click Configuration > LLDP > 802.1 Extension LLDP Port Settings 

 
Figure 6- 128. 802.1 Extension LLDP Port Settings window 

The following parameters can be set: 

Parameter                 Description 
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From Port/To  Use the drop-down menu to select a range of ports to be configured. 

Port VLAN ID Use the drop-down menu to Enable or Disable the advertise Port VLAN ID. 

VLAN Name Use the drop-down menu to Enable or Disable the advertised VLAN ID, VLAN Name or All. 

Protocol Identify Use the drop-down menu to Select the advertised Protocol Identity. Select EAPOL, LACP, 
GVRP, STP or All. 

Click Apply to implement changes made.  
 

802.3 Extension LLDP Port Settings 
To view this window, click Configuration > LLDP > 802.3 Extension LLDP Port Settings 

 
Figure 6- 129. 802.3 Extension LLDP Port Settings window 

The following parameters can be set: 
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Parameter                 Description 

From Port/To  Use the drop-down menu to select a range of ports to be configured. 

MAC/PHY 
Configuration 
Status 

Use the drop-down menu to configure the advertise MAC PHY status of the switch.   

Link Aggregation Use the drop-down menu to Enable or Disable the advertise link aggregation state on the Switch.  

Maximum Frame 
Size 

Use the drop-down menu to Enable or Disable the advertised Maximum Frame Size. 

Click Apply to implement changes made.  
 

LLDP Management Address Settings 
To view this window, click Configuration > LLDP > LLDP Management Address Settings 

 
Figure 6- 130. LLDP Management Address List window 
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The following parameters can be set: 

Parameter                 Description 

Port From/To Use the drop-down menu to select a range of ports to be configured. 

Address 
Type/Address 

Enter the management ip address or the ip address of the entity you wish to advertise to. IPv4 
will ensure the message is sent by the router to ask for the advertisements. 

Port State Use the drop-down menu to Enable or Disable the Port State. 

Click Find to implement changes made.  
 

LLDP Statistics 
This window is used to view the settings for LLDP Statistics. 
To view this window, click Configuration > LLDP > LLDP Statistics 

 
Figure 6- 131. LLDP Statistics window 
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LLDP Management Address Table 
To view this window, Click Configuration > LLDP > LLDP Management Address Table 

 
Figure 6- 132. LLDP Management Address Table window 

Enter the IPv4 Address of the LLDP entry and click Find to display the details in the table.  

LLDP Local Port Table 
LLDP Local Port Information window displays the information on a per port basis in the local port brief table shown below.   
To view this window, click Configuration > LLDP > LLDP Local Port Table 

 
Figure 6- 133. LLDP Local Port Table window 
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To view the information on a per port basis click the View (Normal) button, which will display the following window: 

 
Figure 6- 134. LLDP Local Port Information (Normal) window 

 
To view detailed information about MAC/PHY Configuration/Status or Link Aggregration, click the hyperlinked see detailed.  To 
return to the previous window click the hyperlinked Show LLDP Local Port Berif Table.  To view more detailed information of 
individual parameters click the hyperlinked Show LLDP Local Port Detailed Table, which will reveal the following window; 
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Figure 6- 135. LLDP Local Port Information (Detail) window 

To return to the LLDP Local Port Berif Information window, click the hyperlinked Show LLDP Local Port Berif Table, or to 
return to the Local Port Normal window click the hyperlinked Show LLDP Local Port Normal Table. 
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LLDP Remote Port Information 
To view this window, click Configuration > LLDP > LLDP Remote Port Table 

 
Figure 6- 136. LLDP Remote Port Information window 

Select the port you wish to view by using the drop-down menu and click Find the information will be displayed in the lower half 
of the table.  
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Section 7 
Security Management 

Tustred Host 

User Accounts 

Port Access Entity 

Access Authentication Control 

Secure Sockets Layer (SSL) 

Secure Shell (SSH) 

SNMP Manager 

Safeguard Engine Settings 

Filter 

ARP Spoofing Prevention 

 
The following section will aid the user in configuring security functions for the Switch. The Switch includes various functions for 
security, including TACACS, Security IPs, SSL, SSH and SNMP, all discussed in detail in the following section. 

Trusted Host  
Use the Security IP Management to permit remote stations to manage the Switch. If you choose to define one or more designated 
management stations, only the chosen stations, as defined by IP address, will be allowed management privilege through the web 
manager or Telnet session. You are allowed to enter IP address or IP submask to manage the Switch, and then click the Apply 
button to implement the setting. To remove an individual security IP address from the Switch, click the corresponding  button 
under the Delete heading. To remove all security IP addresses from the Switch, click the  button.  
To view this window, click Security Management > Trusted Host, the following window will appear. 
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Figure 7- 1. Trusted Host window 

User Accounts 
Use the User Account Management window to control user privileges. To view existing User Accounts, open the Security 
Management folder and click on the User Accounts link. This will open the User Account Management window, as shown 
below. 

 
Figure 7- 2. User Accounts Management window 

To add a new user, click on the Add button. To modify or delete an existing user, click on the Modify button for that user. 

 
Figure 7- 3. User Accounts Modify Table window - Add 
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Add a new user by typing in a User Name, and New Password and retype the same password in the Confirm New Password. 
Choose the level of privilege (Admin, Operator, or User) from the Access Right drop-down menu and click Apply. To return to 
the User Account Table click the hyperlinked Show All User Account Entries. 

   

NOTICE: In case of lost passwords or password corruption, please refer to the 
D-Link website and the White Paper entitled “Password Recovery Procedure”, 
which will guide you through the steps necessary to resolve this issue. 

 
Figure 7- 4. User Accounts Modify Table window - Modify 

Modify or delete an existing user account in the User Account Modify Table. To delete the user account, click on the Delete 
button. To change the password, type in the New Password and retype it in the Confirm New Password entry field. The level of 
privilege (Admin, Operator, or User) can be viewed in the Access Right field. To return to the User Account Table click the 
hyperlinked Show All User Account Entries. 
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Port Access Entity (802.1X) 
802.1x Port-Based and MAC-Based Access Control 
The IEEE 802.1x standard is a security measure for authorizing and authenticating users to gain access to various wired or 
wireless devices on a specified Local Area Network by using a Client and Server based access control model. This is 
accomplished by using a RADIUS server to authenticate users trying to access a network by relaying Extensible Authentication 
Protocol over LAN (EAPOL) packets between the Client and the Server. The following figure represents a basic EAPOL packet: 

 
Figure 7- 5. EAPOL Packet 

Utilizing this method, unauthorized devices are restricted from connecting to a LAN through a port to which the user is connected. 
EAPOL packets are the only traffic that can be transmitted through the specific port until authorization is granted. The 802.1x 
Access Control protocol consists of three components, each of which is vital to creating and maintaining a stable and working 
Access Control security method.  

 
Figure 7- 6. Three Functions of 802.1x 

The following section will explain Client, Authenticator, and Authentication Server in greater detail. 
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Authentication Server 
The Authentication Server is a remote device that is connected to the same network as the Client and Authenticator, must be 
running a RADIUS Server program and must be configured properly on the Authenticator (Switch). The Authentication Server 
(RADIUS) must authenticate clients connected to a port on the Switch before attaining any services offered by the Switch on the 
LAN. The role of the Authentication Server is to certify the identity of the Client attempting to access the network by exchanging 
secure information between the RADIUS server and the Client through EAPOL packets and, in turn, informs the Switch whether 
or not the Client is granted access to the LAN and/or switch services.  

 
Figure 7- 7. Authentication Server 

Authenticator 
The Authenticator (the Switch) is an intermediary between the Authentication Server and the Client. The Authenticator serves two 
purposes when utilizing 802.1x. The first purpose is to request certification information from the Client through EAPOL packets, 
which is the only information allowed to pass through the Authenticator before access is granted to the Client. The second purpose 
of the Authenticator is to verify the information gathered from the Client with the Authentication Server, and to then relay that 
information back to the Client. 

Three steps must be implemented on the Switch to properly configure the Authenticator. 
1. The 802.1x State must be enabled. (Configuration > Switch Information > Advanced Settings > 802.1x Status) 
2. The 802.1x settings must be implemented by port. (Port Access Entity > PAE System Control > Port Capability > 

Capability) 
3. A RADIUS server must be configured on the Switch. (Port Access Entity > RADIUS Server > Authentic RADIUS 

Server) 

 
Figure 7- 8. Authenticator 



xStack® DES-3500 Series Layer 2 Stackable Fast Ethernet Managed Switch User Manual 

 158

Client 
The Client is simply the workstation that wishes to gain access to the LAN or switch services. All workstation must be running 
software that is compliant with the 802.1x protocol. For users running Windows XP, that software is included within the operating 
system. All other users are required to attain 802.1x client software from an outside source. The Client will request access to the 
LAN and or Switch through EAPOL packets and, in turn will respond to requests from the Switch.  
 

 
Figure 7- 9. Client 

Authentication Process 
Utilizing the three components stated above, the 802.1x protocol provides a stable and secure way of authorizing and 
authenticating users attempting to access the network. Only EAPOL traffic is allowed to pass through the specified port before a 
successful authentication is made. This port is “locked” until the point when a Client with the correct username and password (and 
MAC address if 802.1x is enabled by MAC address) is granted access and therefore successfully “unlocks” the port. Once 
unlocked, normal traffic is allowed to pass through the port. The D-Link implementation of 802.1x allows network administrators 
to choose between two types of Access Control used on the Switch, which are: 

1. Port-Based Access Control – This method requires only one user to be authenticated per port by a remote RADIUS server 
to allow the remaining users on the same port access to the network.  

2. MAC-Based Access Control – Using this method, the Switch will automatically learn up to sixteen MAC addresses by 
port and set them in a list. The Switch using a remote RADIUS server before being allowed access to the Network must 
authenticate each MAC address.  
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Port-Based Network Access Control 
The original intent behind the development of 802.1x was to leverage the characteristics of point-to-point in LANs. Any single 
LAN segment in such an infrastructures has no more than two devices attached to it, one of which is a Bridge Port. The Bridge 
Port detects events that indicate the attachment of an active device at the remote end of the link, or an active device becoming 
inactive. These events can be used to control the authorization state of the Port and initiate the process of authenticating the 
attached device if the Port is unauthorized. This is the Port-Based Network Access Control. 
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Figure 7- 10. Example of Typical Port-Based Configuration 

Once the connected Client has successfully been authenticated, the Port then becomes Authorized, and all subsequent traffic on 
the Port is not subject to access control restriction until an event occurs that causes the Port to become Unauthorized. Hence, if the 
Port is actually connected to a shared media LAN segment with more than one attached device, successfully authenticating one of 
the attached devices effectively provides access to the LAN for all devices on the shared segment. Clearly, the security offered in 
this situation is open to attack. 
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MAC-Based Network Access Control 
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Figure 7- 11. Example of Typical MAC-Based Configuration 

In order to successfully make use of 802.1x in a shared media LAN segment, it would be necessary to create “virtual” Ports, one 
for each attached device that required access to the LAN. The Switch would regard the single physical Port connecting it to the 
shared media segment as consisting of a number of distinct virtual Ports, each virtual Port being independently controlled from the 
point of view of EAPOL exchanges and authorization state. The Switch learns each attached device’s individual MAC address, 
and effectively creates a virtual Port that the attached device can then use to communicate with the LAN via the Switch. 
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Configure Authenticator 
To configure the 802.1X Authenticator Settings, click Security > Port Access Entity > Configure Authenticator: 

 
Figure 7- 12. 802.1X Authenticator Settings window 

To configure the settings by port, click on the hyperlinked port number under the Port heading, which will display the following 
table to configure: 
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Figure 7- 13. 802.1X Authenticator Settings window (Modify) 

This window allows you to set the following features: 

Parameter               Description 

From [    ] To [   ] Enter the port or ports to be set. 

AdmCtrlDir  Sets the administrative-controlled direction to either in or both.  
If in is selected, control is only exerted over incoming traffic through the port you selected in 
the first field.  
If both are selected, control is exerted over both incoming and outgoing traffic through the 
controlled port selected in the first field. 

PortControl  This allows you to control the port authorization state.  
Select forceAuthorized to disable 802.1X and cause the port to transition to the authorized 
state without any authentication exchange required. This means the port transmits and 
receives normal traffic without 802.1X-based authentication of the client.  
If forceUnauthorized is selected, the port will remain in the unauthorized state, ignoring all 
attempts by the client to authenticate. The Switch cannot provide authentication services to 
the client through the interface.  
If Auto is selected, it will enable 802.1X and cause the port to begin in the unauthorized 
state, allowing only EAPOL frames to be sent and received through the port. The 
authentication process begins when the link state of the port transitions from down to up, or 
when an EAPOL-start frame is received. The Switch then requests the identity of the client 
and begins relaying authentication messages between the client and the authentication 
server. 
The default setting is Auto. 

TxPeriod This sets the TxPeriod of time for the authenticator PAE state machine. This value 
determines the period of an EAP Request/Identity packet transmitted to the client. The 
default setting is 30 seconds. 

QuietPeriod This allows you to set the number of seconds that the Switch remains in the quiet state 
following a failed authentication exchange with the client. The default setting is 60 seconds. 

SuppTimeout This value determines timeout conditions in the exchanges between the Authenticator and 
the client. The default setting is 30 seconds. 
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ServerTimeout This value determines timeout conditions in the exchanges between the Authenticator and 
the authentication server. The default setting is 30 seconds. 

MaxReq  The maximum number of times that the Switch will retransmit an EAP Request to the client 
before it times out of the authentication sessions. The default setting is 2. 

ReAuthPeriod A constant that defines a nonzero number of seconds between periodic reauthentication of 
the client. The default setting is 3600 seconds. 

ReAuth  Determines whether regular reauthentication will take place on this port. The default setting 
is Disabled. 

Click Apply to implement your configuration changes. To view configurations for the 802.1X Authenticator Settings on a port-
by-port basis, see the 802.1X Authenticator Settings table. To return to the Authenticator Table click the hyperlinked Show 
Authenticators Setting. 
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PAE System Control 
Existing 802.1x port settings are displayed and can be configured using the windows below. 

Port Capability 
Click, Security Management > Port Access Entity > PAE System Control > Port Capability to view the following window: 

 
Figure 7- 14. 802.1x Capability Settings window 

To set up the Switch's 802.1x port-based authentication, select which ports are to be configured in the From and To fields. Next, 
enable the ports by selecting Authenticator from the drop-down menu under Capability. Click Apply to let your change take effect. 
Configure the following 802.1x capability settings: 

Parameter                       Description 
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From and To Ports being configured for 802.1x settings. 

Capability Two role choices can be selected: 
Authenticator - A user must pass the authentication process to gain access to the network. 
None - The port is not controlled by the 802.1x functions. 

 
Initializing Ports for Port Based 802.1x 
Existing 802.1x port and MAC settings are displayed and can be configured using the window below. 
Click Security Management > Port Access Entity > PAE System Control > Initialize Port(s) to open the following window: 

 
Figure 7- 15. Initialize Port window 

This window allows the initialization of a port or group of ports. The Initialize Port Table in the bottom half of the window 
displays the current status of the port(s).  
This window displays the following information: 

Parameter                           Description 

From and To Select ports to be initialized. 

Port A read-only field indicating a port on the Switch. 

MAC Address The MAC address of the Switch connected to the corresponding port, if any. 

Auth PAE State The Authenticator PAE State will display one of the following: Initialize, Disconnected, 
Connecting, Authenticating, Authenticated, Aborting, Held, ForceAuth, ForceUnauth, and 
N/A. 

Backend State The Backend Authentication State will display one of the following: Request, Response, 
Success, Fail, Timeout, Idle, Initialize, and N/A. 

Port Status The status of the controlled port can be Authorized, Unauthorized, or N/A. 
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Initializing Ports for MAC Based 802.1x 

To initialize ports for the MAC side of 802.1x, the user must first enable 802.1x by MAC address in the Advanced Settings 
window. Click Security Management > Port Access Entity > PAE System Control > Initialize Port(s) to open the following 
window: 

 
Figure 7- 16. Initialize Port(s) window (MAC based 802.1x) 

To initialize ports, first choose the range of ports in the From and To field. Then the user must specify the MAC address to be 
initialized by entering it into the MAC Address field and checking the corresponding check box. To begin the initialization, click 
Apply. 

 

NOTE: The user must first globally enable 802.1X in the Switch Information 
(Advanced Settings) window in the Configuration folder before initializing ports. 
Information in the Initialize Ports Table cannot be viewed before enabling 802.1X. 

Reauthenticate Port(s) for Port Based 802.1x 
This window allows you to reauthenticate a port or group of ports by choosing a port or group of ports by using the pull down 
menus From and To and clicking Apply. The Reauthenticate Port Table displays the current status of the reauthenticated port(s) 
once you have clicked Apply.    
Click Security Management > Port Access Entity > PAE System Control > Reauthenticate Port(s) to open the 
Reauthenticate Port(s) window: 

 
Figure 7- 17. Reauthenticate Port (Port Based 802.1x) window 

This window displays the following information: 

Parameter                   Description 

Port The port number of the reauthenticated port. 

MAC Address Displays the physical address of the Switch where the port resides. 

Auth State The Authenticator State will display one of the following: Initialize, Disconnected, Connecting, 
Authenticating, Authenticated, Aborting, Held, ForceAuth, ForceUnauth, and N/A. 
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BackendState The Backend State will display one of the following: Request, Response, Success, Fail, 
Timeout, Idle, Initialize, and N/A. 

OpenDir Operational Controlled Directions are both and in. 

PortStatus The status of the controlled port can be Authorized, Unauthorized, or N/A. 

 

Reauthenticate Port(s) for MAC Based 802.1x 
This window allows you to reauthenticate a port or group of ports by using the pull down menus From and To to select the ports , 
enter a MAC Address and click Apply.  
Click Security Management > Port Access Entity > PAE System Control > Reauthenticate Port(s) to open the 
Reauthenticate Port(s) window: 

 
Figure 7- 18. Reauthenticate Port (MAC Based 802.1x) window 

RADIUS Server 
The RADIUS feature of the Switch allows you to facilitate centralized user administration as well as providing protection against 
a sniffing, active hacker. The Web Manager offers three windows.    
Click Security Management > Port Access Entity > RADIUS Server > Authentic RADIUS Server to open the RADIUS 
Server Authentication Setting window shown below: 

 
Figure 7- 19. RADIUS Server Authentication Setting window 
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This window displays the following information: 

Parameter                   Description 

Succession  Choose the desired RADIUS server to configure: First, Second or Third. 

RADIUS Server  Set the RADIUS server IP. 

Authentic Port  Set the RADIUS authentic server(s) UDP port. The default port is 1812. 

Accounting Port  Set the RADIUS account server(s) UDP port. The default port is 1813. 

Key Set the key the same as that of the RADIUS server. 

Confirm Key Confirm the shared key is the same as that of the RADIUS server. 

Accounting Method This allows you to Add/Modify or Delete the RADIUS Server. 

Guest VLANs 

 
Figure 7- 20. Guest VLAN Authentication Process 

Limitations Using the Guest VLAN      
1. Guest VLANs are only supported for port-based VLANs. MAC-based VLANs cannot undergo this procedure. 
2. Ports supporting Guest VLANs cannot be GVRP enabled and vice versa.  
3. A port cannot be a member of a Guest VLAN and a static VLAN simultaneously.  
4. Once a client has been accepted into the target VLAN, it can no longer access the Guest VLAN. 
5. If a port is a member of multiple VLANs, it cannot become a member of the Guest VLAN. 

On 802.1x security enabled networks, there is a need for non 
802.1x supported devices to gain limited access to the network, 
due to lack of the proper 802.1x software or incompatible 
devices, such as computers running Windows 98 or lower 
operating systems, or the need for guests to gain access to the 
network without full authorization. To supplement these 
circumstances, this switch now implements Guest 802.1x 
VLANs. These VLANs should have limited access rights and 
features separate from other VLANs on the network.  

To implement Guest 802.1x VLANs, the user must first create a 
VLAN on the network with limited rights and then enable it as an 
802.1x guest VLAN. Then the administrator must configure the 
guest accounts accessing the Switch to be placed in a Guest 
VLAN when trying to access the Switch. Upon initial entry to the 
Switch, the client wishing services on the Switch will need to be 
authenticated by a remote RADIUS Server or local authentication 
on the Switch to be placed in a fully operational VLAN. If 
authenticated and the authenticator posseses the VLAN 
placement information, that client will be accepted into the fully 
operational target VLAN and normal switch functions will be 
open to the client. If the authenticator does not have target VLAN 
placement information, the client will be returned to its 
originating VLAN. Yet, if the client is denied authentication by 
the authenticator, it will be placed in the Guest VLAN where it 
has limited rights and access. The adjacent figure should give the 
user a better understanding of the Guest VLAN process. 
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Guest VLAN Configuration 
Remember, to set a guest 802.1x VLAN, the user must first configure a normal VLAN which can be enabled here for Guest 
VLAN status.  To view this window, click Security Management > Port Access Entity > RADIUS Server > Guest VLAN, 
which will display the following window for the user to configure.  

 
Figure 7- 21. Guest VLAN Configuration window 

 
The following fields may be modified to enable the guest 802.1x VLAN: 

Parameter                 Description 

VLAN Name Enter the pre-configured VLAN name to create as a guest 802.1x VLAN. 

Operation Allows the user to enable or disable ports for the guest 802.1x VLAN, using the Port List stated 
below. 

Port List Set the port list of ports to be enabled or disabled for the guest 802.1x VLAN using the pull down 
menus. 

Click Apply to implement the guest 802.1x VLAN. Once properly configured, the Guest VLAN Name and associated ports will 
be listed in the lower part of the window. 

 

NOTE: For more information and configuration examples for the 802.1X Guest VLAN 
function, please refer to the Guest VLAN Configuration Example located on the D-Link 
website. 

 
 

Access Authentication Control 
The TACACS/XTACACS/TACACS+/RADIUS commands let you secure access to the Switch using the 
TACACS/XTACACS/TACACS+/RADIUS protocols. When a user logs in to the Switch or tries to access the administrator level 
privilege, he or she is prompted for a password. If TACACS/XTACACS/TACACS+/RADIUS authentication is enabled on the 
Switch, it will contact a TACACS/XTACACS/TACACS+/RADIUS server to verify the user. If the user is verified, he or she is 
granted access to the Switch. 
There are currently three versions of the TACACS security protocol, each a separate entity. The Switch's software supports the 
following versions of TACACS: 

• TACACS (Terminal Access Controller Access Control System) - Provides password checking and authentication, and 
notification of user actions for security purposes utilizing via one or more centralized TACACS servers, utilizing the 
UDP protocol for packet transmission. 

• Extended TACACS (XTACACS) - An extension of the TACACS protocol with the ability to provide more types of 
authentication requests and more types of response codes than TACACS. This protocol also uses UDP to transmit 
packets. 

• TACACS+ (Terminal Access Controller Access Control System plus) - Provides detailed access control for 
authentication for network devices. TACACS+ is facilitated through Authentication commands via one or more 
centralized servers. The TACACS+ protocol encrypts all traffic between the Switch and the TACACS+ daemon, using 
the TCP protocol to ensure reliable delivery 
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In order for the TACACS/XTACACS/TACACS+/RADIUS security function to work properly, a 
TACACS/XTACACS/TACACS+/RADIUS server must be configured on a device other than the Switch, called an Authentication 
Server Host and it must include usernames and passwords for authentication. When the user is prompted by the Switch to enter 
usernames and passwords for authentication, the Switch contacts the TACACS/XTACACS/TACACS+/RADIUS server to verify, 
and the server will respond with one of three messages: 

• The server verifies the username and password, and the user is granted normal user privileges on the Switch.  
• The server will not accept the username and password and the user is denied access to the Switch. 
• The server doesn't respond to the verification query. At this point, the Switch receives the timeout from the server and 

then moves to the next method of verification configured in the method list. 

The Switch has four built-in Authentication Server Groups, one for each of the TACACS, XTACACS, TACACS+ and RADIUS 
protocols. These built-in Authentication Server Groups are used to authenticate users trying to access the Switch. The users will 
set Authentication Server Hosts in a preferable order in the built-in Authentication Server Groups and when a user tries to gain 
access to the Switch, the Switch will ask the first Authentication Server Hosts for authentication. If no authentication is made, the 
second server host in the list will be queried, and so on. The built-in Authentication Server Groups can only have hosts that are 
running the specified protocol. For example, the TACACS Authentication Server Groups can only have TACACS Authentication 
Server Hosts. 
The administrator for the Switch may set up six different authentication techniques per user-defined method list 
(TACACS/XTACACS/TACACS+/RADIUS/local/none) for authentication. These techniques will be listed in an order preferable, 
and defined by the user for normal user authentication on the Switch, and may contain up to eight authentication techniques. 
When a user attempts to access the Switch, the Switch will select the first technique listed for authentication. If the first technique 
goes through its Authentication Server Hosts and no authentication is returned, the Switch will then go to the next technique listed 
in the server group for authentication, until the authentication has been verified or denied, or the list is exhausted. 
Please note that users granted access to the Switch will be granted normal user privileges on the Switch. To gain access to 
administrator level privileges, the user must access the Enable Admin window, which is only available for logining in the Switch 
from the three versions of the TACACS server, and then enter a password, which was previously configured by the administrator 
of the Switch. 

 

NOTE: TACACS, XTACACS and TACACS+ are separate entities and are not compatible. The Switch 
and the server must be configured exactly the same, using the same protocol. (For example, if the 
Switch is set up for TACACS authentication, so must be the host server.) 
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Policy & Parameters 
This command will enable an administrator-defined authentication policy for users trying to access the Switch. When enabled, the 
device will check the Login Method List and choose a technique for user authentication upon login.   
To access the following window, click Security Management > Access Authentication Control > Policy & Parameters: 

 
Figure 7- 22. Policy & Parameters Settings window 

The following parameters can be set: 

Parameters                      Description  

Authentication Policy Use the pull-down menu to enable or disable the Authentication Policy on the Switch. 

Response Timeout (0-
255) 

This field will set the time the Switch will wait for a response of authentication from the user. 
The user may set a time between 0 and 255 seconds. The default setting is 0 seconds. 

User Attempts (1-255) This command will configure the maximum number of times the Switch will accept 
authentication attempts. Users failing to be authenticated after the set amount of attempts 
will be denied access to the Switch and will be locked out of further authentication attempts. 
Command line interface users will have to wait 60 seconds before another authentication 
attempt. Telnet and web users will be disconnected from the Switch. The user may set the 
number of attempts from 1 to 255. The default setting is 3. 

Click Apply to implement changes made. 

Application's Authentication Settings 
This window is used to configure switch configuration applications (console, Telnet, SSH, web) for login at the user level and at 
the administration level (Enable Admin) utilizing a previously configured method list. To view the following window, click 
Security Management > Access Authentication Control > Application Authentication Settings: 

 
Figure 7- 23. Application's Authentication Settings window 

The following parameters can be set: 

Parameter                    Description 

Application Lists the configuration applications on the Switch. The user may configure the Login Method 
List and Enable Method List for authentication for users utilizing the Console (Command Line 
Interface) application, the Telnet application, SSH and the WEB (HTTP) application. 

Login Method List Using the pull down menu, configure an application for normal login on the user level, utilizing 
a previously configured method list. The user may use the default Method List or other Method 
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List configured by the user. See the Login Method Lists window, in this section, for more 
information. 

Enable Method List Using the pull down menu, configure an application for normal login on the user level, utilizing 
a previously configured method list. The user may use the default Method List or other Method 
List configured by the user. See the Enable Method Lists window, in this section, for more 
information 

Click Apply to implement changes made. 

Authentication Server Group 
This window will allow users to set up Authentication Server Groups on the Switch. A server group is a technique used to group 
TACACS/XTACACS/TACACS+/RADIUS server hosts into user-defined categories for authentication using method lists. The 
user may define the type of server group by protocol or by previously defined server group. The Switch has three built-in 
Authentication Server Groups that cannot be removed but can be modified. Up to eight authentications server hosts may be added 
to any particular group. 
To view the following window, click Security Management > Access Authentication Control > Authentication Server Group: 

 
Figure 7- 24. Authentication Server Group Settings window 

This screen displays the Authentication Server Groups on the Switch. The Switch has four built-in Authentication Server Groups 
that cannot be removed but can be modified. To modify a particular group, click its hyperlinked Group Name, which will then 
display the following window. 

 
Figure 7- 25. Add a Server Host to Server Group (xtacas) window 

To add an Authentication Server Host to the list, enter its IP address in the IP Address field, choose the protocol associated with 
the IP address of the Authentication Server Host and click Add to Group to add this Authentication Server Host to the group. 

To add a user-defined server group that is not displayed on the screen, click the add button, revealing the following window for 
the user to configure. 
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Figure 7- 26. Authen Server Group Table Add Settings 

Enter a group name of up to 15 alphanumeric characters to identify the users Group Name and click Add. The user’s new Group 
Name will then appear in the Authentication Server Group Settings window as seen below, defined as Trinity. 

 
Figure 7- 27. Authentication Server Group Settings window 

The new group may be modified in the same way as the other groups, by clicking the hyperlinked name. Yet, unlike the other 
groups, the user-defined Group Name can have any combination of Protocol hosts to be in this group. (Ex. TACACS – 
XTACACS – TACACS+) 

 

NOTE: The user must configure Authentication Server Hosts using the Authentication Server Hosts 
window before adding hosts to the list. Authentication Server Hosts must be configured for their 
specific protocol on a remote centralized server before this function can work properly. 

 

NOTE: The three built in server groups can only have server hosts running the same TACACS 
daemon. TACACS/XTACACS/TACACS+ protocols are separate entities and are not compatible with 
each other. 

Authentication Server Hosts 
This window will set user-defined Authentication Server Hosts for the TACACS/XTACACS/TACACS+/RADIUS security 
protocols on the Switch. When a user attempts to access the Switch with Authentication Policy enabled, the Switch will send 
authentication packets to a remote TACACS/XTACACS/TACACS+/RADIUS server host on a remote host. The 
TACACS/XTACACS/TACACS+/RADIUS server host will then verify or deny the request and return the appropriate message to 
the Switch. More than one authentication protocol can be run on the same physical server host but, remember that 
TACACS/XTACACS/TACACS+/RADIUS are separate entities and are not compatible with each other. The maximum supported 
number of server hosts is 16. 
To view the following window, click Security Management > Access Authentication Control > Authentication Server Host: 
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Figure 7- 28. Authentication Server Host Settings window 

To add an Authentication Server Host, click the Add button, revealing the following window: 

 
Figure 7- 29. Authentication Server Host Settings – Add window 

Configure the following parameters to add an Authentication Server Host: 

Parameter                       Description 

IP Address The IP address of the remote server host the user wishes to add. 

Protocol The protocol used by the server host. The user may choose one of the following: 

• TACACS - Enter this parameter if the server host utilizes the TACACS protocol. 

• XTACACS - Enter this parameter if the server host utilizes the XTACACS protocol.

• TACACS+ - Enter this parameter if the server host utilizes the TACACS+ protocol. 

• RADIUS - Enter this parameter if the server host utilizes the RADIUS protocol. 

Port (1-65535) Enter a number between 1 and 65535 to define the virtual port number of the authentication 
protocol on a server host. The default port number is 49 for TACACS/XTACACS/TACACS+ 
servers and 1813 for RADIUS servers but the user may set a unique port number for higher 
security. 

Timeout (1-255) Enter the time in seconds the Switch will wait for the server host to reply to an authentication 
request. The default value is 5 seconds. 

Retransmit (1-255) Enter the value in the retransmit field to change how many times the device will resend an 
authentication request when the TACACS server does not respond. The default value is 2 
seconds. 

Key Authentication key to be shared with a configured TACACS+ or RADIUS servers only. 
Specify an alphanumeric string up to 254 characters. 

Click Apply to add the server host. 
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NOTE: More than one authentication protocol can be run on the same physical server host but, 
remember that TACACS/XTACACS/TACACS+ are separate entities and are not compatible with each 
other. 

Login Method Lists 
This command will configure a user-defined or default Login Method List of authentication techniques for users logging on to the 
Switch. The sequence of techniques implemented in this command will affect the authentication result. For example, if a user 
enters a sequence of techniques, for example TACACS - XTACACS- local, the Switch will send an authentication request to the 
first TACACS host in the server group. If no response comes from the server host, the Switch will send an authentication request 
to the second TACACS host in the server group and so on, until the list is exhausted. At that point, the Switch will restart the same 
sequence with the following protocol listed, XTACACS. If no authentication takes place using the XTACACS list, the local 
account database set in the Switch is used to authenticate the user. When the local method is used, the privilege level will be 
dependant on the local account privilege configured on the Switch. 
Successful login using any of these techniques will give the user a "User" privilege only. If the user wishes to upgrade his or her 
status to the administrator level, the user must use the Enable Admin window, in which the user must enter a previously 
configured password, set by the administrator. (See the Enable Admin part of this section for more detailed information 
concerning the Enable Admin command.) 
To view the following window click Security Management > Access Authentication Control > Login Method Lists: 

 
Figure 7- 30. Login Method Lists Settings window 

The Switch contains one Method List that is set and cannot be removed, yet can be modified. To delete a Login Method List 
defined by the user, click the X under the Delete heading corresponding to the entry desired to be deleted. To modify a Login 
Method List, click on its hyperlinked Method List Name. To configure a new Method List, click the Add button.  
Both actions will result in the same window to configure: 

 
Figure 7- 31. Login Method List - Edit window (default) 
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Figure 7- 32. Login Method List – Add window 

To define a Login Method List, set the following parameters and click Apply: 

Parameter                       Description 

Method List Name Enter a method list name defined by the user of up to 15 characters. 

Method 1, 2, 3, 4 The user may add one, or a combination of up to four of the following authentication 
methods to this method list: 

• tacacs - Adding this parameter will require the user to be authenticated using the 
TACACS protocol from a remote TACACS server. 

• xtacacs - Adding this parameter will require the user to be authenticated using the 
XTACACS protocol from a remote XTACACS server. 

• tacacs+ - Adding this parameter will require the user to be authenticated using the 
TACACS+ protocol from a remote TACACS+ server. 

• radius - Adding this parameter will require the user to be authenticated using the 
RADIUS protocol from a remote RADIUS server. 

• server_group - Adding this parameter will require the user to be authenticated 
using a user-defined server group previously configured on the Switch. 

• local - Adding this parameter will require the user to be authenticated using the 
local user account database on the Switch.  

• none - Adding this parameter will require an authentication to access the Switch. 

Enable Method Lists 
The Enable Method List Settings window is used to set up Method Lists to promote users with user level privileges to 
Administrator (Admin) level privileges using authentication methods on the Switch. Once a user acquires normal user level 
privileges on the Switch, he or she must be authenticated by a method on the Switch to gain administrator privileges on the Switch, 
which is defined by the Administrator. A maximum of eight Enable Method Lists can be implemented on the Switch, one of 
which is a default Enable Method List. This default Enable Method List cannot be deleted but can be configured. 
The sequence of methods implemented in this command will affect the authentication result. For example, if a user enters a 
sequence of methods like TACACS - XTACACS - Local Enable, the Switch will send an authentication request to the first 
TACACS host in the server group. If no verification is found, the Switch will send an authentication request to the second 
TACACS host in the server group and so on, until the list is exhausted. At that point, the Switch will restart the same sequence 
with the following protocol listed, XTACACS. If no authentication takes place using the XTACACS list, the Local Enable 
password set in the Switch is used to authenticate the user.  
Successful authentication using any of these methods will give the user an "Admin" privilege. 

 

NOTE: To set the Local Enable Password, see the next section, entitled Local Enable Password. 

To view the following table, click Security Management > Access Authentication Control > Enable Method Lists: 



xStack® DES-3500 Series Layer 2 Stackable Fast Ethernet Managed Switch User Manual 

 177

 
Figure 7- 33. Enable Method List Settings window 

To delete an Enable Method List defined by the user, click the X under the Delete heading corresponding to the entry desired to be 
deleted. To modify an Enable Method List, click on its hyperlinked Method List Name. To configure a Method List, click the Add 
button.  
Both actions will result in the same window to configure: 

 
Figure 7- 34. Enable Method List - Edit window 

 
Figure 7- 35. Enable Method List - Add window 

To define an Enable Login Method List, set the following parameters and click Apply: 

Parameter                   Description 

Method List Name Enter a method list name defined by the user of up to 15 characters. 

Method 1, 2, 3, 4 The user may add one, or a combination of up to four of the following authentication methods to 
this method list: 

• local_enable - Adding this parameter will require the user to be authenticated using 
the local enable password database on the Switch. The user in the next section 
entitled Local Enable Password must set the local enable password. 

• none - Adding this parameter will require an authentication to access the Switch. 
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• radius - Adding this parameter will require the user to be authenticated using the 
RADIUS protocol from a remote RADIUS server. 

• tacacs - Adding this parameter will require the user to be authenticated using the 
TACACS protocol from a remote TACACS server. 

• xtacacs - Adding this parameter will require the user to be authenticated using the 
XTACACS protocol from a remote XTACACS server. 

• tacacs+ - Adding this parameter will require the user to be authenticated using the 
TACACS protocol from a remote TACACS server. 

• server_group - Adding a previously configured server group will require the user to be 
authenticated using a user-defined server group previously configured on the Switch. 

Local Enable Password 
This window will configure the locally enabled password for the Enable Admin command. When a user chooses the 
"local_enable" method to promote user level privileges to administrator privileges, he or she will be prompted to enter the 
password configured here that is locally set on the Switch. 
To view the following window, click Security Management > Access Authentication Control > Local Enable Password: 

 
Figure 7- 36. Configure Local Enable Password window 

To set the Local Enable Password, set the following parameters and click Apply. 

Parameter                           Description 

Old Local Enabled If a password was previously configured for this entry, enter it here in order to change it to 
a new password. 

New Local Enabled Enter the new password that you wish to set on the Switch to authenticate users 
attempting to access Administrator Level privileges on the Switch. The user may set a 
password of up to 15 characters. 

Confirm Local Enabled Confirm the new password entered above. Entering a different password here from the 
one set in the New Local Enabled field will result in a fail message. 

Enable Admin 
The Enable Admin window is for users who have logged on to the Switch at Adminstrator level. Possible authentication methods 
for this function include TACACS/XTACACS/TACACS+/RADIUS, user defined server groups, local enable (local account on 
the Switch), or no authentication (none). Because XTACACS and TACACS do not support the enable function, the user must 
create a special account on the server host, which has the username "enable", and a password configured by the administrator that 
will support the "enable" function. This function becomes inoperable when the authentication policy is disabled. 
To view the following window, click Security Management > Access Authentication Control > Enable Admin: 
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Figure 7- 37. Enable Admin Screen 

If the Authentication Policy is disabled the message in the lower half of the screen will indicate Authentication Policy is 
disabled! 
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Secure Socket Layer (SSL) 
Secure Sockets Layer or SSL is a security feature that will provide a secure communication path between a host and client through 
the use of authentication, digital signatures and encryption. These security functions are implemented through the use of a 
ciphersuite, which is a security string that determines the exact cryptographic parameters, specific encryption algorithms and key 
sizes to be used for an authentication session and consists of three levels: 

1. Key Exchange: The first part of the cyphersuite string specifies the public key algorithm to be used. This switch utilizes 
the Rivest Shamir Adleman (RSA) public key algorithm and the Digital Signature Algorithm (DSA), specified here as the 
DHE DSS Diffie-Hellman (DHE) public key algorithm. This is the first authentication process between client and host as 
they “exchange keys” in looking for a match and therefore authentication to be accepted to negotiate encryptions on the 
following level.  

2. Encryption: The second part of the ciphersuite that includes the encryption used for encrypting the messages sent 
between client and host. The Switch supports two types of cryptology algorithms: 

• Stream Ciphers – There are two types of stream ciphers on the Switch, RC4 with 40-bit keys and RC4 with 128-
bit keys. These keys are used to encrypt messages and need to be consistent between client and host for optimal use.  

• CBC Block Ciphers – CBC refers to Cipher Block Chaining, which means that a portion of the previously 
encrypted block of encrypted text is used in the encryption of the current block. The Switch supports the 3DES EDE 
encryption code defined by the Data Encryption Standard (DES) to create the encrypted text. 

3. Hash Algorithm: This part of the ciphersuite allows the user to choose a message digest function which will determine a 
Message Authentication Code. This Message Authentication Code will be encrypted with a sent message to provide 
integrity and prevent against replay attacks. The Switch supports two hash algorithms, MD5 (Message Digest 5) and SHA 
(Secure Hash Algorithm). 

These three parameters are uniquely assembled in four choices on the Switch to create a three-layered encryption code for secure 
communication between the server and the host. The user may implement any one or combination of the ciphersuites available, 
yet different ciphersuites will affect the security level and the performance of the secured connection. The information included in 
the ciphersuites is not included with the Switch and requires downloading from a third source in a file form called a certificate. 
This function of the Switch cannot be executed without the presence and implementation of the certificate file and can be 
downloaded to the Switch by utilizing a TFTP server. The Switch supports SSLv3 and TLSv1. Other versions of SSL may not be 
compatible with this Switch and may cause problems upon authentication and transfer of messages from client to host. 

Download Certificate 

 
                                                                             Figure 7- 38. Download Certificate window 

 
To download certificates, set the following parameters and click Apply. 

Parameter               Description 

Certificate Type Enter the type of certificate to be downloaded. This type refers to the server responsible for 
issuing certificates. This field has been limited to local for this firmware release. 

Server IP Enter the IP address of the TFTP server where the certificate files are located. 

Certificate File Name Enter the path and the filename of the certificate file to download. This file must have a .der 
extension. (Ex. c:/cert.der) 

Key File Name Enter the path and the filename of the key file to download. This file must have a .der 
extension (Ex. c:/pkey.der) 

This window is used to download a certificate file for 
the SSL function on the Switch from a TFTP server. 
The certificate file is a data record used for 
authenticating devices on the network. It contains 
information on the owner, keys for authentication and 
digital signatures. Both the server and the client must 
have consistent certificate files for optimal use of the 
SSL function. The Switch only supports certificate files 
with .der file extensions. The Switch is shipped with a 
certificate pre-loaded though the user may need to 
download more, depending on user circumstances. 
To view the following window, click Configuration > 
Secure Socket Layer (SSL) > Download Certificate: 
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Configuration 
This window will allow the user to enable SSL on the Switch and implement any one or combination of listed ciphersuites on the 
Switch. A ciphersuite is a security string that determines the exact cryptographic parameters, specific encryption algorithms and 
key sizes to be used for an authentication session. The Switch possesses four possible ciphersuites for the SSL function, which are 
all enabled by default. To utilize a particular ciphersuite, disable the unwanted ciphersuites, leaving the desired one for 
authentication.  
When the SSL function has been enabled, the web will become disabled. To manage the Switch through the web based 
management while utilizing the SSL function, the web browser must support SSL encryption and the header of the URL must 
begin with https://. (Ex. https://10.90.90.90) Any other method will result in an error and no access can be authorized for the web-
based management. 
To view the following window, click Configuration > Secure Socket Layer (SSL) > Configuration: 

 
Figure 7- 39. Ciphersuite window 

To set up the SSL function on the Switch, configure the following parameters and click Apply.  

Parameter    Description 

SSL Status  Use the pull-down menu to enable or disable the SSL status on the switch. The default is 
Disabled. 

Cache Timeout(60-
86400 sec) 

Enter the Cache Timeout in seconds the default value is 600 seconds.  

RSA with RC4 128 
MD5 

This ciphersuite combines the RSA key exchange, stream cipher RC4 encryption with 128-
bit keys and the MD5 Hash Algorithm. Use the pull-down menu to enable or disable this 
ciphersuite. This field is Enabled by default. 

RSA with 3DES EDE 
CBC SHA 

This ciphersuite combines the RSA key exchange, CBC Block Cipher 3DES_EDE encryption 
and the SHA Hash Algorithm. Use the pull-down menu to enable or disable this ciphersuite. 
This field is Enabled by default. 

DHS DSS with 3DES 
EDE CBC SHA 

This ciphersuite combines the DSA Diffie Hellman key exchange, CBC Block Cipher 
3DES_EDE encryption and SHA Hash Algorithm. Use the pull-down menu to enable or 
disable this ciphersuite. This field is Enabled by default. 

RSA EXPORT with 
RC4 40 MD5 

This ciphersuite combines the RSA Export key exchange and stream cipher RC4 encryption 
with 40-bit keys. Use the pull-down menu to enable or disable this ciphersuite. This field is 
Enabled by default. 

 

 

NOTE: Certain implementations concerning the function and configuration of SSL are not available on 
the web-based management of this Switch and need to be configured using the command line 
interface. For more information on SSL and its functions, see the DES-3500 Series Command Line 
Reference Manual, located on the documentation CD of this product. 
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NOTE: Enabling the SSL command will disable the web-based switch management. To log on to the 
Switch again, the header of the URL must begin with https://. Entering anything else into the address 
field of the web browser will result in an error and no authentication will be granted. 

 

Secure Shell (SSH) 
SSH is an abbreviation of Secure Shell, which is a program allowing secure remote login and secure network services over an 
insecure network. It allows a secure login to remote host computers, a safe method of executing commands on a remote end node, 
and will provide secure encrypted and authenticated communication between two non-trusted hosts. SSH, with its array of 
unmatched security features is an essential tool in today’s networking environment. It is a powerful guardian against numerous 
existing security hazards that now threaten network communications. 
The steps required to use the SSH protocol for secure communication between a remote PC (the SSH client) and the Switch (the 
SSH server) are as follows: 

1. Create a user account with admin-level access using the User Accounts window in the Security Management folder. 
This is identical to creating any other admin-level User Account on the Switch, including specifying a password. This 
password is used to logon to the Switch, once a secure communication path has been established using the SSH protocol. 

2. Configure the User Account to use a specified authorization method to identify users that are allowed to establish SSH 
connections with the Switch using the SSH User Authentication window. There are three choices as to the method SSH 
will use to authorize the user, which are Host Based, Password and Public Key. 

3. Configure the encryption algorithm that SSH will use to encrypt and decrypt messages sent between the SSH client and 
the SSH server, using the SSH Algorithm window. 

4. Finally, enable SSH on the Switch using the SSH Configuration window. 
After completing the preceding steps, a SSH Client on a remote PC can be configured to manage the Switch using a secure, in 
band connection. 

SSH Configuration 
The following window is used to configure and view settings for the SSH server and can be opened by clicking Security 
Management > Secure Shell (SSH) > SSH Configuration: 
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     Figure 7- 40. Current SSH Configuration Settings 

To configure the SSH server on the Switch, modify the following parameters and click Apply: 

Parameter             Description 

SSH Server Status Use the pull-down menu to enable or disable SSH on the Switch. The default is Disabled. 

Max Session (1-8) Enter a value between 1 and 8 to set the number of users that may simultaneously access the 
Switch. The default setting is 8. 

Time Out (120-600) Allows the user to set the connection timeout. The use may set a time between 120 and 600 
seconds. The default setting is 300 seconds. 

Auth. Fail (2-20) Allows the Administrator to set the maximum number of attempts that a user may try to log on 
to the SSH Server utilizing the SSH authentication. After the maximum number of attempts has 
been exceeded, the Switch will be disconnected and the user must reconnect to the Switch to 
attempt another login. The number of maximum attempts may be set between 2 and 20. The 
default setting is 2. 

Session Rekeying Using the pull-down menu uses this field to set the time period that the Switch will change the 
security shell encryptions. The available options are Never, 10 min, 30 min, and 60 min. The 
default setting is Never. 

Port(1-65535) Enter the ports for the SSH Configuration. 

SSH Algorithm 
The SSH Algorithm window allows the configuration of the desired types of SSH algorithms used for authentication encryption. 
There are four categories of algorithms listed and specific algorithms of each may be enabled or disabled by using their 
corresponding pull-down menus. All algorithms are enabled by default. To open the following window, click Security 
Management > Secure Shell (SSH) > SSH Algorithm: 
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Figure 7- 41. Encryption Algorithm window 

The following algorithms may be set: 

Parameter                Description 

Encryption Algorithm 

3DES-CBC Use the pull-down to enable or disable the Triple Data Encryption Standard encryption 
algorithm with Cipher Block Chaining. The default is Enabled. 

Blow-fish CBC Use the pull-down to enable or disable the Blowfish encryption algorithm with Cipher Block 
Chaining. The default is Enabled. 

AES128-CBC Use the pull-down to enable or disable the Advanced Encryption Standard AES128 
encryption algorithm with Cipher Block Chaining. The default is Enabled. 

AES192-CBC Use the pull-down to enable or disable the Advanced Encryption Standard AES192 
encryption algorithm with Cipher Block Chaining. The default is Enabled. 

AES256-CBC Use the pull-down to enable or disable the Advanced Encryption Standard AES-256 
encryption algorithm with Cipher Block Chaining. The default is Enabled. 

ARC4 Use the pull-down to enable or disable the Arcfour encryption algorithm with Cipher Block 
Chaining. The default is Enabled. 

Cast128-CBC Use the pull-down to enable or disable the Cast128 encryption algorithm with Cipher Block 
Chaining. The default is Enabled. 
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Twofish128 Use the pull-down to enable or disable the twofish128 encryption algorithm. The default is 
Enabled. 

Twofish192 Use the pull-down to enable or disable the twofish192 encryption algorithm. The default is 
Enabled. 

Twofish256 Use the pull-down to enable or disable the twofish256 encryption algorithm. The default is 
Enabled. 

Data Integrity Algorithm 

HMAC-SHA1 Use the pull-down to enable or disable the HMAC (Hash for Message Authentication Code) 
mechanism utilizing the Secure Hash algorithm. The default is Enabled. 

HMAC-MD5 Use the pull-down to enable or disable the HMAC (Hash for Message Authentication Code) 
mechanism utilizing the MD5 Message Digest encryption algorithm. The default is Enabled. 

Public Key Algorithm 

HMAC-RSA Use the pull-down to enable or disable the HMAC (Hash for Message Authentication Code) 
mechanism utilizing the RSA encryption algorithm. The default is Enabled. 

HMAC-DSA Use the pull-down to enable or disable the HMAC (Hash for Message Authentication Code) 
mechanism utilizing the Digital Signature Algorithm encryption. The default is Enabled. 

Authentication Algorithm 

Password This parameter may be enabled if the administrator wishes to use a locally configured 
password for authentication on the Switch. The default is Enabled. 

Public Key This parameter may be enabled if the administrator wishes to use a publickey configuration 
set on a SSH server, for authentication on the Switch. The default is Enabled. 

Host-based This parameter may be enabled if the administrator wishes to use a host computer for 
authentication. This parameter is intended for Linux users requiring SSH authentication 
techniques and the host computer is running the Linux operating system with a SSH 
program previously installed. The default is Enabled. 

Click Apply to implement changes made. 

SSH User Authentication 
The following windows are used to configure parameters for users attempting to access the Switch through SSH. To access the 
following window, click Security Management > Secure Shell > SSH User Authentication.  

 
Figure 7- 42. Current Accounts window 

In the example screen above, the User Account “Trinity” has been previously set using the User Accounts window in the Security 
Management folder. A User Account MUST be set in order to set the parameters for the SSH user. To configure the parameters 
for a SSH user, click on the hyperlinked User Name in the Current Accounts window, which will reveal the following window to 
configure. 
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Figure 7- 43. User Accounts Modify Table window 

The user may set the following parameters: 

Parameter    Description 

User Name  Enter a User Name of no more than 15 characters to identify the SSH user. This User Name 
must be a previously configured user account on the Switch. 

Auth. Mode The administrator may choose one of the following to set the authorization for users 
attempting to access the Switch. 

Host Based – This parameter should be chosen if the administrator wishes to use a remote 
SSH server for authentication purposes. Choosing this parameter requires the user to input 
the following information to identify the SSH user. 

• Host Name – Enter an alphanumeric string of no more than 31 characters to 
identify the remote SSH user. 

• Host IP – Enter the corresponding IP address of the SSH user. 

Password – This parameter should be chosen if the administrator wishes to use an 
administrator-defined password for authentication. Upon entry of this parameter, the Switch 
will prompt the administrator for a password, and then to re-type the password for 
confirmation. 

Public Key – This parameter should be chosen if the administrator wishes to use the 
publickey on a SSH server for authentication. 

Host Name Enter an alphanumeric string of no more than 31 characters to identify the remote SSH user. 
This parameter is only used in conjunction with the Host Based choice in the Auth. Mode 
field. 

Host IP Enter the corresponding IP address of the SSH user. This parameter is only used in 
conjunction with the Host Based choice in the Auth. Mode field. 

Click Apply to implement changes made. 

 

NOTE: To set the SSH User Authentication parameters on the Switch, a User Account must be 
previously configured. For more information on configuring local User Accounts on the Switch, see the 
User Accounts section of this manual located in this section. 
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SNMP Manager 
SNMP Settings 
Simple Network Management Protocol (SNMP) is an OSI Layer 7 (Application Layer) designed specifically for managing and 
monitoring network devices. SNMP enables network management stations to read and modify the settings of gateways, routers, 
switches, and other network devices. Use SNMP to configure system features for proper operation, monitor performance and 
detect potential problems in the Switch, switch group or network. 
Managed devices that support SNMP include software (referred to as an agent), which runs locally on the device. A defined set of 
variables (managed objects) is maintained by the SNMP agent and used to manage the device. These objects are defined in a 
Management Information Base (MIB), which provides a standard presentation of the information controlled by the on-board 
SNMP agent. SNMP defines both the format of the MIB specifications and the protocol used to access this information over the 
network. 
The DES-3500 Series switches support the SNMP versions 1, 2c, and 3. You can specify which version of the SNMP you want to 
use to monitor and control the Switch. The three versions of SNMP vary in the level of security provided between the 
management station and the network device.   
In SNMP v.1 and v.2, user authentication is accomplished using 'community strings', which function like passwords. The remote 
user SNMP application and the Switch SNMP must use the same community string. SNMP packets from any station that has not 
been authenticated are ignored (dropped). 
The default community strings for the Switch used for SNMP v.1 and v.2 management access are: 

• public - Allows authorized management stations to retrieve MIB objects. 
• private - Allows authorized management stations to retrieve and modify MIB objects. 

SNMPv3 uses a more sophisticated authentication process that is separated into two parts. The first part is to maintain a list of 
users and their attributes that are allowed to act as SNMP managers. The second part describes what each user on that list can do 
as an SNMP manager.  
The Switch allows groups of users to be listed and configured with a shared set of privileges. The SNMP version may also be set 
for a listed group of SNMP managers. Thus, you may create a group of SNMP managers that are allowed to view read-only 
information or receive traps using SNMPv1 while assigning a higher level of security to another group, granting read/write privi-
leges using SNMPv3. 
Using SNMPv3 individual users or groups of SNMP managers can be allowed to perform or be restricted from performing 
specific SNMP management functions. The functions allowed or restricted are defined using the Object Identifier (OID) 
associated with a specific MIB. An additional layer of security is available for SNMPv3 in that SNMP messages may be 
encrypted. To read more about how to configure SNMPv3 settings for the Switch read the next section. 

Traps 
Traps are messages that alert network personnel of events that occur on the Switch. The events can be as serious as a reboot 
(someone accidentally turned OFF the Switch), or less serious like a port status change. The Switch generates traps and sends 
them to the trap recipient (or network manager). Typical traps include trap messages for Authentication Failure, Topology Change 
and Broadcast\Multicast Storm. 

MIBs 
The Switch in the Management Information Base (MIB) stores management and counter information. The Switch uses the 
standard MIB-II Management Information Base module. Consequently, values for MIB objects can be retrieved from any SNMP-
based network management software. In addition to the standard MIB-II, the Switch also supports its own proprietary enterprise 
MIB as an extended Management Information Base. Specifying the MIB Object Identifier may also retrieve the proprietary MIB. 
MIB values can be either read-only or read-write. 
The DES-3500 Series switches incorporate a flexible SNMP management for the switching environment. SNMP management can 
be customized to suit the needs of the networks and the preferences of the network administrator. Use the SNMP V3 menus to 
select the SNMP version used for specific tasks. 
The DES-3500 Series switches support the Simple Network Management Protocol (SNMP) versions 1, 2c, and 3. The 
administrator can specify the SNMP version used to monitor and control the Switch.  The three versions of SNMP vary in the 
level of security provided between the management station and the network device. 
SNMP settings are configured using the menus located on the SNMP V3 folder of the web manager. Workstations on the network 
that are allowed SNMP privileged access to the Switch can be restricted with the Management Station IP Address menu. 
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SNMP User Table   
The SNMP User Table displays all of the SNMP User's currently configured on the Switch. 
To view this window click, Security Management > SNMP Manager > SNMP User Table. 

 
Figure 7- 44. SNMP User Table window 

To delete an existing SNMP User Table entry, click the  button under the Delete heading corresponding to the entry you wish 
to delete. 
To display the detailed entry for a given user, click on the hyperlinked User Name. This will open the SNMP User Table Display 
window, as shown below. 

 
Figure 7- 45. SNMP User Table Display window 

The following parameters are displayed: 

Parameter                       Description 

User Name An alphanumeric string of up to 32 characters. This is used to identify the SNMP users. 

Group Name This name is used to specify the SNMP group created can request SNMP messages. 

SNMP Version V1 - Indicates that SNMP version 1 is in use.  
V2 - Indicates that SNMP version 2 is in use. 
V3 - Indicates that SNMP version 3 is in use. 

Auth-Protocol None - Indicates that no authorization protocol is in use. 
MD5 - Indicates that the HMAC-MD5-96 authentication level will be used. 
SHA - Indicates that the HMAC-SHA authentication protocol will be used. 

Priv-Protocol None - Indicates that no authorization protocol is in use. 
DES - Indicates that DES 56-bit encryption is in use based on the CBC-DES (DES-56) 
standard. 

To return to the SNMP User Table, click the Show All SNMP User Table Entries link. 
To add a new entry to the SNMP User Table Configuration window, click on the Add button on the SNMP User Table window.  
This will open the SNMP User Table Configuration window, as shown below. 
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Figure 7- 46. SNMP User Table Configuration window 

The following parameters can set: 

Parameter               Description 

User Name Enter an alphanumeric string of up to 32 characters. This is used to identify the SNMP user. 

Group Name This name is used to specify the SNMP group created can request SNMP messages. 

SNMP Version V1 - Specifies that SNMP version 1 will be used.  
V2 - Specifies that SNMP version 2 will be used.  
V3 - Specifies that SNMP version 3 will be used. 

Auth-Protocol MD5 - Specifies that the HMAC-MD5-96 authentication level will be used. This field is only 
operable when V3 is selected in the SNMP Version field and the Encryption field has been 
checked. This field will require the user to enter a password. 
SHA - Specifies that the HMAC-SHA authentication protocol will be used. This field is only 
operable when V3 is selected in the SNMP Version field and the Encryption field has been 
checked. This field will require the user to enter a password. 

Priv-Protocol None - Specifies that no authorization protocol is in use.  
DES - Specifies that DES 56-bit encryption is in use, based on the CBC-DES (DES-56) standard. 
This field is only operable when V3 is selected in the SNMP Version field and the Encryption field 
has been checked. This field will require the user to enter a password between 8 and 16 
alphanumeric characters. 

Encrypted Checking the corresponding box will enable encryption for SNMP V3 and is only operable in 
SNMP V3 mode. 

To implement changes made, click Apply. To return to the SNMP User Table, click the Show All SNMP User Table Entries link. 
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SNMP View Table 
The SNMP View Table is used to assign views to community strings that define which MIB objects can be accessed by a remote 
SNMP manager. To view this window click, Security Management > SNMP Manager > SNMP View Table. 

 
Figure 7- 47. SNMP View Table window 

To delete an existing SNMP View Table entry, click the  button in the Delete column corresponding to the entry you wish to 
delete. To create a new entry, click the Add button and a separate window will appear. 

 
Figure 7- 48. SNMP View Table Configuration window 

The SNMP Group created with this table maps SNMP users (identified in the SNMP User Table) to the views created in the 
previous window. 
The following parameters can set: 

Parameter               Description 

View Name Type an alphanumeric string of up to 32 characters. This is used to identify the new SNMP view 
being created. 

Subtree OID Type the Object Identifier (OID) Subtree for the view. The OID identifies an object tree (MIB tree) 
that will be included or excluded from access by an SNMP manager. 

View Type Select Included to include this object in the list of objects that an SNMP manager can access. 
Select Excluded to exclude this object from the list of objects that an SNMP manager can 
access. 

To implement your new settings, click Apply. To return to the SNMP View Table, click the Show All SNMP View Table Entries 
link. 
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SNMP Group Table 
An SNMP Group created with this table maps SNMP users (identified in the SNMP User Table) to the views created in the 
previous menu. To view this window click, Security Management > SNMP Manager > SNMP Group Table. 

 
Figure 7- 49. SNMP Group Table window 

To delete an existing SNMP Group Table entry, click the corresponding  button under the Delete heading. 
To display the current settings for an existing SNMP Group Table entry, click the hyperlink for the entry under the Group Name. 

 
Figure 7- 50. SNMP Group Table Display window 

To add a new entry to the Switch's SNMP Group Table, click the Add button in the upper left-hand corner of the SNMP Group 
Table window.  This will open the SNMP Group Table Configuration window, as shown below. 
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Figure 7- 51. SNMP Group Table Configuration window 

The following parameters can set: 

Parameter                   Description 

Group Name Type an alphanumeric string of up to 32 characters. This is used to identify the new SNMP 
group of SNMP users. 

Read View Name Specify a SNMP group name for users that are allowed SNMP read privileges to the Switch's 
SNMP agent. The view name must exist in the SNMP View Table. 

Write View Name Specify a SNMP group name for users that are allowed SNMP write privileges to the Switch's 
SNMP agent. The view name must exist in the SNMP View Table. 

Notify View Name Specify a SNMP group name for users that can receive SNMP trap messages generated by 
the Switch's SNMP agent. The view name must exist in the SNMP View Table. 

Security Model SNMPv1 - Specifies that SNMP version 1 will be used.   
SNMPv2 - Specifies that SNMP version 2c will be used. The SNMPv2 supports both 
centralized and distributed network management strategies. It includes improvements in the 
Structure of Management Information (SMI) and adds some security features. 
SNMPv3 - Specifies that the SNMP version 3 will be used.  SNMPv3 provides secure access 
to devices through a combination of authentication and encrypting packets over the network.  

Security Level The Security Level settings only apply to SNMPv3. 
NoAuthNoPriv - Specifies that there will be no authorization and no encryption of packets 
sent between the Switch and a remote SNMP manager. 
AuthNoPriv - Specifies that authorization will be required, but there will be no encryption of 
packets sent between the Switch and a remote SNMP manager. 
AuthPriv - Specifies that authorization will be required, and that packets sent between the 
Switch and a remote SNMP manger will be encrypted. 

To implement your new settings, click Apply. To return to the SNMP Group Table, click the Show All SNMP Group Table 
Entries link. 

SNMP Community Table 
Use this table to create an SNMP community string to define the relationship between the SNMP manager and an agent. The 
community string acts like a password to permit access to the agent on the Switch. One or more of the following characteristics 
can be associated with the community string: 

• An Access List of IP addresses of SNMP managers that are permitted to use the community string to gain access to the 
Switch's SNMP agent. 

• Any MIB view that defines the subset of all MIB objects will be accessible to the SNMP community. 

• Read/write or read-only level permission for the MIB objects accessible to the SNMP community. 
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To configure SNMP Community entries, open the SNMP Manager folder, located in the Security Management folder, and click 
the SNMP Community Table link, which will open the following window: 

 
Figure 7- 52. SNMP Community Table Configuration window 

The following parameters can set: 

Parameter                Description 

Community Name Type an alphanumeric string of up to 32 characters that is used to identify members of an 
SNMP community. This string is used like a password to give remote SNMP managers 
access to MIB objects in the Switch's SNMP agent. 

View Name Type an alphanumeric string of up to 32 characters that is used to identify the group of MIB 
objects that a remote SNMP manager is allowed to access on the Switch. The view name 
must exist in the SNMP View Table. 

Access Right Read Only - Specifies that SNMP community members using the community string created 
can only read the contents of the MIBs on the Switch. 
Read Write - Specifies that SNMP community members using the community string created 
can read from, and write to the contents of the MIBs on the Switch. 

To implement the new settings, click Apply. To delete an entry from the SNMP Community Table, click the  under the Delete 
heading, corresponding to the entry you wish to delete. 

SNMP Host Table 
Use the SNMP Host Table window to set up SNMP trap recipients. 
To open this window click, Security Management > SNMP Manager > SNMP Host Table.   

To delete an existing SNMP Host Table entry, click the corresponding  button under the Delete heading. 
To display the current settings for an existing SNMP Host Table entry, click the blue link for the entry under the Host IP Address 
heading. 

 
Figure 7- 53. SNMP Host Table window 

To add a new entry to the Switch's SNMP Host Table, click the Add button in the upper left-hand corner of the window.  This will 
open the SNMP Host Table Configuration window, as shown below. 
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Figure 7- 54. SNMP Host Table Configuration window 

The following parameters can set: 

Parameter                   Description 

Host IP Address Type the IP address of the remote management station that will serve as the SNMP host for the 
Switch. 

SNMP Version V1 - To specifies that SNMP version 1 will be used.   
V2 - To specify that SNMP version 2 will be used.  
V3-NoAuth-NoPriv - To specify that the SNMP version 3 will be used, with a NoAuth-NoPriv 
security level. 
V3-Auth-NoPriv - To specify that the SNMP version 3 will be used, with an Auth-NoPriv security 
level. 
V3-Auth-Priv - To specify that the SNMP version 3 will be used, with an Auth-Priv security level.

Community 
String/SNMP V3 
User Name 

Type in the community string or SNMP V3 user name as appropriate. 

To implement your new settings, click Apply. To return to the SNMP Host Table, click the Show All SNMP Host Table Entries 
link. 

SNMP Engine ID 
The Engine ID is a unique identifier used for SNMP V3 implementations. This is an alphanumeric string used to identify the 
SNMP engine on the Switch. 
To display the Switch's SNMP Engine ID, click Security Management  > SNMP Manger > SNMP Engine ID. This will open 
the SNMP Engine ID Configuration window, as shown below. 

 
Figure 7- 55. SNMP Engine ID Configuration window 

To change the Engine ID, type the new Engine ID in the space provided and click the Apply button. 

SNMP Trap 
The following window is used to enable or disable trap settings for the SNMP function on the Switch. To view this window for 
configuration, click Security Management  > SNMP Manger > SNMP Trap. 
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Figure 7- 56. SNMP Trap Global Settings window 

To enable or disable the SNMP Trap State and/or the Authenticate Traps State, use the corresponding pull-down menu to change 
and click Apply. 
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Safeguard Engine 
Periodically, malicious hosts on the network will attack the Switch by utilizing packet flooding (ARP Storm) or other methods. 
These attacks may increase the Safeguard Engine beyond its capability. To alleviate this problem, the Safeguard Engine function 
was added to the Switch’s software. 
 
The Safeguard Engine can help the overall operability of the Switch by minimizing the workload of the Switch while the attack is 
ongoing, thus making it capable to forward essential packets over its network in a limited bandwidth. When the Switch either (a) 
receives too many packets to process or (b) exerts too much memory, it will enter an Exhausted mode. When in this mode, the 
Switch will drop all ARP and IP broadcast packets for a calculated time interval. Every five seconds, the Switch will check to see 
if there are too many packets flooding the Switch. If the threshold has been crossed, the Switch will initially stop all ingress ARP 
and IP broadcast packets for five seconds. After another five-second checking interval arrives, the Switch will again check the 
ingress flow of packets. If the flooding has stopped, the Switch will again begin accepting all packets. Yet, if the checking shows 
that there continues to be too many packets flooding the Switch, it will stop accepting all ARP and IP broadcast packets for double 
the time of the previous stop period. This doubling of time for stopping ingress ARP and IP broadcast packets will continue until 
the maximum time has been reached, which is 320 seconds and every stop from this point until a return to normal ingress flow 
would be 320 seconds. For a better understanding, examine the following example of the Safeguard Engine. 

 
Figure 7- 57. Safeguard Engine example 

For every consecutive checking interval that reveals a packet flooding issue, the Switch will double the time it will discard ingress 
ARP and IP broadcast packets. In the example above, the Switch doubled the time for dropping ARP and IP broadcast packets 
when consecutive flooding issues were detected at 5 second intervals. (First stop = 5 seconds, second stop = 10 seconds, third stop 
= 20 seconds) Once the flooding is no longer detected, the wait period for dropping ARP and IP broadcast packets will return to 5 
seconds and the process will resume. 

Once in Exhausted mode, the packet flow will decrease by half of the level that caused the Switch to enter Exhausted mode. After 
the packet flow has stabilized, the rate will initially increase by 25% and then return to a normal packet flow. 
To configure the Safeguard Engine for the Switch, click Security > Safeguard Engine > which will open the following window. 
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Figure 7- 58. Safeguard Engine window 

To configure the Switch’s Safeguard Engine, change the State to Enabled. To configure the parameters for the Safeguard Engine, 
click the Advanced Settings button which will alter the previous screen to look like this: 

 
Figure 7- 59. Safeguard Engine window - Advanced Settings 

To set the Safeguard Engine for the Switch, complete the following fields: 

Parameter                      Description 

State Toggle the State field to either Enabled or Disabled for the Safeguard Engine of the Switch. 

Rising Threshold Used to configure the acceptable level of CPU utilization before the Safeguard Engine 
mechanism is enabled. Once the CPU utilization reaches this percentage level, the Switch 
will move into the Exhausted state. 

Falling Threshold Used to configure the acceptable level of CPU utilization as a percentage, where the Switch 
leaves the Exhausted state and returns to normal mode. 

Trap/log Use the pull-down menu to enable or disable the sending of messages to the device’s SNMP 
agent and switch log once the Safeguard Engine has been activated by a high CPU utilization 
rate. 

 



xStack® DES-3500 Series Layer 2 Stackable Fast Ethernet Managed Switch User Manual 

 198

Filter 
DHCP Server Screening Setting 
Due to this function allow you not only to restrict all DHCP Server packets but also to receive any specified DHCP server packet 
by any specified DHCP client, it is useful when one or more than one DHCP servers are present on the network and both provide 
DHCP services to different distinct groups of clients. Enabling the DHCP filter in the first time will create both an access profile 
and access rule per port, then creat other access rules following.  These rules are used to block all DHCP server packets. Similarly, 
addition of a permit DHCP entry will create one access profile and create one access rule only in the first time where DHCP client 
MAC address is the client MAC address, and the Source IP address is the same as the DHCP server’s IP address (UDP port 
number 67) that set in the DHCP Client Screening Setting window. These rules are used to permit the DHCP server packets with 
specific fileds, which the user configured. 
To view this window, click Security Management > Filter > DHCP Server Screening Settings. 
When DHCP Server filter function is enabled in DHCP Server Screening Setting window, all DHCP Server packets will be 
filtered from a specific port.  

 
Figure 7- 60. DHCP Server Screening Setting window 



xStack® DES-3500 Series Layer 2 Stackable Fast Ethernet Managed Switch User Manual 

 199

The parameters of DHCP Server Screening window are described as below: 

Parameter                      Description 

From/To These two drop-down menus allow you to select a range of ports to which the filter settings 
will be applied. 

State Enable or disable DHCP Server filter for the ports selected using the pull-down menu. The 
default setting is Disable. 

To implement the new settings, click Apply. Then the current configuration will be displayed in the DHCP Server Screening 
Status table.  
 

DHCP Client Filtering Setting 
This window allows you to create entries for specific Server IP address and Client MAC address binding by port-based. Be aware 
that the DHCP Server filter function must be enabled in DHCP Server Screening Setting window first. Once all setting is done, 
all DHCP Server packets will be filtered from a specific port except those that meet the Server IP Address and Client MAC 
Address binding set in the following DHCP Client Screening Setting window.   
To view this window, click Security Management > Filter > DHCP Client Filtering Settings. 

 
Figure 7- 61. DHCP Client Filtering Setting window 

The parameters of the above window are described as below: 

Parameter                      Description 

Server IP Address Enter IP address of the Server. 

Client MAC Address Enter MAC address of the Client. 

All Ports Check it to select all port of the Switch.  

Ports Check the corresponding boxes for the port(s) you wish to apply the settings. 

Click Apply to implement the new settings or Modify to renew the settings. Then the DHCP Client Filtering Status table will 
show up the current status for all existing entries. To delete any existing entry, click the corresponding  button under the Delete 
heading.  
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NetBIOS Filtering Setting 
When the NetBIOS filter is enabled, all NetBIOS packets will be filtered from the specified port.  Enabling the NetBIOS filter 
will create one access profile and create three access rules per port (UDP port numbers 137 and 138 and TCP port number 139). 
 
For Extensive NetBIOS Filter, when it is enabled, all NetBIOS packets over 802.3 frames will be filtered from the specified port.  
This command is used to configure the state of the NetBIOS filter. Enabling the Extensive NetBIOS filter will create one access 
profile and create one access rule per port (DSAP (Destination Service Access Point) =F0, and SASP (Source Service Access 
Point) =F0). To view this window, click Security Management > Filter > NetBIOS Filtering Settings. 

 
Figure 7- 62. NetBIOS Filtering Setting and Extensive NetBIOS Filter Setting window 
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The parameters are described as below: 

Parameter                      Description 

From/To These two drop-down menus allow you to select a range of ports to which the filter settings 
will be applied. 

State Enable or disable NetBIOS filter for the ports selected using the pull-down menu. The default 
setting is Disable. 

Extensive State Enable or disable Extensive NetBIOS filter for the ports selected using the pull-down menu. 
The default setting is Disable. 

To implement the new settings, click Apply. Then the current configuration will be displayed in the NetBIOS Filtering Status 
table.  
 



xStack® DES-3500 Series Layer 2 Stackable Fast Ethernet Managed Switch User Manual 

 202

CPU Filtering Settings 

 
                                                      Figure 7- 63. CPU Filtering Settings window 

 

ARP Spoofing Prevention 
ARP spoofing, also known as ARP poisoning, is a method to attack an Ethernet network which may allow an attacker to sniff data 
frames on a LAN, modify the traffic, or stop the traffic altogether (known as a Denial of Service – Dos attack). The principle of 
ARP spoofing is to send the fakes, or spoofed ARP messages to an Ethernet network. Generally, the aim is to associate the 
attacker’s or random MAC address with the IP address of another node (such as the default gateway). Any traffic meant for that IP 
address would be mistakenly re-directed to the node specified by the attacker. 

This table is used to adjust the CPU Filtering 
Settings. This table allows the user to Enable 
or Disable a number of settings for different 
ports on the Switch including; RIP, OSPF, 
VRRP, PIM, DVMRP or IGMP Query.   
Select the settings you wish to change for 
individual ports or port ranges and click 
Apply the changes can be viewed in the CPU 
Filtering Status – L3 Control Packet table 
on the lower have of the screen. 
To view this window, click Security 
Management > Filter > CPU Filtering 
Settings.
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D-Link managed switch can effectively mitigate the common Dos attack caused by the ARP spoofing via its unique Packet 
Content ACL. To prevent ARP spoofing attacks, we will use Packet Content ACL to block the invalid ARP packets which contain 
faked gateway’s MAC address and IP address binding. 
To view this window, click Security Management > ARP Spoofing Prevention. 

 
Figure 7- 64. ARP Spoofing Prevention window 

The parameters are described as below: 

Parameter                      Description 

Router/Gateway IP 
Address 

Enter the IP Address of the Router or Gateway you wish to protect. 

Router/Gateway 
MAC Address 

Enter the MAC Address of the Router or Gateway you wish to protect. 

Port Check the corresponding boxes for the port(s) you wish to apply the settings. 

To implement the new settings, click Apply.
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Section 8 
Monitoring 

Port Utilization 

CPU Utilization 

Memory Usage 

Packets 

Errors 

Size 

MAC Address 

Switch History Log 

IGMP Snooping Group 

IGMP Snooping Forwarding 

VLAN Status 

Router Port 

Port Access Control 

Layer 3 Feature 

Safeguard Engine Status 

Cable Diagnostic 

 

Port Utilization 

 
                                                         Figure 8- 1. Utilization window 

The following field can be set: 

Parameter              Description 

Time Interval Select the desired setting between 1s and 60s, where "s" stands for seconds. The default 

The Utilization window displays the percentage 
of the total available bandwidth being used on 
the ports. 
To view the port utilization, click Monitoring > 
Port Utilization: 
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value is one second. 

Record Number Select number of times the Switch will be polled between 20 and 200. The default value is 
200. 

Click Clear to refresh the graph. Click Apply to set changes implemented. 

 

CPU Utilization  
The CPU Utilization window displays the percentage of the CPU being used, expressed as an integer percentage and calculated 
as a simple average by time interval. To view this window, click Monitoring > CPU Utilization. 

 
Figure 8- 2. CPU Utilization window 

Click Apply to implement the configured settings. The window will automatically refresh with new updated statistics 
The information is described as follows: 

Parameter                Description 

Time Interval  Select the desired setting between 1s and 60s, where "s" stands for seconds. The default 
value is one second. 

Record Number  Select number of times the Switch will be polled between 20 and 200. The default value is 20.

Utilization Check whether or not to display Utilization. 

 

Memory Usage 
The Memory Usage window displays the percentage of the CPU Memory being used. To view this window, click Monitoring > 
Memory Usage. 
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Figure 8- 3. Memory Usage window 

Click Apply to implement the configured settings. The window will automatically refresh with new updated statistics 
The information is described as follows: 

Parameter                Description 

Time Interval  Select the desired setting between 1s and 60s, where "s" stands for seconds. The default 
value is one second. 

Record Number  Select number of times the Switch will be polled between 20 and 200. The default value is 
200. 

Show/Hide Check whether or not to display Usage. 
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Packets 
The Web Manager allows various packet statistics to be viewed as either a line graph or a table. Six windows are offered. 

Received (RX) 
To view this window, click Monitoring > Packets > Received (RX) to view the following graph of packets received on the 
Switch. 

 
Figure 8- 4. Rx Packets Analysis window (line graph for Bytes and Packets) 

To view the Received Packets Table, click the link View Table, which will show the following table: 



xStack® DES-3500 Series Layer 2 Stackable Fast Ethernet Managed Switch User Manual 

 208

 
Figure 8- 5. Rx Packets Analysis window (table for Bytes and Packets) 

The following fields may be set or viewed: 

Parameter                    Description 

Time Interval  Select the desired setting between 1s and 60s, where "s" stands for seconds. The default 
value is one second. 

Record Number  Select number of times the Switch will be polled between 20 and 200. The default value is 20. 

Bytes Counts the number of bytes received on the port. 

Packets Counts the number of packets received on the port. 

Show/Hide Check whether to display Bytes and Packets. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 

UMB Cast (RX) 
Click, Monitoring > Packets > UMB Cast (RX) to view the following graph of UMB cast packets received on the Switch. 
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Figure 8- 6. Rx Packets Analysis window (line graph for Unicast, Multicast, and Broadcast Packets) 

To view the UMB Cast Table, click the View Table link, which will show the following table: 
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Figure 8- 7. Rx Packets Analysis window (table for Unicast, Multicast, and Broadcast Packets) 

The following fields may be set or viewed: 

Parameter                     Description 

Time Interval  Select the desired setting between 1s and 60s, where "s" stands for seconds. The default 
value is one second. 

Record Number  Select number of times the Switch will be polled between 20 and 200. The default value is 
20. 

Unicast Counts the total number of good packets that were received by a unicast address. 

Multicast Counts the total number of good packets that were received by a multicast address. 

Broadcast Counts the total number of good packets that were received by a broadcast address. 

Show/Hide Check whether or not to display Multicast, Broadcast, and Unicast Packets. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 
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Transmitted (TX) 
Click Monitoring > Packets > Transmitted (TX)  to view the following graph of packets transmitted from the Switch. 
 

 
Figure 8- 8. Tx Packets Analysis window (line graph for Bytes and Packets) 

To view the Transmitted (TX) Table, click the link View Table, which will show the following table: 
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Figure 8- 9. Tx Packets Analysis window (table for Bytes and Packets) 

 
The following fields may be set or viewed: 

Parameter                   Description 

Time Interval  Select the desired setting between 1s and 60s, where "s" stands for seconds. The default value 
is one second. 

Record Number  Select number of times the Switch will be polled between 20 and 200. The default value is 20. 

Bytes Counts the number of bytes successfully sent from the port. 

Packets Counts the number of packets successfully sent on the port. 

Show/Hide Check whether or not to display Bytes and Packets. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 
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Errors 
The Web Manager allows port error statistics compiled by the Switch's management agent to be viewed as either a line graph or a 
table. Four windows are offered. 

Received (RX) 
Click, Monitoring > Error > Received (RX) to view the following graph of error packets received on the Switch. 

 
Figure 8- 10. Rx Error Analysis window (line graph) 

To view the Received Error Packets Table, click the link View Table, which will show the following table: 
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Figure 8- 11. Rx Error Analysis window (table) 

The following fields can be set: 

Parameter                       Description 

Time Interval  Select the desired setting between 1s and 60s, where "s" stands for seconds. The default 
value is one second. 

Record Number  Select number of times the Switch will be polled between 20 and 200. The default value is 
20. 

Crc Error Counts otherwise valid packets that did not end on a byte (octet) boundary. 

Under Size The number of packets detected that are less than the minimum permitted packets size of 64 
bytes and have a good CRC. Undersize packets usually indicate collision fragments, a nor-
mal network occurrence. 

Over Size Counts packets received that were longer than 1518 octets, or if a VLAN frame is 1522 
octets, and less than the MAX_PKT_LEN. Internally, MAX_PKT_LEN is equal to 1522. 

Fragment The number of packets less than 64 bytes with either bad framing or an invalid CRC. These 
are normally the result of collisions. 

Jabber The number of packets with lengths more than the MAX_PKT_LEN bytes. Internally, 
MAX_PKT_LEN is equal to 1522. 

Drop The number of packets that are dropped by this port since the last Switch reboot. 

Show/Hide Check whether or not to display Crc Error, Under Size, Over Size, Fragment, Jabber, and 
Drop errors. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 
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Transmitted (TX) 
Click, Monitoring > Error > Transmitted (TX) to view the following graph of error packets received on the Switch. 

 
Figure 8- 12. Tx Error Analysis window (line graph) 

To view the Transmitted Error Packets Table, click the link View Table, which will show the following table: 

 
Figure 8- 13. Tx Error Analysis window (table) 
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The following fields may be set or viewed: 

Parameter                        Description 

Time Interval  Select the desired setting between 1s and 60s, where "s" stands for seconds. The default 
value is one second. 

Record Number  Select number of times the Switch will be polled between 20 and 200. The default value is 
20. 

ExDefer Counts the number of packets for which the first transmission attempt on a particular 
interface was delayed because the medium was busy. 

LateColl Counts the number of times that a collision is detected later than 512 bit-times into the 
transmission of a packet. 

ExColl Excessive Collisions. The number of packets for which transmission failed due to excessive 
collisions. 

SingColl Single Collision Frames. The number of successfully transmitted packets for which 
transmission is inhibited by more than one collision. 

Coll An estimate of the total number of collisions on this network segment. 

Show/Hide Check whether or not to display ExDefer, LateColl, ExColl, SingColl, and Coll errors. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 

Size - Packet Size 
The Web Manager allows packets received by the Switch, arranged in six groups and classed by size, to be viewed as either a line 
graph or a table. Two windows are offered. To view this window click, Monitoring > Errors > Packet Size. 
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Figure 8- 14. Rx Size Analysis window (line graph) 

To view the Packet Size Analysis Table, click the link View Table, which will show the following table: 

 
Figure 8- 15. Rx Size Analysis window (table) 
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The following fields can be set or viewed: 

Parameter                    Description 

Time Interval  Select the desired setting between 1s and 60s, where "s" stands for seconds. The default 
value is one second. 

Record Number  Select number of times the Switch will be polled between 20 and 200. The default value is 20. 

64 The total number of packets (including bad packets) received that were 64 octets in length 
(excluding framing bits but including FCS octets). 

65-127 The total number of packets (including bad packets) received that were between 65 and 127 
octets in length inclusive (excluding framing bits but including FCS octets). 

128-255 The total number of packets (including bad packets) received that were between 128 and 255 
octets in length inclusive (excluding framing bits but including FCS octets). 

256-511 The total number of packets (including bad packets) received that were between 256 and 511 
octets in length inclusive (excluding framing bits but including FCS octets). 

512-1023 The total number of packets (including bad packets) received that were between 512 and 1023 
octets in length inclusive (excluding framing bits but including FCS octets). 

1024-1518 The total number of packets (including bad packets) received that were between 1024 and 
1518 octets in length inclusive (excluding framing bits but including FCS octets). 

Show/Hide Check whether or not to display 64, 65-127, 128-255, 256-511, 512-1023, and 1024-1518 
packets received. 

Clear Clicking this button clears all statistics counters on this window. 

View Table Clicking this button instructs the Switch to display a table rather than a line graph. 

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table. 

 



xStack® DES-3500 Series Layer 2 Stackable Fast Ethernet Managed Switch User Manual 

 219

MAC Address 

 
                                                                   Figure 8- 16. MAC Address Table window 

The following fields can be viewed or set: 

Parameter                        Description 

VLAN ID Enter a VLAN ID for the forwarding table to be browsed by. 

MAC Address Enter a MAC address for the forwarding table to be browsed by. 

Find Allows the user to move to a sector of the database corresponding to a user defined port, 
VLAN, or MAC address. 

VID The VLAN ID of the VLAN the port is a member of. 

MAC Address The MAC address entered into the address table. 

Port The port that the MAC address above corresponds to. 

Learned How the Switch discovered the MAC address. The possible entries are Dynamic, Self, and 
Static. 

Next Click this button to view the next page of the address table. 

View All Entry Clicking this button will allow the user to view all entries of the address table. 

Delete All Entry Clicking this button will allow the user to delete all entries of the address table. 

This allows the Switch's dynamic MAC 
address forwarding table to be viewed. When 
the Switch learns an association between a 
MAC address and a port number, it makes an 
entry into its forwarding table. These entries 
are then used to forward packets through the 
Switch. 
To view the MAC Address forwarding table, 
click, Monitoring > MAC Address: 
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Switch History Log 
The Web manager allows the Switch's history log, as compiled by the Switch's management agent, to be viewed. To view the 
Switch history log click, Maintenance > Switch History Log. 

 
Figure 8- 17. Switch History window 

The Switch can record event information in its own logs, to designated SNMP trap receiving stations, and to the PC connected to 
the console manager. Click Next to go to the next page of the Switch History Log. Clicking Clear will allow the user to clear the 
Switch History Log.  
The information is described as follows: 

Parameter               Description 

Sequence A counter incremented whenever an entry to the Switch's history log is made. The table displays 
the last entry (highest sequence number) first.   

Time Displays the time in days, hours, and minutes since the Switch was last restarted. 

Log Text Displays text describing the event that triggered the history log entry. 

 

 

NOTE: For detailed information regarding Log entries that will appear in this window, please refer to 
Appendix C at the back of this manual. 
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IGMP Snooping Group 
IGMP Snooping allows the Switch to read the Multicast Group IP address and the corresponding MAC address from IGMP 
packets that pass through the Switch. The number of IGMP reports that were snooped is displayed in the Reports field. 
To view the IGMP Snooping Table, click Monitoring > IGMP Snooping Group. 

 
Figure 8- 18. IGMP Snooping Table window 

The user may search the IGMP Snooping Table by VLAN ID (VID) by entering the VID in the top left hand corner and clicking 
Search.  

 

NOTE: The Switch supports up to 128 IGMP Snooping groups. 

The following field can be viewed: 

Parameter                       Description 

VLAN ID The VLAN ID (VID) of the multicast group. 

Multicast Group The IP address of the multicast group. 

MAC Address The MAC address of the multicast group. 

Queries A read-only field showing the status of the Querier State. Disabled implies that the Switch is 
not transmitting IGMP Snooping Query packets, while Enabled means those packets are 
being transmitted. 

Reports The total number of reports received for this group. 

Port Map These are the ports where the IGMP packets were snooped are displayed. 

 

 

NOTE: To configure IGMP snooping for the DES-3500 Series switches, go to the Configuration 
folder and select IGMP. Configuration and other information concerning IGMP snooping may be found 
in Section 6 of this manual under IGMP. 
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IGMP Snooping Forwarding  
This window will display the current IGMP snooping forwarding table entries currently configured on the Switch. To view the 
following screen, click, Monitoring > IGMP Snooping Forwarding. 

 
Figure 8- 19. IGMP Snooping Forwarding Table window 

The user may search the IGMP Snooping Forwarding Table by VID clicking the top left hand corner Search button. 
The following field can be viewed: 

Parameter                       Description 

VLAN ID The VLAN ID (VID) of the multicast group. 

Multicast Group The IP address of the multicast group. 

MAC Address The MAC address of the multicast group. 

Port Map These are the ports where the IGMP packets were snooped are displayed. 
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VLAN Status 
This allows the VLAN status for each of the Switch's ports to be viewed by VLAN. This window displays the ports on the Switch 
that are currently Egress or Tag ports. To view the following table, click Monitoring > VLAN Status. 

 
Figure 8- 20. VLAN Status window 

Router Port 
This displays which of the Switch's ports are currently configured as router ports. A router port configured by a user (using the 
console or Web-based management interfaces) is displayed as a static router port, designated by S. D designates a router port that 
is dynamically configured by the Switch. To view the following window, click Monitoring > Router Port. 

 
Figure 8- 21. Router Port window 

Port Access Control 
The following windows are used to monitor 802.1x statistics of the Switch, on a per port basis.  
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Authenticator State 
The following section window displays the 802.1X Status on the Switch. To view the Authenticator State, click Monitoring > 
Port Access Control > Authenticator State. 

 
Figure 8- 22.  Authenticator State window – Port-based 802.1x 
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Figure 8- 23. Show Authenticator State window – MAC-Based 802.1x 

This window displays the Authenticator State for individual ports on a selected device. To select a unit within the switch stack, 
use the pull-down menu at the top of the window and click Apply. A polling interval between 1 and 60 seconds can be set using 
the drop-down menu at the top of the window and clicking OK. 
The information on this window is described as follows: 

Parameter                          Description 

Auth PAE State The Authenticator PAE State value can be: Initialize, Disconnected, Connecting, 
Authenticating, Authenticated, Aborting, Held, Force_Auth, Force_Unauth, or N/A. N/A 
(Not Available) indicates that the port's authenticator capability is disabled. 

Backend State The Backend Authentication State can be Request, Response, Success, Fail, Timeout, 
Idle, Initialize, or N/A. N/A (Not Available) indicates that the port's authenticator capability 
is disabled. 

Port Status Controlled Port Status can be Authorized, Unauthorized, or N/A. 
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Layer 3 Features 
Browse ARP Table 
The ARP Table window may be found by clicking, Monitoring > Layer 3 Feature > Browse ARP Table. This window will 
show current ARP entries on the Switch. To search a specific ARP entry, enter an interface name into the Interface Name field or 
an IP address and click Find. 

 
Figure 8- 24. ARP Table window 
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Safeguard Engine Status 
The following window displays parameters configured for and about the Safeguard Engine Status currently set on the Switch. 
To view this window click, Monitoring > Safeguard Engine Status. 

 
Figure 8- 25. Safeguard Engine Status and CPU Utilization Information window 

The information is described as follows:  

Parameter                       Description 

State Displays the current running state of the Safeguard Engine, whether enabled or disabled. 

Current Status Displays the current running status of the Safeguard Engine, whether in exhausted mode or 
normal mode. 

Interval  Displays the time interval between the checking of the rising and falling threshold of packets 
entering the Switch. The default setting is 5 seconds. 

Rising Threshold Displays the set percentage of the rising threshold of packets determinant of the Safeguard 
Engine. 

Falling Threshold Displays the set percentage of the falling threshold of packets determinant of the Safeguard 
Engine. 

Trap/log Displays the status of the sending of messages to the switch’s log or SNMP trap. Enabled 
will denote the switch will send trap messages in the event of a Safeguard Engine 
engagement. 
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Cable Diagnostic 
The following window displays parameters configured for and about the Cable Diagnostics currently set on the Switch. To view 
this window click, Monitoring > Cable Diagnostic. 

 
Figure 8- 26. Cable Diagnostic Table window 

 



xStack® DES-3500 Series Layer 2 Stackable Fast Ethernet Managed Switch User Manual 

 229

Section 9 
Maintenance 

TFTP Services 

Multiple Image Services 

Ping Test 

Save Changes 

Reset 

Reset System 

Reset Config 

Reboot Device 

Logout 

 

TFTP Services 
Trivial File Transfer Protocol (TFTP) services allow the Switch's firmware to be upgraded by transferring a new firmware file 
from a TFTP server to the Switch. A configuration file can also be loaded into the Switch from a TFTP server. Switch settings can 
be saved to the TFTP server, and a history log can be uploaded from the Switch to the TFTP server. 

Download Firmware 
To update the Switch's firmware, click Maintenance > TFTP Services > Download Firmware: 

 
Figure 9- 1. Download/Update Firmware from TFTP Server window 

The Switch can hold two firmware versions for the user, which can be specified in the Type field by clicking the Update radio 
button and selecting the Image 1 or Image 2. To download or update firmware, configure the following fields and click Start. 

Parameter              Description  

Server IP Enter the IP address of the server from which you wish to download firmware. 

File Name Specify the path and filename of the firmware on the Server. 
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Type Specify the purpose of the firmware: 
Download: Clicking this radio button will specify a download to the Switch. This will be the 
firmware that the Switch will immediately use. 
Update: Clicking this radio button will save the firmware to the Switch's memory but not 
configure the Switch for this firmware. The Switch may hold two firmware versions specified 
as Section 1 and Section 2. 

Information about firmware on the Switch can be viewed in the Firmware Management table in the same window. It holds the 
following information:  

Parameter               Description 

ID The user-defined Section ID of the firmware on the Switch. 

Boot Status The firmware that is currently being run on the Switch will be identified in this field with the term 
"Boot". 

Version The runtime version of the firmware. 

Size The size of the firmware, in bytes. 

Date The date that the firmware was added to the Switch. 

From The IP address of the Server from which the firmware came. 

User The name of the user who downloaded the firmware. 

Set Boot Click the Apply button in this field to set the firmware version to be used upon the next boot up of 
the Switch. 

Delete Click the X in this column to permanently delete the corresponding firmware from the Switch. 

Download Configuration File 
To download a settings file from a TFTP server, click Maintenance > TFTP Service > Download Configuration File: 

 
Figure 9- 2. Download Settings from TFTP Server window 

Enter the IP address of the TFTP server and specify the location of the switch settings file on the TFTP server. 
Click Start to record the IP address of the TFTP server and to initiate the file transfer. 

Upload Configuration 
To upload the switch settings to a TFTP server, click Maintenance > TFTP Services > Upload Configuration: 

 
Figure 9- 3. Upload Settings to TFTP Server window 

Enter the IP address of the TFTP server and the path and filename for the switch settings on the TFTP server.  
Click Start to record the IP address of the TFTP server and to initiate the file transfer. 
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Upload Log  
To upload the switch history log file to a TFTP server, click Maintenance > TFTP Services > Upload Log: 

 
Figure 9- 4. Upload Log to TFTP Server window 

Enter the IP address of the TFTP server and the path and filename for the history log on the TFTP server.  
Click Start to record the IP address of the TFTP server and to initiate the file transfer. 

 

Multiple Image Services 
The Multiple Image Services folder allows users of the xStack® family of switches to configure and view information regarding 
firmware located on the Switch. The Switch allows two firmware images to be stored in its memory and either can be configured 
to be the boot up firmware for the Switch. For information regarding firmware images located on the Switch, open the Firmware 
Information link. The default setting for the Switch’s firmware will have the boot up firmware stored in Image 1, but the user 
may set either firmware stored to be the boot up firmware by using the Config Firmware Image window.  

Firmware Information 
The following screen allows the user to view information about current firmware images stored on the Switch. To access the 
following screen, click Maintenance > Multiple Image Services > Firmware Information. 

 
Figure 9- 5. Firmware Information window 

This window holds the following information: 

Parameter         Description 

BOX States the stacking ID number of the switch in the switch stack. 

ID States the image ID number of the firmware in the Switch’s memory. The Switch can store 2 
firmware images for use. Image ID 1 will be the default boot up firmware for the Switch unless 
otherwise configured by the user. 
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Version States the firmware version.  

Size States the size of the corresponding firmware, in bytes. 

Update Time States the specific time the firmware version was downloaded to the Switch.  

From States the IP address of the origin of the firmware. There are five ways firmware may be 
downloaded to the Switch. 

• R – If the IP address has this letter attached to it, it denotes a firmware upgrade 
through the Console Serial Port (RS-232). 

• T - If the IP address has this letter attached to it, it denotes a firmware upgrade through 
Telnet. 

• S - If the IP address has this letter attached to it, it denotes a firmware upgrade through 
the Simple Network Management Protocol (SNMP). 

• W - If the IP address has this letter attached to it, it denotes a firmware upgrade 
through the web-based management interface. 

• SIM – If the IP address has this letter attached to it, it denotes a firmware upgrade 
through the Single IP Management feature. 

User States the user who downloaded the firmware. This field may read “Anonymous” or “Unknown” 
for users that are not identified. 

Config Firmware Image 
The Config Firmware Image window allows users to configure firmware images saved in the memory of the Switch. To access 
the following window, click Maintenance > Multiple Image Services > Config Firmware Image. 

 
Figure 9- 6. Config Firmware Image window 

This window offers the following information: 

Parameter     Description 

Image  Select the firmware image to be configured using the pull-down menu. The Switch allows two 
firmware images to be stored in the Switch’s memory.  

Action This field has two options for configuration. 

• Delete – Select this option to delete the firmware image specified in the Image field above.

• Boot – Select this option to set the firmware image specified above as the boot up 
firmware for the Switch. This firmware will be set as the boot up firmware after a switch 
reboot has been performed. The default setting has firmware image ID 1 as the boot up 
firmware image for the Switch unless specified here. 

Click Apply to implement changes made. 
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Ping Test 
Ping is a small program that sends ICMP Echo packets to the IP address you specify. The destination node then responds to or 
"echoes" the packets sent from the Switch. This is very useful to verify connectivity between the Switch and other nodes on the 
network. To view this window, click Maintenance > Ping Test. 

 
Figure 9- 7. Ping Test window 

The user may use Infinite times radio button, in the Repeat Pinging for field, which will tell the ping program to keep sending 
ICMP Echo packets to the specified IP address until the program is stopped. The user may opt to choose a specific number of 
times to ping the Target IP Address by clicking its radio button and entering a number between 1 and 255. Click Start to initiate 
the Ping program. 
 

Save Changes 
The DES-3500 Series switches have two levels of memory; normal RAM and non-volatile or NV-RAM. Configuration changes 
are made effective by clicking the Apply button. When this is done, the settings will be immediately applied to the switching 
software in RAM, and will immediately take effect.  
Some settings, though, require you to restart the Switch before they will take effect. Restarting the Switch erases all settings in 
RAM and reloads the stored settings from the NV-RAM. Thus, it is necessary to save all setting changes to NV-RAM before 
rebooting the Switch. 
To retain any configuration changes permanently, click the Save Changes link in the Maintenance folder. The following window 
will appear: 

 
Figure 9- 8.  Save Configuration window 

Click the Save Configuration button to save the current switch configuration in NV-RAM. The following dialog box will 
confirm that the configuration has been saved: 
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Figure 9- 9.  Save Configuration Confirmation dialog box 

Click the OK button to continue. Once the Switch configuration settings have been saved to NV-RAM, they become the default 
settings for the Switch. These settings will be used every time the Switch is rebooted.   

Reset 
The Reset function has several options when resetting the Switch.  Some of the current configuration parameters can be retained 
while resetting all other configuration parameters to their factory defaults.  

 

NOTE: Only the Reset System option will enter the factory default parameters into the Switch's 
non-volatile RAM, and then restart the Switch. All other options enter the factory defaults into the 
current configuration, but do not save this configuration.  Reset System will return the Switch's 
configuration to the state it was when it left the factory 

Reset gives the option of retaining the Switch's User Accounts and History Log while resetting all other configuration parameters 
to their factory defaults.  If the Switch is reset using this window, and Save Changes is not executed, the Switch will return to the 
last saved configuration when rebooted. 

 
Figure 9- 10. Reset window 

Reset System 
In addition, the Reset System option is added to reset all configuration parameters to their factory defaults, save these parameters 
to the Switch's non-volatile RAM, and then restart the Switch. This option is equivalent to Reset Config followed by Save 
Changes. 

 
Figure 9- 11. Reset System window 
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Reset Config 
The Reset Config option will reset all of the Switch's configuration parameters to their factory defaults, without saving these 
default values to the Switch's non-volatile RAM. If the Switch is reset with this option enabled, and Save Changes is not executed, 
the Switch will return to the last saved configuration when rebooted. 

 
Figure 9- 12. Reset Config window 

Reboot Device 
The following window is used to restart the Switch. 
All of the configuration information entered from the last time Save Changes was executed will be lost. Click the Reboot button 
to restart the Switch. 

 
Figure 9- 13. Reboot window 

Logout 
Use the Logout page to logout of the Switch's Web-based management agent by clicking on the Log Out button. 

 
Figure 9- 14. Logout Web Setup window 
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Section 10 
D-Link Single IP Management 
 

Single IP Management (SIM) Overview 

Topology 

Firmware Upgrade 

Configuration Backup/Restore 

Upload Log File 

 

Single IP Management (SIM) Overview 
Simply put, D-Link Single IP Management is a concept that will stack switches together over Ethernet instead of using stacking 
ports or modules. There are some advantages in implementing the "Single IP Management" feature: 

1. SIM can simplify management of small workgroups or wiring closets while scaling the network to handle increased 
bandwidth demand. 

2. SIM can reduce the number of IP address needed in your network. 
3. SIM can eliminate any specialized cables for stacking connectivity and remove the distance barriers that typically limit 

your topology options when using other stacking technology.  
Switches using D-Link Single IP Management (labeled here as SIM) must conform to the following rules: 

• SIM is an optional feature on the Switch and can easily be enabled or disabled through the Command Line Interface or 
Web Interface. SIM grouping has no effect on the normal operation of the Switch in the user's network. 

• There are three classifications for switches using SIM. The Commander Switch (CS), which is the master switch of the 
group, Member Switch (MS), which is a switch that is recognized by the CS a member of a SIM group, and a 
Candidate Switch (CaS), which is a Switch that has a physical link to the SIM group but has not been recognized by 
the CS as a member of the SIM group. 

• A SIM group can only have one Commander Switch (CS). 
• All switches in a particular SIM group must be in the same IP subnet (broadcast domain). Members of a SIM group 

cannot cross a router. 
• A SIM group accepts one Commander Switch (numbered 0) and up to 32 switches (numbered 0-31). 

There is no limit to the number of SIM groups in the same IP subnet (broadcast domain), however a single switch can only belong 
to one group. 
If multiple VLANs are configured, the SIM group will only utilize the system VLAN that has been assigned the switch’s IP 
address.  
SIM allows intermediate devices that do not support SIM. This enables the user to manage switches that are more than one hop 
away from the CS. 
The SIM group is a group of switches that are managed as a single entity. The DES-3500 Series switches may take on three 
different roles: 

1. Commander Switch (CS) - This is a switch that has been manually configured as the controlling device for a group, and 
takes on the following characteristics:  

•  It has an IP Address. 
•  It is not a command switch or member switch of another Single IP group. 
•  It is connected to the member switches through its management VLAN. 

2. Member Switch (MS) - This is a switch that has joined a single IP group and is accessible from the CS, and it takes on 
the following characteristics: 

•  It is not a CS or MS of another IP group. 
•  It is connected to the CS through the CS management VLAN. 

3. Candidate Switch(CaS) - This is a switch that is ready to join a SIM group but is not yet a member of the SIM group. 
The Candidate Switch may join the SIM group through an automatic function of the DES-3500 Series switches, or by 
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manually configuring it to be a MS of a SIM group. A switch configured as a CaS is not a member of a SIM group and 
will take on the following characteristics: 

 

•  It is not a CS or MS of another Single IP group. 

•  It is connected to the CS through the CS management VLAN 

The following rules also apply to the above roles: 

• Each device begins in a Commander state. 

• CS's must change their role to CaS and then to MS, to become a MS of a SIM group. Thus the CS cannot directly be 
converted to a MS. 

• The user can manually configure a CS to become a CaS. 

A MS can become a CaS by: 

• Being configured as a CaS through the CS. 

• If report packets from the CS to the MS time out. 

• The user can manually configure a CaS to become a CS 

• The CaS can be configured through the CS to become a MS.  

After configuring one switch to operate as the CS of a SIM group, additional DES-3500 Series switches may join the group either 
by an automatic method or by manually configuring the Switch to be a MS. The CS will then serve as the in band entry point for 
access to the MS. The CS's IP address will become the path to all MS's of the group and the CS's Administrator's password, and/or 
authentication will control access to all MS's of the SIM group. 
With SIM enabled, the applications in the CS will redirect the packet instead of executing the packets. The applications will 
decode the packet from the administrator, modify some data, and then send it to the MS. After execution, the CS may receive a 
response packet from the MS, which it will encode and send it back to the administrator. 
When a CS becomes a MS, it automatically becomes a member of the first SNMP community (include read/write and read only) 
to which the CS belongs. However, if a MS has its own IP address, it can belong to SNMP communities to which other switches 
in the group, including the CS, do not belong. 

The Upgrade to v1.6 
To better improve SIM management, the xStack® DES-3500 Series switches have been upgraded to version 1.6 in this release. 
Many improvements have been made, including: 
1.  The Commander Switch (CS) now has the capability to automatically rediscover member switches that have left the SIM group, 
either through a reboot or web malfunction. This feature is accomplished through the use of Discover packets and Maintain 
packets that previously set SIM members will emit after a reboot. Once a MS has had its MAC address and password saved to the 
CS’s database, if a reboot occurs in the MS, the CS will keep this MS information in its database and when a MS has been 
rediscovered, it will add the MS back into the SIM tree automatically. No configuration will be necessary to rediscover these 
switches. 
There are some instances where pre-saved MS switches cannot be rediscovered. For example, if the Switch is still powered down, 
if it has become the member of another group, or if it has been configured to be a Commander Switch, the rediscovery process 
cannot occur. 

 
3.  This version will support multiple switch upload and downloads for firmware, configuration files and log files, as follows: 

Firmware – The switch now supports multiple MS firmware downloads from a TFTP server. 
Configuration Files – This switch now supports multiple downloading and uploading of configuration files both to (for 
configuration restoration) and from (for configuration backup) MS’s, using a TFTP server. 
Log – The switch now supports uploading multiple MS log files to a TFTP server. 

2.  The topology map now includes new features for connections that are a member of a 
port trunking group. It will display the speed and number of Ethernet connections 
creating this port trunk group, as shown in the adjacent picture. 
 

 

NOTE: For more details regarding improvements made 
in SIMv1.6, please refer to the D-Link Single IP 
Management White Paper located on the D-Link 
website. 
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4. The user may zoom in and zoom out when utilizing the topology window to get a better, more defined view of the 
configurations. 

SIM Using the Web Interface 
All DES-3500 Series switches are set as Candidate (CaS) switches, as their factory default configuration and Single IP 
Management will be disabled. To enable SIM for the Switch using the Web interface, click Single IP Management > SIM 
Settings. 

 
Figure 10- 1. SIM Settings window (disabled) 

Change the SIM State to Enabled using the pull-down menu and click Apply. The window will then refresh and the SIM 
Settings window will look like this: 

 
Figure 10- 2. SIM Settings window (enabled) 

The following parameters can be set: 

Parameters                    Description 

SIM State Use the pull-down menu to either enable or disable the SIM state on the Switch. Disabled 
will render all SIM functions on the Switch inoperable. 

Role State Use the pull-down menu to change the SIM role of the Switch. The two choices are: 
Candidate - A Candidate Switch (CaS) is not the member of a SIM group but is connected to 
a Commander Switch. This is the default setting for the SIM role of the DES-3500 Series 
switches. 
Commander - Choosing this parameter will make the Switch a Commander Switch (CS). The 
user may join other switches to this Switch, over Ethernet, to be part of its SIM group. 
Choosing this option will also enable the Switch to be configured for SIM. 

Discovery Interval The user may set the discovery protocol interval, in seconds that the Switch will send out 
discovery packets. Returning information to a Commander Switch will include information 
about other switches connected to it. (Ex. MS, CaS). The user may set the Discovery Interval 
from 30 to 90 seconds. 

Holdtime This parameter may be set for the time, in seconds; the Switch will hold information sent to it 
from other switches, utilizing the Discovery Interval. The user may set the hold time from 100 
to 255 seconds. 

Group Name The user may enter a Group Name of up to 64 characters to define the SIM group created.  
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Click Apply to implement the settings changed. 
After enabling the Switch to be a Commander Switch (CS), the Single IP Management folder will then contain four added links 
to aid the user in configuring SIM through the web, including Topology, Firmware Upgrade, Configuration Backup/Restore 
and Upload Log File. 

Topology 
The Topology window will be used to configure and manage the Switch within the SIM group and requires Java script to function 
properly on your computer. The following message should appear the first time the user clicks the Topology link in the Single IP 
Management folder. 

 
Figure 10- 3. Java window 

Clicking the here link will setup the Java Runtime Environment on your server and lead you to the topology window, as seen 
below. 

 
Figure 10- 4. Single IP Management window-Tree View 

The Tree View window holds the following information under the Data tab: 

Parameter              Description  

Device Name This field will display the Device Name of the switches in the SIM group configured by the 
user. If no Device Name is configured by the name, it will be given the name default and 
tagged with the last six digits of the MAC Address to identify it. 

Local Port Displays the number of the physical port on the CS that the MS or CaS is connected to. The 
CS will have no entry in this field. The CS will not display an entry in this field. 
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Speed Displays the connection speed between the CS and the MS or CaS. The CS will not display 
an entry in this field. 

Remote Port Displays the number of the physical port on the MS or CaS that the CS is connected to. The 
CS will have no entry in this field. The CS will not display an entry in this field. 

MAC Address Displays the MAC Address of the corresponding Switch. 

Model Name Displays the full Model Name of the corresponding Switch. 

To view the Topology Map, click the View menu in the toolbar and then Topology, which will produce the following window. 
The Topology View will refresh itself periodically (20 seconds by default). 

 
Figure 10- 5. Topology view 

This window will display how the devices within the Single IP Management Group are connected to other groups and devices. 
Possible icons in this window are as follows: 

Icon                      Description 

 
Group 

 
Layer 2 commander switch 

 
Layer 3 commander switch 

 
Commander switch of other group 
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Layer 2-member switch. 

 
Layer 3 member switch 

 
Member switch of other group 

 
Layer 2 candidate switch 

 
Layer 3 candidate switch 

 
Unknown device 

 

Non-SIM devices 

Tool Tips 
In the Topology view window, the mouse plays an important role in configuration and in viewing device information. Setting the 
mouse cursor over a specific device in the topology window (tool tip) will display the same information about a specific device as 
the Tree view does. See the window below for an example.  

 
Figure 10- 6. Device Information Utilizing the Tool Tip 

Setting the mouse cursor over a line between two devices will display the connection speed between the two devices, as shown 
below. 
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Figure 10- 7. Port Speed Utilizing the Tool Tip 

Right-Click 
Right clicking on a device will allow the user to perform various functions, depending on the role of the Switch in the SIM group 
and the icon associated with it. 

Group Icon 

      
Figure 10- 8. Right-Clicking a Group Icon 

The following options may appear for the user to configure: 

• Collapse - to collapse the group that will be represented by a single icon. 

• Expand - to expand the SIM group, in detail.  

• Property - to pop up a window to display the group information. 
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Figure 10- 9. Property window 

Commander Switch Icon 

        
Figure 10- 10. Right-Clicking a Commander Icon 

The following options may appear for the user to configure: 

• Collapse - to collapse the group that will be represented by a single icon. 

• Expand - to expand the SIM group, in detail.  

• Property - to pop up a window to display the group information. 
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Figure 10- 11. Property window 

Member Switch Icon 

      
Figure 10- 12. Right-Clicking a Member icon 

The following options may appear for the user to configure: 

• Collapse - to collapse the group that will be represented by a single icon. 

• Expand - to expand the SIM group, in detail. 

• Remove from group - remove a member from a group. 

• Configure - launch the web management to configure the Switch. 

• Property - to pop up a window to display the device information. 
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Figure 10- 13. Property window 

Candidate Switch Icon 

   
Figure 10- 14. Right-Clicking a Candidate icon 

The following options may appear for the user to configure: 

• Collapse - to collapse the group that will be represented by a single icon. 

• Expand - to expand the SIM group, in detail. 

• Add to group - add a candidate to a group. Clicking this option will reveal the following dialog box for the user to 
enter a password for authentication from the Candidate Switch before being added to the SIM group. Click OK to enter 
the password or Cancel to exit the window. 

 
Figure 10- 15. Input password dialog box 

• Property - to pop up a window to display the device information, as shown below. 
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Figure 10- 16. Property window 

This window holds the following information: 

Parameter                       Description  

Device Name This field will display the Device Name of the switches in the SIM group configured by the 
user. If no Device Name is configured by the name, it will be given the name default and 
tagged with the last six digits of the MAC Address to identify it. 

Module Name Displays the full module name of the switch that was right-clicked. 

MAC Address Displays the MAC Address of the corresponding Switch. 

Remote Port No. Displays the number of the physical port on the MS or CaS that the CS is connected to. The 
CS will have no entry in this field. 

Local Port No. Displays the number of the physical port on the CS that the MS or CaS is connected to. The 
CS will have no entry in this field. 

Port Speed Displays the connection speed between the CS and the MS or CaS. The CS will have no 
entry in this field. 

Click Close to close the Property window. 
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Menu Bar 
The Single IP Management window contains a menu bar for device configurations, as seen below.  

 
Figure 10- 17. Menu Bar of the Topology View 

The five menus on the menu bar are as follows. 

File 
• Print Setup - will view the image to be printed. 

• Print Topology - will print the topology map. 

• Preference - will set display properties, such as polling interval, and the views to open at SIM startup. 

Group 
• Add to group - add a candidate to a group. Clicking this option will reveal the following dialog box for the user to 

enter a password for authentication from the Candidate Switch before being added to the SIM group. Click OK to enter 
the password or Cancel to exit the window. 

 
Figure 10- 18. Input password dialog box 

• Remove from Group - remove an MS from the group. 

Device 
• Configure - will open the web manager for the specific device. 

 

View 
• Refresh - update the views with the latest status. 

• Topology - display the Topology view. 

 

Help 
• About - Will display the SIM information, including the current SIM version. 
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NOTE: Upon this firmware release, some functions of the SIM can only be configured through the 
Command Line Interface. See the DES-3500 Series  Command Line Interface Reference Manual 
for more information on SIM and its configurations. 

Firmware Upgrade 
This window is used to upgrade firmware from the Commander Switch to the Member Switch.  Member Switches will be listed in 
the table and will be specified by Port (port on the CS where the MS resides), MAC Address, Model Name and Version. To 
specify a certain Switch for firmware download, click its corresponding check box under the Port heading. To update the firmware, 
enter the Server IP Address where the firmware resides and enter the Path/Filename of the firmware. Click Download to initiate 
the file transfer. 

 
Figure 10- 19. Firmware Upgrade window 

Configuration File Backup/Restore 
This window is used to upgrade configuration files from the Commander Switch to the Member Switch.  Member Switches will 
be listed in the table and will be specified by Port (port on the CS where the MS resides), MAC Address, Model Name and 
Version. To specify a certain Switch for upgrading configuration files, click its corresponding radio button under the Port heading. 
To update the configuration file, enter the Server IP Address where the firmware resides and enter the Path/Filename of the 
firmware. Click Download to initiate the file transfer. 

 
Figure 10- 20. Configuration File Backup/Restore window  

Upload Log File 
The following window is used to upload log files from SIM member switches to a specified PC. To view this window, click 
Single IP Management > Upload Log File. To upload a log file, enter the IP address of the SIM member switch and then enter 
the path on your PC to which to save this file. Click Upload to initiate the file transfer.  
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Figure 10- 21. Upload Log File window 
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Appendix A 
Technical Specifications 

General 

Standards IEEE 802.3 Nway auto-negotiation 
IEEE 802.3 10BASE-T Ethernet 
IEEE 802.3u 100BASE-TX Fast Ethernet 
IEEE 802.3ab 1000BASE-T Gigabit Ethernet 
IEEE 802.3z 1000BASE-T (SFP “Mini GBIC”) 
IEEE 802.1D Spanning Tree 
IEEE 802.1w Rapid Spanning Tree 
IEEE 802.1s Multiple Spanning Tree 
IEEE 802.1Q VLAN 
IEEE 802.1p Priority Queues 
IEEE 802.3ad Link Aggregation Control 
IEEE 802.3x Full-duplex Flow Control 

Protocols CSMA/CD 

Data Transfer Rates:  
 
Ethernet  
 
Fast Ethernet 
 
Gigabit Ethernet 
 
Fiber Optic 
 
 
 

Half-duplex Full-duplex   
 
10 Mbps 20Mbps 
 
100Mbps 200Mbps  
 
n/a              2000Mbps 
 
SFP (Mini GBIC) Support 
IEEE 802.3z 1000BASE-LX (DEM-310GT transceiver) 
IEEE 802.3z 1000BASE-SX (DEM-311GT transceiver) 
IEEE 802.3z 1000BASE-LH (DEM-314GT transceiver) 
IEEE 802.3z 1000BASE-ZX (DEM-315GT transceiver) 

Topology Star 

Network Cables 
 

Cat.5 Enhanced for 1000BASE-T 
UTP Cat.5, Cat. 5 Enhanced for 100BASE-TX 
UTP Cat.3, 4, 5 for 10BASE-T 
EIA/TIA-568 100-ohm screened twisted-pair (STP)(100m) 

Number of Ports 24 10/100/1000 Mbps ports (DES-3526/DES-DES-3526DC) 
48 10/100/1000 Mbps ports (DES-3550) 
2 1000BASE-T Mini-GBIC Combo Ports 
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Physical and Environmental 

Internal power supply AC Input: 100 – 120; 200 – 240 VAC, 50/60 Hz 
DC 60W   DC Power Input: 48V     Output: 12V  

Power Consumption For DES-3526/ DES-3526DC, Max. 23 watts 
For DES-3550, Max. 40 watts 

DC fans For DES-3526/ DES-3526DC, one 40 mm fan  
For DES-3550, two 40mm fan 

Operating Temperature 0 - 40°C 

Storage Temperature -40 - 70°C 

Humidity 5 - 95% non-condensing 

Dimensions For DES-3526/ DES-3526DC, 441(W) x 207(D) x 44(H) mm, 19-inch, 1U Rack-mount size 
For DES-3550, 441(W) × 309(D) × 44(H) mm 

Weight For DES-3526, 2.56 kg  
For DES-3526DC, 2.5 kg  
For DES-3550, 5Kg 

EMI CE class A, FCC Class A, C-Tick, VCCI class A 

Safety CSA International 

 
 

Performance 

Transmission Method Store-and-forward 

Packet Buffer 16 MB per device 

Packet Filtering/Forwarding Rate Full-wire speed for all connections. 1,488,095 pps per port (for 1000Mbps) 

MAC Address Learning Automatic update. Supports 8K MAC address. 

Priority Queues 4 Priority Queues per port. 

Forwarding Table Age Time Max age: 10-1000000 seconds. Default = 300. 
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Appendix B 
Cables and Connectors 
When connecting the Switch to another switch, a bridge or hub, a normal cable is necessary. Please review these products for 
matching cable pin assignment. 
The following diagrams and tables show the standard RJ-45 receptacle/connector and their pin assignments. 
  

 
Figure B- 1. The standard RJ-45 port and connector 

RJ-45 Pin Assignments 

Contact MDI-X Port MDI-II Port 

1 RD+ (receive) TD+ (transmit) 

2 RD- (receive) TD- (transmit) 

3 TD+ (transmit) RD+ (receive) 

4 Not used Not used 

5 Not used Not used 

6 TD- (transmit) RD- (receive) 

7 Not used Not used 

8 Not used Not used 

Table B- 1. The standard RJ-45 pin assignments 
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Appendix C 
System Log Entries 
The following table lists all possible entries and their corresponding meanings that will appear in the System Log of this Switch. 

Category  Event 
Description Log Content Severity Remark 

system  System started up 
by reboot System warm start Critical  

system  System started up 
by power recycle System cold start Critical  

 Configuration 
saved to flash 

Configuration and log saved 
to flash by console 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational

"by console" and "IP: 
<ipaddr>, MAC: <macaddr>" 
are XOR shown in log strings, 
which means if the user logs 
in through the console, no IP 
or MAC address information 
will be included in the log. 

 Internal Power 
failed Internal Power failed Critical  

 Internal Power is 
recovered Internal Power is recovered Critical  

 Redundant Power 
failed Redundant Power failed Critical  

 Redundant Power 
is working Redundant Power is working Critical  

up/down-
load 

Firmware 
upgraded 
successfully 

Firmware upgraded by 
console successfully 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Firmware 
upgrade was 
unsuccessful  

Firmware upgrade by console 
was unsuccessful! 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning 

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Configuration 
successfully 
downloaded 

Configuration successfully 
downloaded by console 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Configuration 
download was 
unsuccessful 

Configuration download by 
console was unsuccessful! 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning 
by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
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Category  Event 
Description Log Content Severity Remark 

through the console, no IP or 
MAC address information will 
be included in the log. 

 
Configuration 
successfully 
uploaded 

Configuration successfully 
uploaded by console 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Configuration 
upload was 
unsuccessful 

Configuration upload by 
console was unsuccessful! 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning 

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Log message 
successfully 
uploaded 

Log message successfully 
uploaded by console 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

 
Log message 
upload was 
unsuccessful  

Log message upload by 
console was unsuccessful! 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning 

by console and "IP: <ipaddr>, 
MAC: <macaddr>" are XOR 
shown in log string, which 
means if the user logs in 
through the console, no IP or 
MAC address information will 
be included in the log. 

Interface Port link up  Port <portNum> link up, <link 
state> Informational Port link state (ex: , 100Mbps 

FULL duplex) 

 Port link down Port <portNum> link down Informational  

Console Successful login 
through Console 

Successful login through 
Console (Username: 
<username>) 

Informational

If the user logs in through the 
console, no IP or MAC 
address information will be 
included in the log. 

 Login failed 
through Console  

Login failed through Console 
(Username: <username>) Warning 

If the user logs in through the 
console, no IP or MAC 
address information will be 
included in the log. 

 Logout through 
Console  

Logout through Console 
(Username: <username>) Informational

If the user logs in through the 
console, no IP or MAC 
address information will be 
included in the log. 

 Console session 
timed out  

Console session timed out 
(Username: <username>) Informational

If the user logs in through the 
console, no IP or MAC 
address information will be 
included in the log. 

Web Successful login 
through Web  

Successful login through Web 
(Username: <username>, IP: 

Informational  
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Category  Event 
Description Log Content Severity Remark 

<ipaddr>, MAC: <macaddr>) 

 Login failed 
through Web  

Login failed through Web 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning  

 Logout through 
Web 

Logout through Web 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

 Successful login 
through SSL 

Successful login through Web 
(SSL) (Username: <string>, IP: 
<ip>, MAC: <mac>) 

Informational  

 Logout through 
SSL 

Logout through Web (SSL) 
(Username: <string>, IP: <ip>, 
MAC: <mac>) 

Informational  

 Login failed 
through SSL  

Login failed through Web 
(SSL) (Username: <string>, IP: 
<ip>, MAC: <mac>) 

Warning  

Telnet Successful login 
through Telnet 

Successful login through 
Telnet (Username: 
<username>, IP: <ipaddr>, 
MAC: <macaddr>) 

Informational  

 Login failed 
through Telnet  

Login failed through Telnet 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning  

 Logout through 
Telnet  

Logout through Telnet 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

 Telnet session 
timed out  

Telnet session timed out 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

SNMP 
SNMP request 
received with 
invalid 
community string 

SNMP request received from 
<ipAddress> with invalid 
community string! 

Informational  

STP Topology 
changed  Topology changed Informational  

 New Root 
selected  New Root selected Informational  

 BPDU Loop Back 
on port 

BPDU Loop Back on Port 
<portNum> Warning  

 
Spanning Tree 
Protocol is 
enabled  

Spanning Tree Protocol is 
enabled Informational  

 
Spanning Tree 
Protocol is 
disabled 

Spanning Tree Protocol is 
disabled Informational  

SSH Successful login 
through SSH  

Successful login through SSH 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  
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Category  Event 
Description Log Content Severity Remark 

 Login failed 
through SSH  

Login failed through SSH 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Warning  

 Logout through 
SSH  

Logout through SSH 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

 SSH session 
timed out  

SSH session timed out 
(Username: <username>, IP: 
<ipaddr>, MAC: <macaddr>) 

Informational  

 Enable SSH 
server SSH server is enabled Informational  

 Disable SSH 
server SSH server is disabled Informational  

AAA Authentication 
Policy is enabled 

Authentication Policy is 
enabled (Module: AAA) Informational  

 Authentication 
Policy is disabled 

Authentication Policy is 
disabled (Module: AAA) Informational  

 

Successful login 
through Console 
authenticated by 
AAA local 
method 

Successful login through 
Console authenticated by 
AAA local method (Username: 
<username>) 

Informational  

 

Login failed 
through Console 
authenticated by 
AAA local 
method 

Login failed through Console 
authenticated by AAA local 
method (Username: 
<username>) 

Warning  

 

Successful login 
through Web 
authenticated by 
AAA local 
method 

Successful login through Web 
from <userIP> authenticated 
by AAA local method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Login failed 
through Web 
authenticated by 
AAA local 
method 

Login failed through Web 
from <userIP> authenticated 
by AAA local method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful login 
through Web 
(SSL) 
authenticated by 
AAA local 
method 

Successful login through Web 
(SSL) from <userIP> 
authenticated by AAA local 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Login failed 
through Web 
(SSL) 
authenticated by 
AAA local 
method 

Login failed through Web 
(SSL) from <userIP> 
authenticated by AAA local 
method (Username: 
<username>, MAC: 
<macaddr>) 

Warning  
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Category  Event 
Description Log Content Severity Remark 

 

Successful login 
through Telnet 
authenticated by 
AAA local 
method 

Successful login through 
Telnet from <userIP> 
authenticated by AAA local 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Login failed 
through Telnet 
authenticated by 
AAA local 
method 

Login failed through Telnet 
from <userIP> authenticated 
by AAA local method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful login 
through SSH 
authenticated by 
AAA local 
method 

Successful login through SSH 
from <userIP> authenticated 
by AAA local method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Login failed 
through SSH 
authenticated by 
AAA local 
method 

Login failed through SSH from 
<userIP> authenticated by 
AAA local method (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Successful login 
through Console 
authenticated by 
AAA none 
method 

Successful login through 
Console authenticated by 
AAA none method (Username: 
<username>) 

Informational  

 

Successful login 
through Web 
authenticated by 
AAA none 
method 

Successful login through Web 
from <userIP> authenticated 
by AAA none method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Successful login 
through Web 
(SSL) 
authenticated by 
AAA none 
method 

Successful login through Web 
(SSL) from <userIP> 
authenticated by AAA none 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful login 
through Telnet 
authenticated by 
AAA none 
method 

Successful login through 
Telnet from <userIP> 
authenticated by AAA none 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful login 
through SSH 
authenticated by 
AAA none 
method 

Successful login through SSH 
from <userIP> authenticated 
by AAA none method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 
Successful login 
through Console 
authenticated by 
AAA server 

Successful login through 
Console authenticated by 
AAA server <serverIP> 
(Username: <username>) 

Informational

If the user logs in through the 
console, no IP or MAC 
address information will be 
included in the log. 
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Category  Event 
Description Log Content Severity Remark 

 
Login failed 
through Console 
authenticated by 
AAA server 

Login failed through Console 
authenticated by AAA server 
<serverIP> (Username: 
<username>) 

Warning There are no IP and MAC if 
login by console. 

 

Login failed 
through Console 
due to AAA 
server timeout or 
improper 
configuration 

Login failed through Console 
due to AAA server timeout or 
improper configuration 
(Username: <username>) 

Warning  

 
Successful login 
through Web 
authenticated by 
AAA server 

Successful login through Web 
from <userIP> authenticated 
by AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 
Login failed 
through Web 
authenticated by 
AAA server 

Login failed through Web 
from <userIP> authenticated 
by AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Login failed 
through Web due 
to AAA server 
timeout or 
improper 
configuration 

Login failed through Web 
from <userIP> due to AAA 
server timeout or improper 
configuration (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Successful login 
through Web 
(SSL) 
authenticated by 
AAA server 

Successful login through Web 
(SSL) from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Login failed 
through Web 
(SSL) 
authenticated by 
AAA server 

Login failed through Web 
(SSL) from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Login failed 
through Web 
(SSL) due to 
AAA server 
timeout or 
improper 
configuration 

Login failed through 
Web(SSL) from <userIP> due 
to AAA server timeout or 
improper configuration 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 
Successful login 
through Telnet 
authenticated by 
AAA server 

Successful login through 
Telnet from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 
Login failed 
through Telnet 
authenticated by 

Login failed through Telnet 
from <userIP> authenticated 
by AAA server <serverIP> 

Warning  
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Category  Event 
Description Log Content Severity Remark 

AAA server (Username: <username>, 
MAC: <macaddr>) 

 

Login failed 
through Telnet 
due to AAA 
server timeout or 
improper 
configuration 

Login failed through Telnet 
from <userIP> due to AAA 
server timeout or improper 
configuration (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 
Successful login 
through SSH 
authenticated by 
AAA server 

Successful login through SSH 
from <userIP> authenticated 
by AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 
Login failed 
through SSH 
authenticated by 
AAA server 

Login failed through SSH from 
<userIP> authenticated by 
AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Login failed 
through SSH due 
to AAA server 
timeout or 
improper 
configuration 

Login failed through SSH from 
<userIP> due to AAA server 
timeout or improper 
configuration (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Successful Enable 
Admin through 
Console 
authenticated by 
AAA 
local_enable 
method 

Successful Enable Admin 
through Console 
authenticated by AAA 
local_enable method 
(Username: <username>) 

Informational  

 

Enable Admin 
failed through 
Console 
authenticated by 
AAA 
local_enable 
method 

Enable Admin failed through 
Console authenticated by 
AAA local_enable method 
(Username: <username>) 

Warning  

 

Successful Enable 
Admin through 
Web 
authenticated by 
AAA 
local_enable 
method 

Successful Enable Admin 
through Web from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Enable Admin 
failed through 
Web 
authenticated by 
AAA 
local_enable 
method 

Enable Admin failed through 
Web from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  
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Category  Event 
Description Log Content Severity Remark 

 

Successful Enable 
Admin through 
Web (SSL) 
authenticated by 
AAA 
local_enable 
method 

Successful Enable Admin 
through Web (SSL) from 
<userIP> authenticated by 
AAA local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Enable Admin 
failed through 
Web (SSL) 
authenticated by 
AAA 
local_enable 
method 

Enable Admin failed through 
Web (SSL) from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
Telnet 
authenticated by 
AAA 
local_enable 
method 

Successful Enable Admin 
through Telnet from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Enable Admin 
failed through 
Telnet 
authenticated by 
AAA 
local_enable 
method 

Enable Admin failed through 
Telnet from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
SSH 
authenticated by 
AAA 
local_enable 
method 

Successful Enable Admin 
through SSH from <userIP> 
authenticated by AAA 
local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Enable Admin 
failed through 
SSH 
authenticated by 
AAA 
local_enable 
method 

Enable Admin failed through 
<Telnet or Web or SSH> from 
<userIP> authenticated by 
AAA local_enable method 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
Console 
authenticated by 
AAA none 
method 

Successful Enable Admin 
through Console 
authenticated by AAA none 
method (Username: 
<username>) 

Informational  

 

Successful Enable 
Admin through 
Web 
authenticated by 
AAA none 
method 

Successful Enable Admin 
through Web from <userIP> 
authenticated by AAA none 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  
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Category  Event 
Description Log Content Severity Remark 

 

Successful Enable 
Admin through 
Web (SSL) 
authenticated by 
AAA none 
method 

Successful Enable Admin 
through Web (SSL) from 
<userIP> authenticated by 
AAA none method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful Enable 
Admin through 
Telnet 
authenticated by 
AAA none 
method 

Successful Enable Admin 
through Telnet from <userIP> 
authenticated by AAA none 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful Enable 
Admin through 
SSH 
authenticated by 
AAA none 
method 

Successful Enable Admin 
through SSH from <userIP> 
authenticated by AAA none 
method (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Successful Enable 
Admin through 
Console 
authenticated by 
AAA server 

Successful Enable Admin 
through Console 
authenticated by AAA server 
<serverIP> (Username: 
<username>) 

Informational  

 

Enable Admin 
failed through 
Console 
authenticated by 
AAA server 

Enable Admin failed through 
Console authenticated by 
AAA server <serverIP> 
(Username: <username>) 

Warning  

 

Enable Admin 
failed through 
Console due to 
AAA server 
timeout or 
improper 
configuration 

Enable Admin failed through 
Console due to AAA server 
timeout or improper 
configuration (Username: 
<username>) 

Warning  

 

Successful Enable 
Admin through 
Web 
authenticated by 
AAA server 

Successful Enable Admin 
through Web from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Enable Admin 
failed through 
Web 
authenticated by 
AAA server 

Enable Admin failed through 
Web from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Enable Admin 
failed through 
Web due to AAA 
server timeout or 
improper 
configuration 

Enable Admin failed through 
Web from <userIP> due to 
AAA server timeout or 
improper configuration 
(Username: <username>, 
MAC: <macaddr>) 

Warning  
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Category  Event 
Description Log Content Severity Remark 

 

Successful Enable 
Admin through 
Web (SSL) 
authenticated by 
AAA server 

Successful Enable Admin 
through Web (SSL) from 
<userIP> authenticated by 
AAA server <serverIP> 
(Username: <username>, 
MAC: <macaddr>) 

Informational  

 

Enable Admin 
failed through 
Web (SSL) 
authenticated by 
AAA server 

Enable Admin failed through 
Web (SSL) from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Enable Admin 
failed through 
Web (SSL) due to 
AAA server 
timeout or 
improper 
configuration 

Enable Admin failed through 
Web (SSL) from <userIP> due 
to AAA server timeout or 
improper configuration 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
Telnet 
authenticated by 
AAA server 

Successful Enable Admin 
through Telnet from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Enable Admin 
failed through 
Telnet 
authenticated by 
AAA server 

Enable Admin failed through 
Telnet from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Enable Admin 
failed through 
Telnet due to 
AAA server 
timeout or 
improper 
configuration 

Enable Admin failed through 
Telnet from <userIP> due to 
AAA server timeout or 
improper configuration 
(Username: <username>, 
MAC: <macaddr>) 

Warning  

 

Successful Enable 
Admin through 
SSH 
authenticated by 
AAA server 

Successful Enable Admin 
through SSH from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Informational  

 

Enable Admin 
failed through 
SSH 
authenticated by 
AAA server 

Enable Admin failed through 
SSH from <userIP> 
authenticated by AAA server 
<serverIP> (Username: 
<username>, MAC: 
<macaddr>) 

Warning  

 

Enable Admin 
failed through 
SSH due to AAA 
server timeout or 
improper 

Enable Admin failed through 
SSH from <userIP> due to 
AAA server timeout or 
improper configuration 
(Username: <username>, 

Warning  
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Category  Event 
Description Log Content Severity Remark 

configuration MAC: <macaddr>) 

 AAA server 
timed out 

AAA server <serverIP> 
(Protocol: <protocol>) 
connection failed 

Warning 
<protocol> is one of 
TACACS, XTACACS, 
TACACS+ or RADIUS 

Port 
Security 

port security has 
reached its 
maximum 
learning size and 
will not learn any 
new addresses 

Port security violation (Port: 
<portNum>, MAC: <macaddr>) Warning  

IP-MAC-
PORT 
Binding 

Unauthenticated 
IP address 
discarded by IP 
mac port binding 

Unauthenticated IP-MAC 
address and discarded by ip 
mac port binding (IP: 
<ipaddr>, MAC: <macaddr>, 
Port <portNum>) 

Warning  

Safeguard 
Engine 

Safeguard Engine 
is in normal mode

SafeGuard Engine enters 
NORMAL mode Informational  

 
Safeguard Engine 
is in filtering 
packet mode 

Safeguard Engine enters 
EXHAUSTED mode Warning  

Packet 
Storm 

Broadcast storm 
occurence 

Broadcast storm is occurring 
(port: <id>) Warning  

 Broadcast storm 
has cleared 

Broadcast storm has cleared 
(port: <id>) Informational  

 Multicast storm 
occurence 

Multicast storm is occurring 
(port: <id>) Warning  

 Multicast storm 
has cleared 

Multicast storm has cleared 
(port: <id>) Informational  

Security 

Packet received 
containing a 
MAC address 
identical to the 
MAC address of 
the device’s 
interface 

Possible spoofing attack from 
<mac> port <u16> Critical  
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Appendix D 
Cable Lengths 
Use the following table to as a guide for the maximum cable lengths. 

Standard Media Type Maximum Distance 

Mini-GBIC 1000BASE-LX, Single-mode fiber module 
1000BASE-SX, Multi-mode fiber module 
1000BASE-LHX, Single-mode fiber module 
1000BASE-ZX, Single-mode fiber module 

10km 
550m 
40km 
80km 

1000BASE-T Category 5e UTP Cable 
Category 5 UTP Cable (1000 Mbps) 

100m 

100BASE-TX Category 5 UTP Cable (100 Mbps) 100m 

10BASE-T Category 3 UTP Cable (10 Mbps) 100m 
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Appendix E 
 
      

Mitigating ARP Spoofing Attacks Using Packet 
Content ACL 
Address Resolution Protocol (ARP) is the standard method for finding a host's hardware address (MAC address) 
when only its IP address is known. This protocol is vulnerable because it can spoof the IP and MAC information in the 
ARP packets to attack a LAN (known as ARP spoofing). This document is intended to introduce ARP protocol, ARP 
spoofing attacks, and the counter measure brought by D-Link's switches to counter the ARP spoofing attack. 
  

• How Address Resolution Protocol works 

In the process of ARP, PC A will, firstly, issue an ARP request to query PC B’s MAC address. The network structure is 
shown in Figure-1. 
 

 
Figure-1 

 
In the mean time, PC A’s MAC address will be written into the “Sender H/W Address” and its IP address will be written 
into the “Sender Protocol Address” in ARP payload. As PC B’s MAC address is unknown, the “Target H/W Address” 
will be “00-00-00-00-00-00” while PC B’s IP address will be written into the “Target Protocol Address”, shown in Table-
1.  

H/W 
type 

Protocol 
type 

H/W 
address 
length 

Protocol 
address 
length 

Operation Sender  
H/W address 

Sender 
protocol 
address 
 

Target  
H/W address 
 

Target 
protocol 
address 
 

    ARP 
request 00-20-5C-01-11-11 10.10.10.1 00-00-00-00-00-00 10.10.10.2

Table -1 (ARP Payload) 

 
The ARP request will be encapsulated into Ethernet frame and sent out. As can be seen in Table-2, the “Source 
Address” in the Ethernet frame will be PC A’s MAC address. Since an ARP request is sent via a broadcast, the 
“Destination address” is in the format of an Ethernet broadcast (FF-FF-FF-FF-FF-FF).  
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Destination 
address 

Source address 
 

Ether-type ARP FCS 

FF-FF-FF-FF-FF-FF 00-20-5C-01-11-11    

Table-2 (Ethernet frame format) 

 
When the switch receives the frame, it will check the “Source Address” in the Ethernet frame’s header. If the address 
is not in its Forwarding Table, the switch will learn PC A’s MAC and the associated port into its Forwarding Table. 
 
 

 
Port1   00-20-5C-01-11-11 

 
In addition, when the switch receives the broadcast ARP request, it will flood the frame to all ports except the source 
port, port 1 (see Figure -2). 

 
Figure - 2 

When the switch floods the frame of ARP requests to the network, all PCs will receive and examine the frame but only 
PC B will reply to the query as the destination IP address of PC B matches (see Figure-3). 
 

 
Figure-3 

Forwarding Table 
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When PC B replies to the ARP request, its MAC address will be written into “Target H/W Address” in the ARP payload 
shown in Table-3. The ARP reply will be then encapsulated into the Ethernet frame again and sent back to the sender. 
The ARP reply is in a form of Unicast communication. 

H/W 
type 

Protocol 
type 

H/W 
address 
length 

Protocol 
address 
length 

Operation
 
 

Sender  
H/W address 
 

Sender 
protocol 
address 

Target  
H/W address 

Target 
protocol 
address 

    
ARP reply 00-20-5C-01-11-11 10.10.10.1 00-20-5C-01-22-22 10.10.10.2

Table – 3 (ARP Payload) 

 
When PC B replies the query, the “Destination Address” in the Ethernet frame will be changed to PC A’s MAC address. 
The “Source Address” will be changed to PC B’s MAC address (see Table-4).  

Destination address Source address 
 

Ether-type ARP FCS 

00-20-5C-01-11-11 00-20-5C-01-22-22    

Table – 4 (Ethernet frame format) 

 
The switch will also examine the “Source Address” of the Ethernet frame and find that the address is not in the 
Forwarding Table. The switch will learn PC B’s MAC and update its Forwarding Table. 

 

Port1   00-20-5C-01-11-11 
Port2   00-20-5C-01-22-22 
 

Forwarding Table 
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How ARP spoofing attacks a network 

ARP spoofing, also known as ARP poisoning, is a method to attack an Ethernet network which may allow an attacker 
to sniff data frames on a LAN, modify the traffic, or stop the traffic altogether (known as a Denial of Service - DoS 
attack). The principle of ARP spoofing is to send the fake, or spoofed ARP messages to an Ethernet network. 
Generally, the aim is to associate the attacker's or random MAC address with the IP address of another node (such as 
the default gateway). Any traffic meant for that IP address would be mistakenly re-directed to the node specified by 
the attacker.  
 
IP spoofing attack is caused by Gratuitous ARP that occurs when a host sends an ARP request to resolve its own IP 
address. Figure-4 shows a hacker within a LAN to initiate ARP spoofing attack.  
 

 

Figure-4 

In the Gratuitous ARP packet, the “Sender protocol address” and “Target protocol address” are filled with the same 
source IP address. The “Sender H/W Address” and “Target H/W address” are filled with the same source MAC 
address. The destination MAC address is the Ethernet broadcast address (FF-FF-FF-FF-FF-FF). All nodes within the 
network will immediately update their own ARP table in accordance with the sender’s MAC and IP address. The 
format of Gratuitous ARP is shown in Table-5.  
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Destination 
address 

Source 
address 

Ethernet 
type 

H/W type Protocol 
type 

H/W 
address 
length

Protocol 
address 
length

Operation Sender H/W 
address 

Sender 
protocol 
address 

Target H/W 
address 

Target 
protocol 
address

(6-byte) (6-byte) (2-byte) (2-byte) (2-byte) (1-byte) (1-byte) (2-byte) (6-byte) (4-byte) (6-byte) (4-byte)

FF-FF-FF-FF-FF-FF 00-20-5C-01-11-11 806     ARP reply 00-20-5C-01-11-11 10.10.10.254 00-20-5C-01-11-11 10.10.10.254

Table-5 

A common DoS attack today can be done by associating a nonexistent or specified MAC address to the IP address of 
the network’s default gateway. The malicious attacker only needs to broadcast ONE Gratuitous ARP to the network 
claiming it is the gateway so that the whole network operation will be turned down as all packets to the Internet will be 
directed to the wrong node.  
 
Likewise, the attacker can either choose to forward the traffic to the actual default gateway (passive sniffing) or modify 
the data before forwarding it (man-in-the-middle attack). The hacker cheats the victim’s PC to think that it is a router 
and cheats the router to think it is the victim. As can be seen in Figure-5 all traffic will be then sniffed by the hacker but 
the users will not notice anything happening.  
 

 

Figure-5 

 

Gratuitous ARP 
Ethernet Header 
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• Prevent ARP spoofing via packet content ACL 

Concerning the common DoS attack today caused by the ARP spoofing, D-Link managed switch can effectively 
mitigate it via its unique Packet Content ACL. 
For that reason the basic ACL can only filter ARP packets based on packet type, VLAN ID, Source and Destination 
MAC information, there is a need for further inspections of ARP packets. To prevent ARP spoofing attack, we will 
demonstrate here using Packet Content ACL on DES-3526 to block the invalid ARP packets which contain fake 
gateway’s MAC and IP binding. 
 

 

 
 

Example topology 
Configuration: 

The configuration logic is listed below: 
1. Only when the ARP matches the Source MAC address in Ethernet, the Sender MAC address and Sender IP 

address in the ARP protocol can pass through the switch. (In this example, it is the gateway’s ARP.) 
2. The switch will deny all other ARP packets which claim they are from the gateway’s IP. 
 
The design of Packet Content ACL on DES-3500 series enables users to inspect any offset_chunk. An offset_chunk is 
a 4-byte block in a HEX format which is utilized to match the individual field in an Ethernet frame. Each profile is 
allowed to contain up to a maximum of 4 offset_chunks. Furthermore, only one single profile of Packet Content ACL 
can be supported per switch. In other words, up to 16 bytes of total offset_chunks can be applied to each profile and a 
switch. Therefore, careful consideration is needed for planning the configuration of the valuable offset_chunks. 
 
In Table-6, you will notice that the Offset_Chunk0 starts from 127 and ends at the 128th byte. It can also be found that 
the offset_chunk is scratched from 1 but not zero!!! 
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Offset 
Chunk 

Offset 
Chunk0 

Offset 
Chunk1 

Offset 
Chunk2 

Offset 
Chunk3

Offset 
Chunk4 

Offset 
Chunk5 

Offset 
Chunk6

Offset 
Chunk7

Offset 
Chunk8

Offset 
Chunk9

Offset 
Chunk10

Offset 
Chunk11 

Offset 
Chunk12 

Offset 
Chunk13

Offset 
Chunk14

Offset 
Chunk15

Byte 127 3 7 11 15 19 23 27 31 35 39 43 47 51 55 59 

Byte 128 4 8 12 16 20 24 28 32 36 40 44 48 52 56 60 

Byte 1 5 9 13 17 21 25 29 33 37 41 45 49 53 57 61 

Byte 2 6 10 14 18 22 26 30 34 38 42 46 50 54 58 62 

 
Offset 
Chunk 

Offset 
Chunk15 

Offset 
Chunk16 

Offset 
Chunk17 

Offset 
Chunk18 

Offset 
Chunk19 

Offset 
Chunk20

Offset 
Chunk21

Offset 
Chunk22

Offset 
Chunk23

Offset 
Chunk24

Offset 
Chunk25

Offset 
Chunk26 

Offset 
Chunk27 

Offset 
Chunk28

Offset 
Chunk129

Offset 
Chunk30

Byte 63 67 71 75 79 83 87 91 95 99 103 107 111 115 119 123

Byte 64 68 72 76 80 84 88 92 96 100 104 108 112 116 120 124

Byte 65 69 73 77 81 85 89 93 97 101 105 109 113 117 121 125

Byte 66 70 74 78 82 86 90 94 98 102 106 110 114 118 122 126

Table-6: Chunk and Packet offset Indicates a completed ARP packet contained in the Ethernet frame, which is the 
pattern for the calculation of packet offset.  
 
 
 
 
Destination 
address 

Source address Ethernet 
type 

H/W type Protocol 
type 

H/W 
address 
length 

Protocol 
address 
length 

Operation Sender 
H/W 
address

Sender protocol 
address 

Target 
H/W 
address

Target 
protocol 
address

(6-byte) (6-byte) (2-byte) (2-byte) (2-byte) (1-byte) (1-byte) (2-byte) (6-byte) (4-byte) (6-byte) (4-byte) 

 01 02 03 04 05 06 0806       0a5a5a5a   

         (10.90.90.90)   

Table-7: A completed ARP packet contained in Ethernet frame 
 

Ethernet Header ARP 
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Glossary 
1000BASE-LX: A short laser wavelength on multimode fiber optic cable for a maximum length of 550 meters 
1000BASE-SX: A long wavelength for a "long haul" fiber optic cable for a maximum length of 10 kilometers 
100BASE-FX: 100Mbps Ethernet implementation over fiber. 
100BASE-TX: 100Mbps Ethernet implementation over Category 5 and Type 1 Twisted Pair cabling. 
10BASE-T: The IEEE 802.3 specification for Ethernet over Unshielded Twisted Pair (UTP) cabling. 
aging: The automatic removal of dynamic entries from the Switch Database which have timed-out and are no longer valid. 
ATM: Asynchronous Transfer Mode. A connection oriented transmission protocol based on fixed length cells (packets). ATM is 
designed to carry a complete range of user traffic, including voice, data and video signals. 
auto-negotiation: A feature on a port, which allows it to advertise its capabilities for speed, duplex and flow control. When 
connected to an end station that also supports auto-negotiation, the link can self-detect its optimum operating setup.  
backbone port: A port which does not learn device addresses, and which receives all frames with an unknown address. Backbone 
ports are normally used to connect the Switch to the backbone of your network. Note that backbone ports were formerly known as 
designated downlink ports. 
backbone: The part of a network used as the primary path for transporting traffic between network segments. 
bandwidth: Information capacity, measured in bits per second that a channel can transmit. The bandwidth of Ethernet is 10Mbps, 
the bandwidth of Fast Ethernet is 100Mbps. 
baud rate: The switching speed of a line. Also known as line speed between network segments. 
BOOTP: The BOOTP protocol allows you to automatically map an IP address to a given MAC address each time a device is 
started. In addition, the protocol can assign the subnet mask and default gateway to a device. 
bridge: A device that interconnects local or remote networks no matter what higher-level protocols are involved. Bridges form a 
single logical network, centralizing network administration. 
broadcast: A message sent to all destination devices on the network. 
broadcast storm: Multiple simultaneous broadcasts that typically absorb available network bandwidth and can cause network 
failure. 
console port: The port on the Switch accepting a terminal or modem connector. It changes the parallel arrangement of data within 
computers to the serial form used on data transmission links. This port is most often used for dedicated local management. 
CSMA/CD: Channel access method used by Ethernet and IEEE 802.3 standards in which devices transmit only after finding the 
data channel clear for some period of time. When two devices transmit simultaneously, a collision occurs and the colliding 
devices delay their retransmissions for a random amount of time. 
data center switching: The point of aggregation within a corporate network where a switch provides high-performance access to 
server farms, a high-speed backbone connection and a control point for network management and security. 
Ethernet: A LAN specification developed jointly by Xerox, Intel and Digital Equipment Corporation. Ethernet networks operate 
at 10Mbps using CSMA/CD to run over cabling. 
Fast Ethernet: 100Mbps technology based on the Ethernet/CD network access method. 
Flow Control: (IEEE 802.3z) A means of holding packets back at the transmit port of the connected end station. Prevents packet 
loss at a congested switch port. 
forwarding: The process of sending a packet toward its destination by an internetworking device. 
full duplex: A system that allows packets to be transmitted and received at the same time and, in effect, doubles the potential 
throughput of a link. 
half duplex: A system that allows packets to be transmitted and received, but not at the same time. Contrast with full duplex. 
IP address: Internet Protocol address. A unique identifier for a device attached to a network using TCP/IP. The address is written 
as four octets separated with full-stops (periods), and is made up of a network section, an optional subnet section and a host 
section. 
IPX: Internetwork Packet Exchange. A protocol allowing communication in a NetWare network. 
LAN - Local Area Network: A network of connected computing resources (such as PCs, printers, servers) covering a relatively 
small geographic area (usually not larger than a floor or building). Characterized by high data rates and low error rates. 
latency: The delay between the time a device receives a packet and the time the packet is forwarded out of the destination port. 
line speed: See baud rate. 
main port: The port in a resilient link that carries data traffic in normal operating conditions. 
MDI - Medium Dependent Interface: An Ethernet port connection where the transmitter of one device is connected to the 
receiver of another device. 
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MDI-X - Medium Dependent Interface Cross-over: An Ethernet port connection where the internal transmit and receive lines 
are crossed. 
MIB - Management Information Base: Stores a device's management characteristics and parameters. MIBs are used by the 
Simple Network Management Protocol (SNMP) to contain attributes of their managed systems. The Switch contains its own 
internal MIB.  
multicast: Single packets copied to a specific subset of network addresses. These addresses are specified in the destination-
address field of the packet. 
protocol: A set of rules for communication between devices on a network. The rules dictate format, timing, sequencing and error 
control. 
resilient link: A pair of ports that can be configured so that one will take over data transmission should the other fail. See also 
main port and standby port. 
RJ-45: Standard 8-wire connectors for IEEE 802.3 10BASE-T networks. 
RMON: Remote Monitoring. A subset of SNMP MIB II that allows monitoring and management capabilities by addressing up to 
ten different groups of information. 
RPS - Redundant Power System: A device that provides a backup source of power when connected to the Switch. 
server farm: A cluster of servers in a centralized location serving a large user population. 
SLIP - Serial Line Internet Protocol: A protocol, which allows IP to run over a serial line connection. 
SNMP - Simple Network Management Protocol: A protocol originally designed to be used in managing TCP/IP internets. 
SNMP is presently implemented on a wide range of computers and networking equipment and may be used to manage many 
aspects of network and end station operation. 
Spanning Tree Protocol (STP): A bridge-based system for providing fault tolerance on networks. STP works by allowing you to 
implement parallel paths for network traffic, and ensure that redundant paths are disabled when the main paths are operational and 
enabled if the main paths fail. 
stack: A group of network devices that are integrated to form a single logical device. 
standby port: The port in a resilient link that will take over data transmission if the main port in the link fails. 
switch: A device, which filters, forwards and floods packets based on the packet's destination address. The switch learns the 
addresses associated with each switch port and builds tables based on this information to be used for the switching decision. 
TCP/IP: A layered set of communications protocols providing Telnet terminal emulation, FTP file transfer, and other services for 
communication among a wide range of computer equipment. 
telnet: A TCP/IP application protocol that provides virtual terminal service, letting a user log in to another computer system and 
access a host as if the user were connected directly to the host. 
TFTP - Trivial File Transfer Protocol: Allows you to transfer files (such as software upgrades) from a remote device using your 
switch's local management capabilities. 
UDP - User Datagram Protocol: An Internet standard protocol that allows an application program on one device to send a 
datagram to an application program on another device. 
VLAN - Virtual LAN: A group of location- and topology-independent devices that communicate as if they are on a common 
physical LAN. 
VLT - Virtual LAN Trunk: A Switch-to-Switch link which carries traffic for all the VLANs on each Switch. 
VT100: A type of terminal that uses ASCII characters. VT100 screens have a text-based appearance. 
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FCC Warning 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with this manual, may cause harmful interference to radio communications.  Operation 
of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense. 
CE Mark Warning 

This is a Class A product. In a domestic environment, this product may cause radio interference in which case the user may be required to take adequate measures. 

Warnung! 

Dies ist ein Produkt der Klasse A. Im Wohnbereich kann dieses Produkt Funkstoerungen verursachen. In diesem Fall kann vom Benutzer verlangt werden, 
angemessene Massnahmen zu ergreifen. 

Precaución! 

Este es un producto de Clase A. En un entorno doméstico, puede causar interferencias de radio, en cuyo case, puede requerirse al usuario para que adopte las 
medidas adecuadas. 

Attention! 

Ceci est un produit de classe A. Dans un environnement domestique, ce produit pourrait causer des interférences radio, auquel cas l`utilisateur devrait prendre les 
mesures adéquates. 

Attenzione! 
Il presente prodotto appartiene alla classe A. Se utilizzato in ambiente domestico il prodotto può causare interferenze radio, nel cui caso è possibile che l`utente 
debba assumere provvedimenti adeguati. 
BSMI Warning 
 
 
 
 



 

 
 
 
Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this lifetime product warranty for hardware:  
 
• Only for products purchased, delivered and used within the fifty states of the United States, the District of Columbia, U.S. Possessions or 

Protectorates, U.S. Military Installations, or addresses with an APO or FPO, and; 
• Only with proof of purchase. 
  
Product Warranty:  D-Link warrants that the hardware portion of the D-Link product, including internal and external power supplies and fans (“Hardware”), 
will be free from material defects in workmanship and materials under normal use from the date of original retail purchase of the product (“Warranty 
Period”), except as otherwise stated herein.    
The customer's sole and exclusive remedy and the entire liability of D-Link and its suppliers under this Warranty will be, at D-Link’s option, to repair or 
replace the defective Hardware during the Warranty Period at no charge to the owner or to refund the actual purchase price paid.  Any repair or 
replacement will be rendered by D-Link at an Authorized D-Link Service Office.  The replacement hardware need not be new or have an identical make, 
model or part.  D-Link may, at its option, replace the defective Hardware or any part thereof with any reconditioned product that D-Link reasonably 
determines is substantially equivalent (or superior) in all material respects to the defective Hardware.  Repaired or replacement hardware will be 
warranted for the remainder of the original Warranty Period or ninety (90) days, whichever is longer, and is subject to the same limitations and exclusions.  
If a material defect is incapable of correction, or if D-Link determines that it is not practical to repair or replace the defective Hardware, the actual price 
paid by the original purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective Hardware.  All Hardware or part 
thereof that is replaced by D-Link, or for which the purchase price is refunded, shall become the property of D-Link upon replacement or refund. 
 
Software Warranty:  D-Link warrants that the software portion of the product (“Software”) will substantially conform to D-Link’s then current functional 
specifications for the Software, as set forth in the applicable documentation, from the date of original retail purchase of the Software for a period of ninety 
(90) days (“Software Warranty Period”), provided that the Software is properly installed on approved hardware and operated as contemplated in its 
documentation. D-Link further warrants that, during the Software Warranty Period, the magnetic media on which D-Link delivers the Software will be free 
of physical defects.  The customer's sole and exclusive remedy and the entire liability of D-Link and its suppliers under this Limited Warranty will be, at D-
Link’s option, to replace the non-conforming Software (or defective media) with software that substantially conforms to D-Link’s functional specifications 
for the Software or to refund the portion of the actual purchase price paid that is attributable to the Software.  Except as otherwise agreed by D-Link in 
writing, the replacement Software is provided only to the original licensee, and is subject to the terms and conditions of the license granted by D-Link for 
the Software.  Replacement Software will be warranted for the remainder of the original Warranty Period and is subject to the same limitations and 
exclusions.  If a material non-conformance is incapable of correction, or if D-Link determines in its sole discretion that it is not practical to replace the non-
conforming Software, the price paid by the original licensee for the non-conforming Software will be refunded by D-Link; provided that the non-conforming 
Software (and all copies thereof) is first returned to D-Link.  The license granted respecting any Software for which a refund is given automatically 
terminates.   
Non-Applicability of Warranty:  The Warranty provided hereunder for D-Link's products will not be applied to and does not cover any products obtained 
through a special or unique pricing agreement, if such agreement provides for warranty terms different from those normally provided with the product or 
set forth herein, nor to any refurbished product and any product purchased through the inventory clearance or liquidation sale or other sales in which D-
Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case, the product is being sold "As-Is" 
without any warranty whatsoever including, without limitation, the Warranty as described herein, notwithstanding anything stated herein to the contrary.   
 
Submitting A Claim:  The customer shall return the product to the original purchase point based on its return policy.  In case the return policy period has 
expired and the product is within warranty, the customer shall submit a claim to D-Link as outlined below: 
   
• The customer must submit with the product as part of the claim a written description of the Hardware defect or Software nonconformance in sufficient 

detail to allow D-Link to confirm the same, along with proof of purchase of the product (such as a copy of the dated purchase invoice for the product). 

• The customer must obtain a Case ID Number from D-Link Technical Support by going to https://support.dlink.com, who will attempt to assist the 
customer in resolving any suspected defects with the product.  If the product is considered defective, the customer must obtain a Return Material 
Authorization (“RMA”) number by completing the RMA form and entering the assigned Case ID Number at https://rma.dlink.com/. 

• After an RMA number is issued, the defective product must be packaged securely in the original or other suitable shipping package to ensure that it 
will not be damaged in transit, and the RMA number must be prominently marked on the outside of the package.  Include any manuals or 
accessories in the shipping package.   

• The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery (“COD”) is allowed.  Products sent COD will either be 
rejected by D-Link or become the property of D-Link.  Products shall be fully insured by the customer and shipped to D-Link Systems, Inc., 17595 
Mt. Herrmann, Fountain Valley, CA 92708.  D-Link will not be held responsible for any packages that are lost in transit to D-Link.  The repaired or 
replaced packages will be shipped to the customer via UPS Ground or any common carrier selected by D-Link.  Return shipping charges shall be 
prepaid by D-Link if you use an address in the United States, otherwise we will ship the product to you freight collect. Expedited shipping is available 
upon request and provided shipping charges are prepaid by the customer.  

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing requirements, or for which an RMA 
number is not visible from the outside of the package. The product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any 
product that is not packaged and shipped in accordance with the foregoing requirements, or that is determined by D-Link not to be defective or non-
conforming.  
What Is Not Covered: The Warranty provided herein by D-Link does not cover: Products that, in D-Link’s judgment, have been subjected to abuse, 
accident, alteration, modification, tampering, negligence, misuse, faulty installation, lack of reasonable care, repair or service in any way that is not 
contemplated in the documentation for the product, or if the model or serial number has been altered, tampered with, defaced or removed; Initial 
installation, installation and removal of the product for repair, and shipping costs; Operational adjustments covered in the operating manual for the product, 
and normal maintenance; Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;  Any hardware, 
software, firmware or other products or services provided by anyone other than D-Link; and Products that have been purchased from inventory clearance 
or liquidation sales or other sales in which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the product.  
While necessary maintenance or repairs on your Product can be performed by any company, we recommend that you use only an Authorized D-Link 
Service Office. Improper or incorrectly performed maintenance or repair voids this Warranty.  
Disclaimer of Other Warranties: EXCEPT AS SPECIFICALLY SET FORTH ABOVE OR AS REQUIRED BY LAW, THE PRODUCT IS PROVIDED “AS-
IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY 
TERRITORY WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO NINETY (90) DAYS.  EXCEPT 
AS EXPRESSLY COVERED UNDER THE WARRANTY PROVIDED HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION AND 
PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF THE PRODUCT.  



 

 
 
Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER ANY CONTRACT, NEGLIGENCE, 
STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF 
ANY CHARACTER, WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS 
OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, FAILURE OF OTHER 
EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK’S PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATA 
CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING FROM 
THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY BREACH OF THIS  WARRANTY, EVEN IF D-LINK 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING WARRANTY IS 
REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.  THE MAXIMUM LIABILITY OF D-LINK UNDER 
THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT COVERED BY THE WARRANTY. THE FOREGOING EXPRESS 
WRITTEN WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED 
OR STATUTORY. 
 
Lifetime Warranty:  IF LOCAL LAW MANDATES THE USE OF A DEFINITION OF “LIFETIME WARRANTY” DIFFERENT FROM THAT PROVIDED 
HEREIN, THEN THE LOCAL LAW DEFINITION WILL SUPERSEDE AND TAKE PRECEDENCE, TO THE EXTENT NECESSARY TO COMPLY. 
  
Governing Law:  This Warranty shall be governed by the laws of the State of California. Some states do not allow exclusion or limitation of incidental or 
consequential damages, or limitations on how long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This Warranty 
provides specific legal rights and you may also have other rights which vary from state to state.   
 
Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered trademarks are the property of their respective 
owners.  
 
Copyright Statement:  No part of this publication or documentation accompanying this product may be reproduced in any form or by any means or used 
to make any derivative such as translation, transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as stipulated 
by the United States Copyright Act of 1976 and any amendments thereto.  Contents are subject to change without prior notice.  Copyright 2009 by D-Link 
Corporation/D-Link Systems, Inc. All rights reserved. 
 
CE Mark Warning:  This is a Class A product. In a residential environment, this product may cause radio interference, in which case the user may be 
required to take adequate measures. 
 
FCC Statement:  This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against harmful interference in a commercial installation. This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communication. However, there is no guarantee that interference will not occur in a particular installation. Operation of this equipment in a residential 
environment is likely to cause harmful interference to radio or television reception.  If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help. 
 
 
For detailed warranty information applicable to products purchased outside the United States, please contact the corresponding 
local D-Link office. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 
 
 
 
 
 

Product Registration 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Register your D-Link product online at http://support.dlink.com/register/ 
Product registration is entirely voluntary and failure to complete or return this form will 
not diminish your warranty rights. 



 

LIMITED WARRANTY  (Exclude USA, Europe, China and Taiwan) 
D-Link provides this limited warranty for its product only to the person or entity who originally 
purchased the product from D-Link or its authorized reseller or distributor. D-Link would fulfill the 
warranty obligation according to the local warranty policy in which you purchased our products. 
 
Limited Hardware Warranty: D-Link warrants that the hardware portion of the D-Link products 
described below (“Hardware”) will be free from material defects in workmanship and materials from the 
date of original retail purchase of the Hardware, for the period set forth below applicable to the product 
type (“Warranty Period”) if the Hardware is used and serviced in accordance with applicable 
documentation; provided that a completed Registration Card is returned to an Authorized D-Link 
Service Office within ninety (90) days after the date of original retail purchase of the Hardware. If a 
completed Registration Card is not received by an authorized D-Link Service Office within such ninety 
(90) period, then the Warranty Period shall be ninety (90) days from the date of purchase. 
 
Product Type Warranty Period 
Product (including Power Supplies and Fans) One (1) Year 
Spare parts and pare kits Ninety (90) days 
 
D-Link’s sole obligation shall be to repair or replace the defective Hardware at no charge to the original 
owner. Such repair or replacement will be rendered by D-Link at an Authorized D-Link Service Office. 
The replacement Hardware need not be new or of an identical make, model or part; D-Link may in its 
discretion replace the defective Hardware (or any part thereof) with any reconditioned product that D-
Link reasonably determines is substantially equivalent (or superior) in all material respects to the 
defective Hardware. The Warranty Period shall extend for an additional ninety (90) days after any 
repaired or replaced Hardware is delivered. If a material defect is incapable of correction, or if D-Link 
determines in its sole discretion that it is not practical to repair or replace the defective Hardware, the 
price paid by the original purchaser for the defective Hardware will be refunded by D-Link upon return 
to D-Link of the defective Hardware. All Hardware (or part thereof) that is replaced by D-Link, or for 
which the purchase price is refunded, shall become the property of D-Link upon replacement or refund. 
 
Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”) will 
substantially conform to D-Link’s then current functional specifications for the Software, as set forth in 
the applicable documentation, from the date of original delivery of the Software for a period of ninety 
(90) days (“Warranty Period”), if the Software is properly installed on approved hardware and operated 
as contemplated in its documentation. D-Link further warrants that, during the Warranty Period, the 
magnetic media on which D-Link delivers the Software will be free of physical defects. D-Link’s sole 
obligation shall be to replace the non-conforming Software (or defective media) with software that 
substantially conforms to D-Link’s functional specifications for the Software. Except as otherwise 
agreed by D-Link in writing, the replacement Software is provided only to the original licensee, and is 
subject to the terms and conditions of the license granted by D-Link for the Software. The Warranty 
Period shall extend for an additional ninety (90) days after any replacement Software is delivered. If a 
material non-conformance is incapable of correction, or if D-Link determines in its sole discretion that it 
is not practical to replace the non-conforming Software, the price paid by the original licensee for the 
non-conforming Software will be refunded by D-Link; provided that the non-conforming Software (and 
all copies thereof) is first returned to D-Link. The license granted respecting any Software for which a 
refund is given automatically terminates. 
 
What You Must Do For Warranty Service: 
 
Registration Card. The Registration Card provided at the back of this manual must be completed and 
returned to an Authorized D-Link Service Office for each D-Link product within ninety (90) days after 
the product is purchased and/or licensed. The addresses/telephone/fax list of the nearest Authorized D-



 

Link Service Office is provided in the back of this manual. FAILURE TO PROPERLY COMPLETE 
AND TIMELY RETURN THE REGISTRATION CARD MAY AFFECT THE WARRANTY FOR 
THIS PRODUCT. 
 
Submitting A Claim. Any claim under this limited warranty must be submitted in writing before the end 
of the Warranty Period to an Authorized D-Link Service Office. The claim must include a written 
description of the Hardware defect or Software nonconformance in sufficient detail to allow D-Link to 
confirm the same. The original product owner must obtain a Return Material Authorization (RMA) 
number from the Authorized D-Link Service Office and, if requested, provide written proof of purchase 
of the product (such as a copy of the dated purchase invoice for the product) before the warranty service 
is provided. After an RMA number is issued, the defective product must be packaged securely in the 
original or other suitable shipping package to ensure that it will not be damaged in transit, and the RMA 
number must be prominently marked on the outside of the package. The packaged product shall be 
insured and shipped to Authorized D-Link Service Office with all shipping costs prepaid. D-Link may 
reject or return any product that is not packaged and shipped in strict compliance with the foregoing 
requirements, or for which an RMA number is not visible from the outside of the package. The product 
owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product that is 
not packaged and shipped in accordance with the foregoing requirements, or that is determined by D-
Link not to be defective or non-conforming. 
 
What Is Not Covered: 
 
This limited warranty provided by D-Link does not cover: 
 
Products that have been subjected to abuse, accident, alteration, modification, tampering, negligence, 
misuse, faulty installation, lack of reasonable care, repair or service in any way that is not contemplated 
in the documentation for the product, or if the model or serial number has been altered, tampered with, 
defaced or removed; 
 
Initial installation, installation and removal of the product for repair, and shipping costs; 
 
Operational adjustments covered in the operating manual for the product, and normal maintenance; 
 
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage; 
and 
 
Any hardware, software, firmware or other products or services provided by anyone other than D-Link. 
 
Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, 
THE PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND 
INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY 
CANNOT BE DISCLAIMED IN ANY TERRITORY WHERE A PRODUCT IS SOLD, THE 
DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO NINETY (90) DAYS. 
EXCEPT AS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, 
THE ENTIRE RISK AS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE 
PRODUCT IS WITH THE PURCHASER OF THE PRODUCT. 
 
Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT 
LIABLE UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR 
EQUITABLE THEORY FOR ANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR 
DAMAGES OF ANY CHARACTER, WHETHER DIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF 



 

GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, LOSS OF 
INFORMATION OR DATA CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY 
PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING FROM THE USE 
OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY 
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE 
FOREGOING LIMITED WARRANTY IS REPAIR, REPLACEMENT OR REFUND OF THE 
DEFECTIVE OR NON-CONFORMING PRODUCT. 
 
GOVERNING LAW: This Limited Warranty shall be governed by the laws of the state of Singapore. 
 
Trademarks 
D-Link is a registered trademark of D-Link Corporation/ D-Link International Ptd Ltd. All other 
trademarks belong to their respective proprietors. 
 
Copyright Statement 
No part of this publication may be reproduced in any form or by any means or used to make any 
derivative such as translation, transformation, or adaptation without permission from D-Link 
Corporation/ D-Link International Ptd Ltd. 
 
 
FCC Warning 
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with this manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense. 
 



 

Tech Support 

 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Technical Support 
You can find software updates and user documentation on the D-

Link website. 
 

D-Link provides free technical support for customers within the 
United States and within Canada for the duration of the service 
period, and warranty confirmation service, during the warranty 

period on this product. U.S. and Canadian customers can contact 
D-Link technical support through our website, or by phone. 

  

Tech Support for customers within the United States: 
D-Link Technical Support over the Telephone: 

USA - 877-DLINK-55 (877-354-6555) 
D-Link Technical Support over the Internet: 

http://support.dlink.com 

Tech Support for customers within Canada: 
D-Link Technical Support over the Telephone: 

877-354-6560 
D-Link Technical Support over the Internet: 

http://support.dlink.com 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Technical Support 
United Kingdom (Mon-Fri) 

Home Wireless/Broadband 0871 873 3000 (9.00am–06.00pm, Sat 10.00am-02.00pm) 
Managed, Smart, & Wireless Switches, or Firewalls 0871 873 0909 (09.00am – 05.30pm) 

(BT 10ppm, other carriers may vary.) 
Ireland (Mon-Fri) 

All Products 1890 886 899 (09.00am-06.00pm, Sat 10.00am-02.00pm)  

€0.05ppm peak, €0.045ppm off peak Times 

Internet 
http://www.dlink.co.uk 

ftp://ftp.dlink.co.uk 

Technische Unterstützung 
 

Deutschland: Web: http://www.dlink.de 
  E-Mail:  support@dlink.de 
  Telefon: +49(0)1805 2787     0,14 € pro Minute 
  Zeiten: Mo. –Fr. 09:00 – 17:30 Uhr 
Österreich: Web: http://www.dlink.at 
  E-Mail: support@dlink.at  
  Telefon: +43(0)820 480084    0,116 € pro Minute 
  Zeiten: Mo. –Fr. 09:00 – 17:30 Uhr 
Schweiz:  Web: http://www.dlink.ch     
  E-Mail:  support@dlink.ch 
  Telefon: +41(0)848 331100 0,08 CHF pro Minute 
  Zeiten: Mo. –Fr. 09:00 – 17:30 Uhr 
* Gebühren aus Mobilnetzen und von anderen Providern können abweichen. 
 
 

 
 

* Gebühren aus Mobilnetzen und von anderen Providern können abweichen. 
 
 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Assistance technique 
Assistance technique D-Link par téléphone : 0 820 0803 03 

0,12 €/min la minute : Lundi – Vendredi de 9h à 13h et de 14h à 19h 
Samedi 9h à 13h et de 14h à 16h 

Assistance technique D-Link sur internet : 
http://www.dlink.fr 

Technical Support 
Tech Support for customers within the Netherlands: 
0900 501 2007 / www.dlink.nl / €0.15ppm anytime. 

Tech Support for customers within Belgium: 
070 66 06 40 / www.dlink.be / €0.175ppm peak, €0.0875ppm off peak 

Tech Support for customers within Luxemburg: 
+32 70 66 06 40 / www.dlink.be 

 

Asistencia Técnica 
Asistencia Técnica Telefónica de D-Link: +34 902 30 45 45 

0,067 €/min 
De Lunes a Viernes de 9:00 a 14:00 y de 15:00 a 18:00 

http://www.dlink.es 

Supporto tecnico 
Supporto Tecnico dal lunedì al venerdì dalle ore 9.00 alle ore 19.00 con orario 

continuato 
Telefono: 199400057 

http://www.dlink.it/support 



 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pomoc techniczna 
Telefoniczna pomoc techniczna firmy D-Link: 0 801 022 021 
Pomoc techniczna firmy D-Link świadczona przez Internet: 

URL: http://www.dlink.pl 
e-mail: serwis@dlink.pl 

 

Technická podpora 
Web: http://www.dlink.cz/suppport/ 

E-mail: support@dlink.cz 
Telefon: 225 281 553 

Telefonická podpora je v provozu: PO- PÁ od 09.00 do 17.00 
Land Line 1,78 CZK/min - Mobile 5.40 CZK/min 

 

Technikai Támogatás 
Tel. : 06 1 461-3001 
Fax : 06 1 461-3004 

Land Line 14,99 HUG/min - Mobile 49.99,HUF/min 
email : support@dlink.hu 
URL : http://www.dlink.hu 

Teknisk Support 
D-Link Teknisk telefon Support: 820 00 755 

(Hverdager 08:00-20:00) 
D-Link Teknisk Support over Internett: http://www.dlink.no 

Teknisk Support 
D-Link teknisk support over telefonen: Tlf. 7026 9040 

Åbningstider: kl. 08:00 – 20:00 
D-Link teknisk support på Internettet: http://www.dlink.dk 

 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Teknistä tukea asiakkaille Suomessa: 
Arkisin klo. 9 - 21 

numerosta : 06001 5557 
Internetin kautta : http://www.dlink.fi 

Τεχνική Υποστήριξη 
D-Link Hellas Support Center 
Κεφαλληνίας 64, 11251 Αθήνα, 

Τηλ: 210 86 11 114  (Δευτέρα- Παρασκευή 09:00-17:00) 
Φαξ: 210 8611114 

http://www.dlink.gr/support 
 

Assistência Técnica 
Assistência Técnica da D-Link na Internet: 

http://www.dlink.pt 
e-mail: soporte@dlink.es 

Teknisk Support 
D-Link Teknisk Support via telefon: 0900-100 77 00 

Vardagar 08.00-20.00 
D-Link Teknisk Support via Internet: http://www.dlink.se 

 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Tehnička podrška 
Hvala vam na odabiru D-Link proizvoda. Za dodatne informacije, podršku 
i upute za korištenje uređaja, molimo vas da posjetite D-Link internetsku 

stranicu na www.dlink.eu 
www.dlink.biz/hr 

Tehnična podpora 
Zahvaljujemo se vam, ker ste izbrali D-Link proizvod. Za vse nadaljnje 

informacije, podporo ter navodila za uporabo prosimo obiščite D-Link - ovo 
spletno stran www.dlink.eu 

www.dlink.biz/sl 

Suport tehnica 
Vă mulţumim pentru alegerea produselor D-Link. Pentru mai multe informaţii, 

suport şi manuale ale produselor vă rugăm să vizitaţi site-ul D-Link www.dlink.eu 
www.dlink.ro 

 



 

 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Technical Support 
You can find software updates and user documentation on the D-Link website. 

Tech Support for customers in 
Australia: 

Tel: 1300-766-868 
24/7(24Hrs, 7days a week) technical support  

http://www.dlink.com.au 
e-mail: support@dlink.com.au 

India: 
Customer Support: - 1800-233-0000 (MTNL & BSNL Toll Free) or  

+91-832-2885700 (GSM, CDMS & Others) 
E-Mail Address: - helpdesk@dlink.co.in, techsupport@dlink.co.in 

Website: - www.dlink.co.in 
Indonesia, Malaysia, Singapore and Thailand: 

Tel: +62-21-5731610  (Indonesia) 
Tel: 1800-882-880  (Malaysia) 
Tel: +65 6501 4200  (Singapore) 
Tel: +66-2-719-8978/9 (Thailand) 

24/7, for English Support Only 
http://www.dlink.com.sg/support/ 

e-mail: support@dlink.com.sg 
Korea: 

Tel: +82-2-2028-1815 
Monday to Friday 9:00am to 6:00pm 

http://www.d-link.co.kr 
e-mail: arthur@d-link.co.kr 

New Zealand: 
Tel: 0800-900-900 

24/7(24Hrs, 7days a week) technical support 
http://www.dlink.co.nz 

e-mail: support@dlink.co.nz 



 

 
 

 
 

 
 
 
 
 

Technical Support 
You can find software updates and user documentation on the D-Link website. 

Tech Support for customers in 
Egypt: 

Tel: +202-2919035 or +202-2919047 
Sunday to Thursday 9:00am to 5:00pm 

http://support.dlink-me.com 
Email: support.eg@dlink-me.com 

Iran: 
Te: +98-21-88880918,19 

Saturday to Thursday 9:00am to 5:00pm 
http://support.dlink-me.com 

Email : support.ir@dlink-me.com  & support@dlink.ir 
Israel: 

Magshimim 20 St., Matalon center,  
Petach Tikva, Israel 49348 

Consumer support line: 03-9212886 
Business support line: 03-9212608 

Pakistan: 
Tel: +92-21-4548158 or +92-21-4548310 

Monday to Friday 10:00am to 6:00pm 
http://support.dlink-me.com 

E-mail: zkashif@dlink-me.com 
South Africa and Sub Sahara Region: 

Tel: +27-12-665-2165 
08600 DLINK (for South Africa only) 

Monday to Friday 8:30am to 9:00pm South Africa Time 
http://www.d-link.co.za 

Turkey: 
Tel: +90-212-2895659 

Monday to Friday 9:00am to 6:00pm 
http://www.dlink.com.tr 

e-mail: turkiye@dlink-me.com 
e-mail: support@d-link.co.za 
U.A.E and North Africa: 

Tel: +971-4-4278127 (U.A.E) 
Sunday to Thursday 9.00AM to 6.00PM GMT+4 

Web: http://www.dlink-me.com 
E-mail: support.me@dlink-me.com 

Saudi ARABIA (KSA): 
Telephone : +966 01 217 0008 
Facsimile : +966 01 217 0009 

e-mail: Support.sa@dlink-me.com 
Saturday to Wednesday  9.30AM to 6.30PM 

Thursdays 9.30AM  to 2.00 PM 



 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Техническая поддержка 
 

Обновления программного обеспечения и документация 
доступны на Интернет-сайте D-Link. 

 
D-Link предоставляет бесплатную поддержку для клиентов  

в течение гарантийного срока. 
 

Клиенты могут обратиться в группу технической поддержки 
D-Link по телефону или через Интернет. 

 
Техническая поддержка D-Link: 

+7(495) 744-00-99 
 

Техническая поддержка через Интернет  
http://www.dlink.ru 

e-mail: support@dlink.ru 
 



 

 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 

 
 
 
 
 

SOPORTE TÉCNICO 
Usted puede encontrar actualizaciones de softwares o firmwares y 

documentación para usuarios a través de nuestro sitio www.dlinkla.com 
  

SOPORTE TÉCNICO PARA USUARIOS EN LATINO AMERICA 
 Soporte técnico a través de los siguientes teléfonos de D-Link 

 

PAIS NUMERO  HORARIO  

Argentina 0800 - 12235465 Lunes a Viernes 08:00am a 21:00pm  

Chile 800 - 835465 ó (02) 5941520  Lunes a Viernes 08:00am a 21:00pm 

Colombia  01800 -  9525465 Lunes a Viernes 06:00am a 19:00pm 

Costa Rica 0800 - 0521478 Lunes a Viernes 05:00am a 18:00pm 

Ecuador 1800 - 035465 Lunes a Viernes 06:00am a 19:00pm  

El Salvador  800 - 6335 Lunes a Viernes 05:00am a 18:00pm 

Guatemala 1800 - 8350255 Lunes a Viernes 05:00am a 18:00pm 

México 01800 - 1233201 Lunes a Viernes 06:00am a 19:00pm 

Panamá 011 008000525465  Lunes a Viernes 05:00am a 18:00pm 

Perú 0800 - 00968 Lunes a Viernes 06:00am a 19:00pm 

República Dominicana 18887515478 Lunes a Viernes 05:00am a 18:00pm 

Venezuela 0800 - 1005767  Lunes a Viernes 06:30am a 19:30pm 

 
 

Soporte Técnico de D-Link a través de Internet 
www.dlinkla.com 

e-mail: soporte@dlinkla.com & consultas@dlinkla.com 
 



 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Suporte Técnico 
Você pode encontrar atualizações de software e documentação de 

usuário no site da D-Link Brasil. 
 

A D-Link fornece suporte técnico gratuito para clientes no Brasil 
durante o período de vigência da garantia deste produto. 

 
Suporte Técnico para clientes no Brasil: 

 
Telefone 

São Paulo +11-2185-9301 
Segunda à sexta  

Das 8h30 às 18h30 
Demais Regiões do Brasil 0800 70 24 104 

E-mail: 
e-mail: suporte@dlinkbrasil.com.br 

 



 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

D-Link 友訊科技 台灣分公司 
技術支援資訊 

 

如果您還有任何本使用手冊無法協助您解決的產品相關問題，台灣 
地區用戶可以透過我們的網站、電子郵件或電話等方式與D-Link台灣

地區技術支援工程師聯絡。 

 

D-Link 免付費技術諮詢專線 
0800-002-615 

服務時間：週一至週五，早上9:00到晚上9:00 

(不含周六、日及國定假日) 

網      站：http://www.dlink.com.tw 

電子郵件：dssqa_service@dlink.com.tw 

如果您是台灣地區以外的用戶，請參考D-Link網站全球各地 

分公司的聯絡資訊以取得相關支援服務。 

 

產品保固期限、台灣區維修據點查詢，請參考以下網頁說明： 

http://www.dlink.com.tw 

產品維修： 

使用者可直接送至全省聯強直營維修站或請洽您的原購買經銷商。   
 



 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Dukungan Teknis 
 

Update perangkat lunak dan dokumentasi pengguna 
dapat diperoleh pada situs web D-Link. 

 
Dukungan Teknis untuk pelanggan: 

 
Dukungan Teknis D-Link melalui telepon: 

Tel: +62-21-5731610 
 

Dukungan Teknis D-Link melalui Internet: 
Email : support@dlink.co.id 

Website : http://support.dlink.co.id 
 



 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Technical Support 
 

この度は弊社製品をお買い上げいただき、誠にありがとうご

ざいます。 

 

下記弊社 Web サイトからユーザ登録及び新製品登録を 

行っていただくと、ダウンロードサービスにて 

サポート情報、ファームウェア、ユーザマニュアルを 

ダウンロードすることができます。 

 

ディーリンクジャパン Web サイト 
URL:http://www.dlink-jp.com 

 



 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 

技术支持 
您可以在 D-Link 的官方網站找到產品的軟件升級和使用手冊 

办公地址：北京市东城区北三环东路 36 号 环球贸易中心 B 座 26F 
02-05 室 邮编: 100013 

技术支持中心电话：8008296688/ (028)66052968 

技术支持中心传真：(028)85176948 

维修中心地址：北京市东城区北三环东路 36 号 环球贸易中心 B 座

26F 02-05 室 邮编: 100013 

维修中心电话：(010) 58257789 

维修中心传真：(010) 58257790 

网址：http://www.dlink.com.cn 

办公时间：周一到周五，早09:00到晚18:00 




